


  
 

 

 ا هتحلیل غیرارتجاعی سازه
افزار با استفاده از نرم

 
  

 
 

 :نویسندگان

 (عضو هیئت علمی دانشگاه آزاد اسلامی واحد ملایر)  مهدی علیرضایی

 )عضو هئیت علمی دانشگاه قم(   دکتر  محمدکاظم بحرانی 

 (انعضو هیئت علمی دانشگاه آزاد اسلامی واحد همد)دکتر وحید رستمی 

 (عضو هیئت علمی دانشگاه آزاد اسلامی واحد ملایر)خسرو پیله وریان 
                                                                        

 9313 تانــزمس

 



         هاتحلیل غیرارتجاعی سازه

 مقدمه:
وهای ابر نیرای به هدف باربری و مقاومت در برهای سازهمهندسی سازه گرایشی از مهندسی است که با طراحی سیستم

 .گوناگون وارد بر سازه سروکار دارد

یکی از عوامل موثر در اعتلای سطح علمی دانشجویان و مهندسین عمران و ارتقاء دانش فنی مهندسان، وجود مراجع مفید 

لزله، زهای مقاوم در برابر ها به لحاظ طراحی سازهبحث تحلیل غیرارتجاعی سازه باشد.های مختلف این رشته میدر زمینه

های غیرخطی مجاز دانسته شده است. استفاده از تحلیل 0022باشد. همچنین ویرایش جدید استاندارد بحث مهمی می

کیل مفاصل در عی سازه محل تشمهمترین مزایای استفاده از تحلیل غیرخطی استاتیکی عبارتند از : تشریح رفتار غیر ارتجا

ه بحرانی و... . به این ترتیب بدون نیاز به انجام تحلیل غیر خطی دینامیکی ک، نوع و ترتیب تشکیل مفاصل در اعضای اعضا

یم . در این کتاب سعی شده مفاه، طراح با رفتار سازه در ورای حد تسلیم آشنا خواهد شدیر و پرهزینه استبسیار زمان گ

تهیه و آماده سازی  تر شوند.ای کاربردییهباشد تا مفاهیم پا SeismoStructافزار ها به همراه آموزش نرمتحلیل غیرخطی سازه

این کتاب مدت زمان نسبتاً زیادی را بخود اختصاص داده است. سعی شده کتاب با حداقل اشکال منتشر شود. با این وصف 

اندرکاران را برآورده سازد ولی تواند رضایت کلیه دستوقوف کامل داریم که هر اثری خالی از اشکال نیست و نمی

لاحات فنی فارسی سعی شده لغت معادل به زبان طریم که رهگشایی برای کارهای بعدی باشد. در به کاربردن اصامیدوا

چندان گویا نبود، لغت معادل به زبان دیگر معنی را برساند و  اتشود تا چنانچه اصطلاح آوردهانگلیسی در پایین صفحه 

ها سعی شده الدر نوشتن مث های مرجع انگلیسی جستجو کند.ر کتابضمناً با دانستن لغت لاتین، خواننده بتواند مطلب را د

کسانی  تمامی این مجموعه را به رسم حق شناسی بهردی در متن گنجانده شوند. های عددی به صورت کاربتا حد امکان مثال

در اینجا از تمامی  کنیم.د تقدیم میانهو مشوق و همراه ما بود هرشد و بالندگی یاری نمود که در طول زندگی، ما را در

عزیزانی که دست یاری دادند، بخصوص خانم مهندس الهام علیخانی، تا این مجموعه به زیور طبع آراسته گردد بسیار 

های همکاران محترم، دانشجویان گرامی و خوانندگان عزیز موجب دریافت نظرات، پیشنهادات و رهنمون سپاسگذاریم.

 امتنان است.

 9313 زمستان -رستمی-وریانپیله -یبحران -علیرضایی
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 مقدمه

افزارهایی هستند که برای رشته دانشگاهی عمران در مقاطع نرم افزارهای رشته مهندسی عمرانرمن

های هر نرم افزار های روز جهان دانشبا توجه به پیشرفت علم و تکنولوژی رود.کار میمختلف به

یک برنامه المان محدود برای تحلیل  SeismoStruct. برنامه رشته نیاز امروز بازار کار جهان است

های بزرگ سازه، تحلیل استاتیکی و دینامکی  و رفتار ها که قادر به مدلسازی تغییرشکلسازه

 ،(Processor-Preردازش )باشد. برنامه شامل سه قسمت پیش پنیز می 1غیرارتجاعی هندسی و مصالح

( است. در بخش پیش پردازش مدلسازی Post-Processor( و پس پردازش )Processorپردازش )

انجام شده و در بخش پردازش عملیات تحلیل سازه صورت گرفته و در نهایت در بخش پس پردازش، 

هیچ فایل ورودی  شود. تمام این مراحل دارای یک رابط دیداری قوی است.خروجی نتایج گرفته می

برای اجرای برنامه مورد نیاز نیست و تمام روند مدلسازی و ورودی اطلاعات در محیط داخلی برنامه 

مشاهده نماید. همچنین  2تواند، حرکت را بصورت بلادرنگشود. در بخش پردازش، کاربر میانجام می

هیه نمود. در زیر ساختار ت AVIدر انتهای تحلیل میتوان از تغییرشکل سازه یک فیلم با فرمت 

 افزار نشان داده شده است.نرم

 
-Preبرنامه بطور کامل با محیط سیستم عامل ویندوز همخوانی دارد. در بخش پیش پردازش )

Processorهای صفحه گسترده به مانند برنامه ( وارد نمودن اطلاعات ورودی بسیار شبیه به برنامه

ین محیط کاربر قادر به کپی اطلاعات به داخل جداول برنامه ( است. در اMicrosoft Excelاکسل )

                                                        
1 Geometric nonlinearities and material inelasticity. 
2 Real-time 

پیش پردازش

مصالح* 

مقطع* 

دسته المان* 

هاگره* 

هااتصال المان* 

قیدها* 

های تاریخچه زمانیمنحنی* 

اعمال بارها* 

فازهای بارگذاری* 

معیارهای پذیرش* 

خروجی تحلیل* 

تحلیل سازه

پس پردازش

گزارش تحلیل* 

های مدلکمیت* 

های خروچیگام* 

دیدن تغییرشکل سازه* 

پارامترهای پاسخ کلی* 

اثرات المان* 

خروجی تنش و کرنش* 

پوش تحلیل دینامیکی فزاینده* 
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توان در محیط ها( را نیز میهای برنامه )شامل تصاویر و منحنیاست. همچنین تمام خروجی

 ( کپی نمود.Microsoft Wordهای دیگر به مانند برنامه کلمه پرداز وُرد )برنامه

  با استفاده از ابزارBuilding Modeller  ین قسمت از برنامه فقط در نسخه تجاری آن قابل )ا

شما قادر خواهید بود یک سازه منظم یا نامنظم را در    Wizard facilityدسترسی است( و ابزار 

 کمتر از چند ثانیه مدلسازی نمایید.

 های برنامه بطور خلاصه در زیر آورده شده است:برخی از قابلیت

 های دینامیکی و استاتیکی، تحلیل چون تحلیلدارا بدون هشت نوع تحلیل مجزا هم

، تحلیل دینامیکی 1تاریخچه زمانی، تحلیل بار افزون معمولی و بار افزون بهنگام شونده

 باشد.می 4و تحلیل بار استاتیکی غیر متغییر 3، تحلیل مقادیر ویژه2فزاینده

 برنامه دارای یازده مدل رفتاری برای مصالح همچون مدل

و غیره  SMAهای رفتاری های رفتاری برای فولاد، مدل، مدل5رفتای برای بتن پرمقاومت

 است.

 ان ستون، الم -های سه بعدی همچون المان فایبر تیربرنامه دارای کتابخانه بزرگی از المان

 خرپا، المان پانل پرکننده دیواری، المان لینک رابط و غیره است.

 های خطی، دوخطی، سه خطی با سخت همچون مدل 6ایزده مدل چرخهبرنامه دارای نو

، مدل تاکدا، مدل 4، مدل اندرکنش خاک سازه4قلاب -شوندگی سینماتیکی، مدل گپ

 و غیره است. 7رامبراسگود

 ای ای، خسارات سازهبرنامه دارای چندین معیار پذیرش است )همچون خسارات غیرسازه

 ربر قادر به بررسی حالات حدی سازه خواهد بود.و فروریزش( که در این حالت کا

                                                        
1 Adaptive pushover 
2 Incremental dynamic analysis 
3 Eigenvalue 
4 Non-variable static loading 
5 High-strength nonlinear concrete 
6 Hysteretic models 
4 Gap-hook models 
4 Soil-structure interaction model 
7 Takeda model، Ramberg-Osgood model 
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 3                                                                                                           مقدمه 

  1برنامه دارای دو پردازنده تحلیلSkyline solver  2وFrontal solver .است 

 تواند بصورت متغییر و ثابت انجام شوند. این مورد برای اعمال جابجایی و اعمال بارها می

 شتاب نیز برقرار است.

در نظر گرفت. یک تحلیل  1-1شکل توان بصورت له را میهای سازه در برابر زلزبطور خلاصه تحلیل

شود. از لحاظ آنکه وابسته به زمان باشد، یا خیر، به دو نوع تحلیل استاتیکی و دینامیکی تقسیم می

ر د های دینامیکی و استاتیکی نیز بسته به اینکه رفتار غیرارتجاعی مصالح در آنهاهر یک از تحلیل

شوند. در تحلیل استاتیکی در های مختلفی تقسیم مینظر گرفته شده باشد، یا خیر نیز به تحلیل

ترین نوع تحلیل بوده و تحت عنوان سادهصورتی که رفتار مصالح خطی در نظر گرفته شده باشد، 

 یشود. لیکن در یک تحلیل استاتیکی غیرخطی رفتار غیرخطتحلیل استاتیکی معادل شناخته می

مصالح درنظر گرفته شده است. در تحلیل دینامیکی در صورتی که رفتار خطی مصالح مورد نظر 

باشد، بایستی بصورت تحلیل دینامیکی طیفی و یا تحلیل تاریخچه زمانی خطی مورد استفاده قرار 

ه اریخچتگیرد، لیکن در حالتی که رفتار غیرخطی مورد نظر باشد، بایستی لزوماً بصورت یک تحلیل 

 زمانی غیرخطی صورت گیرد.

 
 انواع تحلیل سازه در برابر زلزله 1-1شکل 

 

 تفاوت یک تحلیل ارتجاعی و غیرارتجاعی در چیست؟

                                                        
1 Skyline solver (Cholesky decomposition، Cuthill-McKee nodes ordering algorithm، 
Skyline storage format) 
2 Frontal solver for sparse systems، introduced by Irons [1970] featuring the automatic 

ordering algorithm proposed by Izzuddin [1991]. 
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در وسط تیر اعمال ، طول و مقطع تیرها ثابت بوده و بار 2-1شکل نشان داده شده در در تیرهای 

های تکیهالعملتن بوده و عکس 11در تیر سمت چپ نیرو برابر  است. IPE160میشود، مقطع تیر 

العملبرابر شده و همچنین مقدار عکس 11تن است. در شکل وسط بار  5گاهی هر یک به میزان 

همچنین مقدار  برابر شده و 111برابر شده است. در شکل سمت راست بار  11گاهی نیز های تکیه

برابر شده است. این نوع تحلیل، یک تحلیل خطی بوده که  111گاهی نیز های تکیهالعملعکس

 کند.های سازه با میزان بار بصورت خطی تغییر میمیزان پاسخ

 
 مفهوم تحلیل خطی و غیرخطی 2-1شکل 

 

ود، رفتار خطی مصالح )در حالتی قانون هوک همواره ثابت است( رفتاری شهمانطور که دیده می

غیر واقعی بوده و در مواردی که احتمال ورود سازه به حیطه غیرخطی وجود دارد بایستی رفتار 

 واقعی مصالح در نظر گرفته شود.
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 معرفی برنامه -1 فصل

 مقدمه -1-1

 شود:موارد زیر پیشنهاد می SeismoStructبرای اجرای برنامه 

 بیتی( 64یا  32و یا ویندوز ویستا ) 4یا  4یک کامپیوتر شخصی با سیستم عامل ویندوز  -

 حافظه موقت 4GBحداقل  -

 پیکسل برای صفحه نمایش. 1024x768دقت تصور  -

 اتصال به اینترنت جهت ثبت برنامه -

 نصب برنامه -1-2

مشخص شده رفته و در بخش  (http://www.seismosoft.comابتدا به سایت برنامه )

DOWLOAD  کلیک نمایید و در صفحه ظاهر شده برنامهSeismoStruct  را انتخاب

 نمایید تا بارگذاری شود.

 
 seismosoftنمایی از محیط پایگاه  1-1شکل 

 

ی شده را از حالت فشرده خارج نمایید و آن را در محیط ویندوز اجرا نمایید. برای نصب، فایل بارگذار

کلیک نمایید.  Nextبر روی گزینه  2-1شکل منتظر بمانید تا مراحل نصب برنامه شروع شود. مطابق 

کلیک نمایید. برای  Finishمنتظر بمانید تا مراحل نصب برنامه تمام شود. در نهایت بر روی دکمه 

 < Start > Programs or All Programs > Seismosoftاز نصب انداختن برنامه از مسیر 
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SeismoStruct v7> Uninstall SeismoStructv7  اقدام نمایید تا برنامه بطور کامل از روی سیستم

 پنجره ثبت برنامه ظاهر شود. 3-1شکل شما حذف شود. برنامه را باز نموده تا مطابق 

 
 مراحل اولیه نصب برنامه 2-1شکل 

 

 
 ثبت برنامه 3-1شکل 

 

زمایشی برنامه با کلیک استفاده از حالت آ -1در این پنجره، سه راه برای استفاده از برنامه وجود دارد: 

 Obtainدانشگاه با کلیک بر روی گزینه استفاده از یک مجوز  -Continue Trial ،2بر روی گزینه 

academic license  ،بدست آوردن یک مجوز تجاری با کلیک  -3و وارد نمودن یک ایمیل دانشگاهی

 نامه. و پرداخت هزینه استفاده از بر Acquire commercial licenseبر روی 

 4های قبلی برنامه را دارید، در نسخه توجه داشته باشید، در صورتی که مجوز استفاده از نسخه 

 این برنامه قادر به استفاده از مجوزهای قدیمی نیستید و نیاز به یک مجوز جدید دارید.

ز مجوز استفاده ا 12111بیش از  2114تاسیس شد و تا مارس  seismosoftشرکت 

)به نقل از سایت  4-1شکل نرم افزارهای خود را صادر نموده است. همانطور که در 

Web: www.M-Alirezaei.com

Telegram Channel: @AlirezaeiChannel استفاده غیر تجاری از این اثر با ذکر منبع بلامانع است



 4                                                                                                     فصل اول / معرفی برنامه

http://www.seismosoft.com ،مجوزهای صادر شده برای استفاده از  %14( نشان داده شده است

مان هندسین کشوربرنامه تولیدی این شرکت مربوط به ایران است که این خود نشان از استقبال م

 دهداز محولات این شرکت را می

 
 www.seismosoft.comبه نقل از پایگاه اطلاعاتی  آمار کاربران برنامه 4-1شکل 

 

 منوی اصلی برنامه و نوار ابزار -1-3

برنامه دگیری دارد. پنجره اصلی دارای یک محیط برنامه ساده و جذاب برای یا SeismoStructبرنامه 

 شود.تقسیم می 5-1شکل نشان داده شده در های بخش هدر قسمت پیش پردازش، ب

 
 محیط کلی برنامه 5-1شکل 

 

ردازش، پردازش و پس پردازش( های برنامه )شامل پیش پنوار منوی اصلی برنامه در تمام بخش

 وجود دارد.
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 نوار منوی اصلی برنامه
 منوی زیر است: 4این قسمت شامل 

• File 

• Edit 

• View 

• Define 

• Results 

• Tools 

• Run 

• Help 
است، تا در نوار ابزار اصلی آورده شده  6-1شکل های منوی اصلی برنامه مطابق ترین قسمتمهم

 تر شود.دسترسی به آنها ساده

 
 اجزای اصلی منوی اصلی 6-1شکل 

 

در زیر دستورات مهم منوی اصلی به همراه جزئیات آنها در نوار ابزار اصلی برنامه نشان داده شده 

 است:
 عنوان منوی اصلی برکلید میان آیکون

 Ctrl+N New  

 Ctrl+O Open 

File 
  Building Modeller 

  Wizard 

 Ctrl+S Save 
  Save as… 

 Ctrl+Z Undo 

Edit 

 Ctrl+R Redo 

  Organize Groups 

 Ctrl+C Copy Selection 

 Ctrl+Alt+C 

 
Ctrl+V Paste Selection 

 Ctrl+F Find… 

 Ctrl+A Select All 
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 Ctrl+W Next Properties Module 

View  Ctrl+Q Previous Properties Module 

  Model Statistics 

  Material properties 

Define 

  Section properties 

  Element Classes 

  Structural Nodes 

  Element Connectivity 

  Nodal Constraints 

  Restraints 

  Linear Curves 

  Applied Loading 

  Phases 

  Adaptive Parameters 

  Response Spectrum Parameters 

  Performance Criteria 

  Output 

  Analysis Logs 

Results 

  Modal Quantities 

  Step Output 

  Deformed Shapes 

  Global Response Parameters 

  Member Action Effects 

  Stress and Strain Output 

  IDA Envelope 

 Ctrl+U Units Selector 

Tools 
  Redraw 3D Plot 
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  Project Settings…/Post-Processor Settings… 

  3D Plot Options 

  Deformed Shape Settings 

  Calculator 

  Open SeismoBatch 

  Pre-Processor 

Run   Processor 

  Post-Processor 

 F1 SeismoStruct Help 

Help 

  Rotate/move the 3D model 

  SeismoStruct User Manual 

  SeismoStruct Verification Report 

 
  Seismosoft Forum 

  Video Tutorials 

  Seismosoft Web Site 

  About… 
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 سطوح عملکردی سازه و تحلیل بارافزون -2 فصل

 مقدمه -2-1

 ،در اثر زلزله سطح خطر انتخاب شدهبه منظور برآورد نیروهای داخلی و تغییر شکلهای اجزای سازه 

 های زیر تحلیل شود. لازم است سازه به یکی از روش

 روش استاتیکی خطی 

 روش دینامیکی خطی 

  روش استاتیکی غیر خطی 

 روش دینامیکی غیر خطی 

حدوده کاربرد روشهای مختلف تحلیل و همچنین معیارهای پذیرش هر یک بر اساس نوع رفتار م

)نشریه ای از دستورالعمل بهسازی لرزه 5-2و همچنین  2-3-2و  1-3-2اجزای سازه در بندهای 

در ادامه سطوح عملکردی سازه و مبانی تحلیل استاتیکی غیرارتجاعی تشریح گردیده است. ( 361

 اهد شد.نشریح خو

 سطوح عملکرد اجزای اصلی و غیراصلی -2-2

 .شودای تعریف میای و غیر سازهسطح عملکرد کل ساختمان بر حسب سطح عملکرد اجزای سازه

  اي:سطوح عملكرد اجزاي سازه 
 باشد.ای شامل چهار سطح عملکرد اصلی و دو سطح عملکرد میانی میسطوح عملکرد اجزای سازه

 ای عبارتند از :اجزای سازهسطوح عملکرد اصلی برای 

 : قابلیت استفاده بی وقفه  1سطح عملکرد 

بینی شود در اثر گردد که پیشسطح عمکلرد قابلیت استفاده بی وقفه به سطح عملکردی اطلاق می

وقوع زلزله، مقاومت و سختی اجزای سازه تغییر قابل توجهی پیدا نکند و استفاده بی وقفه از آن 

 ممکن باشد.

 : ایمنی جانی 3ملکرد سطح ع
گردد که پیش بینی شود در اثر وقوع زلزله سطح عملکرد ایمنی جانی به سطح عملکردی اطلاق می

 ای نباشد که منجر به خسارت جانی گردد.اما میزان خرابی به اندازه خرابی در سازه ایحاد گردد
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 یزشور: آستانه فر 5سطح عملکرد 
بینی شود در اثر وقوع گردد که پیشعملکردی اطلاق می سطح عملکرد آستانه فروریزش به سطح

 ای در سازه ایجاد شود، اما ساختمان فرو نریزد و تلفات جانی به حداقل برسد.زلزله خرابی گسترده

 : لحاظ نشده 6سطح عملکرد 

ای سطح عملکرد خاصی انتخاب نشده باشد، سطح عملکرد اجزای چنانچه برای عملکرد اجزای سازه

 شود.ای لحاظ نشده نامیده میسازه

 ای عبارتند از : سطوح عملکرد میانی برای اجزای سازه

 : خرابی محدود 2سطح عملکرد 
بینی شود در اثر وقوع زلزله، خرابی سطح عملکرد خرابی محدود به سطح عملکردی است که پیش

مت بخشهای آسیب دیده، . بطوریکه پس از زلزله با انجام مر،اد گرددجدر سازه به میزان محدود ای

 .برداری از ساختمان میسر باشدادامه بهره

 : ایمنی جانی محدود 4سطح عملکرد 
گردد که در اثر وقوع زلزله خرابی در سازه سطح عملکرد ایمنی محدود به سطح عملکردی اطلاق می

 ای باشد که خسارت جانی حداقل گردد.ها به اندازهایجاد شود، اما میزان خرابی

  ايطوح عملكرد اجزاي غیر سازهس : 
 ای عبارتند از:سطوح عملکرد اجزای غیر سازه

 : خدمت رسانی بی وقفهA سطح عملکرد 

-بینی شود اجزای غیرگردد که پیشسطح خدمت رسانی بی وقفه به سطح عملکردی اطلاق می

ساختمان بطور  ای که خدمت رسانیبگونه ،ای در اثر زلزله دچار خرابی بسیار جزئی شوندسازه

 پیوسته انجام شود.

 : قابلیت استفاده بی وقفه B سطح عملکرد 
جزای گردد که پیش بینی شود اسطح عملکرد قابلیت استفاده بی وقفه به سطح عملکردی اطلاق می

های دسترسی و فرار بطوریکه پس از زلزله راه ،ای در اثر زلزله دچار خرابی جزئی شوندغیر سازه

آسانسورها و روشنایی آنها مختل نشده و استفاده از ساختمان بی وقفه ،هاراهروها، پله مانند درها،

 .میسر باشد

 : ایمنی جانیCسطح عملکرد 
گردد که پیش بینی شود خرابی اجزای غیر سطح عملکرد ایمنی جانی به سطح عملکردی اطلاق می

د.ای در اثر زلزله خطر جدی برای جان ساکنین بوجود نیاورسازه

 : ایمنی جانی محدود 
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گردد که پیش بینی شود خرابی سطح عملکرد ایمنی جانی محدود به سطح عملکردی اطلاق می

 ای باشد که خسارت جانی حداقل گردد.ای در اثر زلزله به اندازهاجزای غیر سازه

 لحاظ نشده:  E سطح عملکرد 
ح عملکرد خاصی انتخاب نشده باشد سطح عملکرد ای سطچنانچه برای عملکرد اجزای غیر سازه

 شود.ای لحاظ نشده نامیده میاجزای غیر سازه

 

  : سطوح عملكرد كل ساختمان 
شود و می ای تعریفای و غیرسازهسطح عملکرد کل ساختمان بر حسب سطح عملکرد اجزای سازه

 عبارتند از:

 سطح عملکرد خدمت رسانی بی وقفه:
ای آن دارای سطح عملکرد وقفه است که اجزای سازهرسانی بیعملکرد خدمتساختمانی دارای سطح 

)خدمت رسانی بی وقفه(  Aای آن دارای سطح عملکرد و اجزای غیرسازه وقفهقابلیت استفاده بی

 باشند.

 عملکرد قابلیت استفاده بی وقفه:سطح 

ای آن دارای سطح ی سازهوقفه است که اجزاساختمانی دارای سطح عملکرد قابلیت استفاده بی

)قابلیت استفاده  Bای آن دارای سطح عملکرد سازهو اجزای غیروقفه عملکرد قابلیت استفاده بی

 وقفه( باشد.بی

 ایمنی جانی:سطح عملکرد 
ای آن دارای سطح عملکرد ایمنی ساختمانی دارای سطح عملکرد ایمنی جانی است که اجزای سازه

 )ایمنی جانی( باشد. Cای آن دارای سطح عملکرد جانی و اجزای غیر سازه

 :سطح عملکرد آستانه فروریزش

ای آن دارای سطح عملکرد ساختمانی دارای سطح عملکرد آستانه فروریزش است که اجزای سازه

 ای وجود نداردآستانه فروریزش باشند. در این حالت محدودیتی برای سطح عملکرد اجزای غیرسازه

 (.Eظ نشده )سطح عملکرد لحا

 : سطوح خطر زلزله 
 ای به شرح زیر است:سطوح خطر زلزله تعریف شده در دستورالعمل بهسازی لرزه

 (1سطح خطر برداری )سال بهره 51درصد در  11زلزله با احتمال فراگذشت 

  (2سطح خطر برداری )سال بهره 51درصد در  2زلزله با احتمال فراگذشت 
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سال: این سطح خطر برای موارد خاصی  51ا هر احتمال وقوع انتخابی در سطح خطر انتخابی، زلزله ب

 51در  ٪21یا  سال و 51در  ٪51گیرد. از جمله زلزله با احتمال فراگذشت مورد استفاده قرار می

 باشند.می 2و  1سال که سطح خطر کمتری از زلزله های خطر 

 تحلیل استاتیکی خطی -2-3

 ل عبارتند از: فرضیات اساسی در این روش از تحلی

 .رفتار مصالح خطی است 

  .بارهای ناشی از زلزله ثابت )استاتیکی( است 

  کل نیروی وارد بر سازه برابر ضریبی از وزن ساختمان است 

در این روش نیروهای جانبی ناشی از زلزله چنان انتخاب می شود که حداکثر تغییر شکل سازه با 

بینی می شود مطابقت داشته باشد. بنابراین چنانچه  آنچه که در زلزله سطح خطر مورد نظر پیش

تحت اثر بار وارده، سازه بصورت خطی رفتار کند نیروهای بدست آمده برای اعضا نزدیک به مقادیر 

پیش بینی شده در هنگام زلزله خواهد بود. ولی چنانچه سازه رفتار غیرخطی داشته باشد، نیروهای 

یر حد جاری شدن مصالح خواهند شد. به همین جهت هنگام بدست آمده از این روش بیش از مقاد

ی که هنگام زلزله رفتار غیر یهابررسی معیارهای پذیرش، نتایج حاصل از تحلیل خطی برای سازه

 گردد. خطی دارند اصلاح می

در روش استاتیکی خطی همانگونه که قبلاً نیز گفته شد، نیروی جانبی زلزله بصورت ضریبی از وزن 

 :تمان و از رابطه زیر محاسبه می گرددکل ساخ

(2-1) WSCCCCV am321 

ه مطابق وزن کل ساختمان، شامل وزن مرده ساختمان و درصدی از سربار زنده ک: Wدر رابطه فوق، 

 :2Cمکانهای غیر ارتجاعی سیستم،  تغییر: ضریب تصحیح برای اعمال 1C، 2411با ضوابط استاندارد 

: 3C ،اعمال اثرات کاهش سختی و مقاومت اعضای سازه ای بر تغییر مکانها بدلیل رفتار چرخشی آنها

:  :mCبا رفتار غیر خطی مصالح،  Delta-Pبرای اعمال اثرات 

با توجه به هدف بهسازی و سطح خطر مورد شتاب طیفی به ازای زمان تناوب اصلی سازه است که 

 را ملاحظه نمایید. 361نشریه  2-1-3-3برای کسب اطلاعات بیشتر بند  گردد.نظر تعیین می

 تغییر شکل حاصل بصورت کنترل-رفتار اجزای سازه با توجه به نوع تلاش داخلی آنها و منحنی نیرو

نده باشد. انتخاب نوع تلاش )کنترل شوشونده توسط تغییرشکل و یا کنترل شونده توسط نیرو می

وع رفتار باشد بلکه بر اساس نتوسط نیرو و یا کنترل شونده توسط تغییر شکل( در اختیار طراح نمی

شود. تقسیم بندی نوع رفتار اعضای سازه مطابق با پیشنهادات تفسیر دستور العمل اعضا مشخص می

گردد حتی ته شده است. همانگونه که مشاهده میای مطابق با جدول زیر در نظر گرفبهسازی لرزه
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در یک مقطع از یک عضو نیروهای داخلی ممکن است از دو نوع کنترل شونده توسط نیرو یا 

 تغییرشکل باشد.
 تقسیم بندی نوع رفتار اعضای سازه1-2جدول 

عضو )سیستم قاب خمشی 

 بتنی(

 ی کنترل شونده توسطتلاشها

 تغییر شکل

 های کنترل شوندهتلاش

 توسط نیرو

 (Vنیروی برشی ) (Mلنگر خمشی ) تیرها

 (Mلنگر خمشی ) هاستون
 (Pنیروی محوری )

 (Vنیروی برشی )

 (Vنیروی برشی ) - اتصالات

 ای بر تحلیل استاتیکی غیرخطی )تحلیل بار افزون(مقدمه -2-4

های غیرخطی برای تحلیل سازه خطی استفاده نمود باید از روش هایدر صورتیکه نتوان از روش

ای هنگامی که برش پایه حاصل از استفاده نمود. اما مطابق با ضوابط دستورالعمل بهسازی لرزه

بیشتر از برش حاصل از  ٪31، جرم مؤثر ٪71ای با درنظر گرفتن تحلیل دینامیکی خطی در طبقه

بایست همراه با روش تحلیل دینامیکی خطی یکی غیرخطی میمود اول باشد، روش تحلیل استات

بایست برای هر دو روش بررسی شود با این تفاوت بکار گرفته شود و در این حالت معیار پذیرش می

 ٪33 توان، در روش دینامیکی خطی میاعضای کنترل شونده توسط تغییرشکلکه برای پذیرش 

 استاتیکی و بصورت فزاینده به سازه ،جانبی ناشی از زلزلهار روش بار افزون، ب درتخفیف قائل شد. 

گردد. تا آنجا که تغییر مکان یک نقطه خاص )مطابق با ضوابط دستورالعمل مرکز جرم(، اعمال می

ا حد بایست تتوزیع بار جانبی بر مدل سازه می به میزان تغییرمکان هدف برسد و یا سازه فرو ریزد.

وهای شکل و نیرهای بحرانی تغییردهد باشد. تا حالتهنگام زلزله رخ می امکان شبیه به آنچه که در

بایست حداقل دو نوع توزیع بار داخلی را در اعضا ایجاد نماید. مطابق با ضوابط دستورالعمل می

و نوع دجانبی بر روی سازه اعمال گردد. از بین توزیع بارهای جانبی پیشنهادی توسط دستورالعمل، 

 ادامه مورد بررسی قرار گرفته شده است. توزیع بار در

   :توزیع نوع اول 

به عنوان توزیع نوع اول باید بار جانبی فقط به یکی از سه روش زیر محاسبه و برمدل سازه اعمال 

ش قط می توان از روفهایی که دارای زمان تناوب اصلی بزرگتر از یک ثانیه هستند گردد. برای سازه

 استفاده نمود.سوم این نوع توزیع بار 

توزیع متناسب با توزیع بار جانبی در روش استاتیکی خطی، از این توزیع هنگامی می توان استفاده -1

جرم سازه در مود ارتعاشی اول در جهت مورد نظر مشارکت کند. در صورت  ٪45نمود که حداقل 
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یع متناسب با شکل مود توز-2انتخاب این توزیع، توزیع نوع دوم باید از نوع یکنواخت انتخاب شود. 

جرم  ٪45اول ارتعاش در جهت مورد نظر، از این توزیع زمانی می توان استفاده نمود که حداقل 

توزیع متناسب با نیروهای جانبی حاصل از تحلیل دینامیکی -3 سازه در این مود مشارکت کند.

 انتخاب شود که حداقلتعداد مودهای ارتعاشی مورد بررسی باید چنان  خطی طیفی. برای این منظور

 جرم سازه در تحلیل مشارکت کند. 71٪

 :توزیع نوع دوم 

 به عنوان توزیع نوع دوم باید بار جانبی به یکی از دو روش زیر محاسبه و بر مدل سازه اعمال گردد.

توزیع متغیر  -2 توزیع یکنواخت که در آن بار جانبی متناسب با وزن هر طبقه محاسبه می شود. -1

ن توزیع بار جانبی بر حسب وضعیت رفتار غیرخطی مدل سازه در هر گام افزایش بار با که در آ

ود باید شبار جانبی که به ترتیب فوق انتخاب می استفاده از یک روش معتبر تغییر داده می شود.

جداگانه در دو جهت مثبت و منفی به سازه وارد شود و رابطه بین برش پایه و تغییر مکان نقطه 

برابر تغییر  5/1باید برای هر گام افزایش نیروهای جانبی تا رسیدن به تغییر مکانی حداقل  کنترل

 مکان هدف ثبت شود. 

 های غیر خطی:پارامترهای مدلسازی رفتار برای روش
برای مدلسازی رفتاری اجزا مطابق ضوابط فصل ششم از دستورالعمل بهسازی برای روش استاتیکی 

های دیگری که رفتار را تحت افزایش یکنوای تغییر شکل یا منحنی -یروغیرخطی از رابطه کلی ن

تغییر  -منحنی ساده شده کلی رفتار بار 1-2شکل گردد. در دهند استفاده میتغییرشکل نشان می

ؤثر در )عضو فاقد بارگذاری( تا یک نقطه تسلیم م Aشکل نشان داده شده است. این مدل از نقطه 

B خطی است و بین نقاط ،B  وC ای به صورت خطی وجود دارد که با یک سختی کاهش یافته

ماند. ثابت می Eمی رسد و تا نقطه  Dبه نقطه  Cکاهش ناگهانی در مقاومت در برابر بار جانبی ازنقطه 

بق ضوابط توان مطارا می Bتا  Aمقاومت به صفر کاهش می یابد. شیب از  سرانجام در این نقطه 

، با نادیده گرفتن Cتا نقطه  Bای محاسبه نمود. شیب از نقطه فصل ششم دستورالعمل بهسازی لرزه

گردد مگر اینکه می شیب اولیه منظور %11اثرات بارهای ثقلی بر تغییرشکل جانبی، بین صفر تا 

ر با مقاومت دارای عرضی براب Cشیب دیگری با آزمایش یا تحلیل، بهتر تشخیص داده شود. نقطه 

 باشد.گردد، میعضو و طولی برابر با مقدار تغییرمکانی که در آن کاهش شدید مقاومت آغاز می

ای در تیرها خمش توسط تغییرشکل و برش توسط نیرو کنترل براساس دستورالعمل بهسازی لرزه

و در د گردند. ضمن اینکه برش و نیروی محوری ستون توسط نیرو و خمش ناشی از بار محوریمی

 شود.جهت توسط تغییرشکل کنترل می

Web: www.M-Alirezaei.com

Telegram Channel: @AlirezaeiChannel استفاده غیر تجاری از این اثر با ذکر منبع بلامانع است



 14                              فصل دوم / سطوح عملکرد سازه و تحلیل بار افزون                                               

 
 جابجایی تعمیم یافته -منحنی نیرو 1-2شکل 

 

 برای تعیین نقطه عملکرد سازه روش طیف ظرفیت -2-5

ارائه شد. این روش مبتنی بر یک روش گرافیکی  Freemanاولین بار توسط  ،روش طیف ظرفیت

 ،باشد. به دلیل گرافیکی بودن این روشایسه ظرفیت یک سازه با تقاضای زلزله در سازه میجهت مق

 ،ددر این روش با تعریف نقطه عملکر باشد.عملکرد سازه تحت اثر زلزله ممکن می نوعارزیابی عینی از 

ازه سشوند نقطه عملکرد محل تلاقی منحنی ظرفیت ظرفیت سازه و تقاضای زلزله با هم مقایسه می

ت در جایی اس ،نقطه عملکرد روی منحنی ظرفیت ،باشد. به دیگر سخنو منحنی تقاضای زلزله می

 .تپذیری تغییر مکان سازه برابر اسپذیری تغییر مکان تحریک با تقاضای شکلتقاضای شکل ،که

ل با فرض غالب بودن مد اول حاص Pushoverسازه از تحلیل  (تغییر مکان -منحنی ظرفیت )نیرو 

با توجه  .(2-2شکل ) شودتعریف می  dSبر حسب  aS ،شود. تقاضای زلزله نیز توسط طیف پاسخمی

مشخص بودن تغییر  ،Pushoverبه تحلیل استاتیکی غیر خطی  ،به وابسته بودن روش طیف ظرفیت

تا رسیدن به این تغییر   Pushoverباشد. بارگذاری جانبی افزایشی در روش مکان هدف لازم می

ای هگردد. در قسمتیابد. بدین ترتیب تقاضای ناشی از زلزله در اعضاء مشخص میمکان ادامه می

 ،باشدمی ATC40آیین نامة بعدی مراحل این روش که برگرفته از 
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 پوش سازه 2-2شکل 

 

 سم طیف تقاضای زلزله طرحر
ر باشند که دهای ثابت شتاب و سرعت و تغییر مکان میای شامل محدودههای پاسخ آیین نامهطیف

های طراحی بر اساس جهت روش ،اند. این شکل طیف( رسم شدهT-aSپریود )-بیک منحنی شتا

ذا ل ،ر مکان مهم هستندنیرو )یا مقاومت( مناسب است. اما در تحلیل غیر خطی هم نیرو و هم تغیی

 ،شودنامیده می 1ADRS ها باید به صورت منحنی شتاب در برابر تغییر مکان که تحت عنوانطیف

ای از خطوط شعاعی گذرنده از مبدا توسط مجموعه ADRSهای پریود در منحنی رسم گردند.

 ،aSشتاب طیفی  متناظر با یک مقدار ،ای روی طیف پاسخشود. هر نقطهنمایش داده می ،مختصات

 aSباشد. جهت تبدیل طیف از حالت استاندارد می Tو پریود  dSتغییر مکان طیفی ،vSسرعت طیفی 

( در هر نقطه از منحنی لازم است aiS،iTمتناظر با ) ،diSتعیین مقدار به شکل  ،Tبر حسب 

 باشد.خص میشود. نحوه تبدیل در شکل زیر مشکه این مقدار توسط فرمول زیر محاسبه می

                                                        
1 Acceleration-Displacement Response Spectra 
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 ADRSطیف در حالت سنتی و در قالب  3-2شکل 
 

با استفاده از مفهوم میرایی موثر  ،لازم به تذکر است که جهت منظور کردن رفتار غیر الاستیک

و  ایین میرایی سازهای بشود. این مفهوم رابطهکاهش داده می ،( طیف پاسخ الاستیکeffβویسکوز)

تعیین ضرائب کاهش طیفی جهت به  ،نتیجه کند.برقرار می (μ)نسبت شکل پذیری تغییر مکان 

بل خواهد بود. قا (های پاسخ غیر الاستیکپذیری ثابت )طیفهای طیف با شکلدست آوردن منحنی

 .شودمان تعریف میهیسترتیک و ویسکوزیته ذاتی ساخت توسط میرایی effβذکر است که 

 رسم منحنی ظرفیت سازه 

خطی تغییر مکان به دست آمده از تحلیل استاتیکی غیر –ظرفیت سازه توسط منحنی نیرو 

Pushover ترین حالت این است که این منحنی بر حسب برش پایه شود. مناسبنمایش داده می– 

متناظر  با زلزله طرح که از یک الگوی بارگذاری جانبی   Pushoverتغییر مکان به بام باشد. در روش

گردد. این بارگذاری تا رسیدن به استفاده می ،به طور افزایشی به سازه مورد نظر اعمال می شود

 یابد. تغییر مکان هدف به صورت یکنواخت افزایش می
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 نمایش گرافیکی بار افزون  4-2شکل 
 

 دم ساخت منحنی ظرفیت مراحل قدم به ق
منحنی ظرفیت نشانگر مد اول پاسخ سازه  ،با فرض غالب بودن مد اول ارتعاشی سازه ،در حالت کلی

قابل  ،ثانیه است 1/1هایی که پریود اصلی ارتعاش در آنها کمتر از باشد. این حالت برای سازهمی

 باشد. قبول می

اثر مدهای بالاتر  (ثانیه 1/1پریود ارتعاش بزرگتر از  پذیری بیشتر )باهایی که با انعطافبرای سازه

ته که برگرف ،باید در محاسبات وارد شود. در ذیل به مراحل قدم به قدم ساخت منحنی ظرفیت ،نیز

 Push overلازم به ذکر است مراحل انجام روش تحلیل آنالیز گردد.اشاره می ،باشدمی ATC40از 

 باشد.می  ATC40همانند    FEMA 273در دستور العمل بهسازی و 

 ایجاد مدل کامپیوتری سازه با استفاده از قواعد مدلسازی.  -1

 طبقه بندی اعضای مدل به عنوان اولیه یا ثانویه. -2

اعمال نیروهای جانبی در تراز طبقات به سازه. این نیروها متناسب با جرم طبقات و تامین  -3

با در نظر گرفتن همزمان بارهای قائم کننده شکل مد اصلی سازه هستند. این تحلیل باید 

 انجام شود. 

؛ باید از روابط زیر محاسبه GQدر ترکیب بارگذاری ثقلی و جانبی، حد بالا و پائین اثرات بار ثقلی، 

 شود:

(2-2) 

 DG QQ 9.0 

 باشد.می مبحث ششم از مقررات ملیبار زندة مؤثر براساس  LQبار مرده و  DQکه در آن 

های متفاوت ارائه شده است. در این های مختلف برای استفاده در حالتدر شکل Pushoverروش 

ری گیرد. این بارگذامی صورت افقی قرار روش سازه تحت اثر یک الگوی بارگذاری جانبی مشخص به
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 توزیعیابد. در ذیل به چند تا زمان رسیدن سازه به یک حالت حدی به صورت افزایشی ادامه می

 شود.اشاره می که در دستورالعمل بهسازی آمده است برای مدل کردن بارگذاری جانبی

 توزیع نوع اول:
کی از سه روش زیر محاسبه و بر مدل سازه اعمال گردد. به عنوان توزیع نوع اول باید بار جانبی به ی

م توان از روش سوهایی که دارای زمان تناوب اصلی بزرگتر از یک ثانیه هستند. فقط میبرای سازه

 این نوع توزیع با استفاده نمود.

 :زیرتوزیع متناسب با توزیع بار جانبی در روش استاتیکی خطی مطابق رابطه  -الف

(2-4) 




n

j

k

ii

k

ii
i

hW

hW
F 

که در آن 
iF نیروی جانبی وارد بر طبقهi ،

iW وزن طبقهi،
ihارتفاع طبقهi  از تراز پایه است و مقدار

k  :برابر است با 

(2-5) K=0.5T+0.75 

درصد جرم سازه در مود ارتعاشی اول در  45توان استفاده نمود که حداقل از این توزیع هنگامی می

جهت مورد نظر مشارکت کند. در صورت انتخاب این توزیع، توزیع نوع دوم باید از نوع یکنواخت 

 انتخاب شود.

ه توان استفادود اول ارتعاش در جهت مورد نظر، از این توزیع زمانی میتوزیع متناسب با شکل م -ب

 :درصد جرم سازه در این مود مشارکت کند. مانند معادله زیر 45نمود که حداقل 

(2-6) v
w

w
F

xx

xx
x .















 

تحلیل دینامیکی خطی طیفی. برای این منظور تعداد  توزیع متناسب با نیروهای جانبی حاصل از -ج

درصد جرم سازه در تحلیل  71مودهای ارتعاشی مورد بررسی باید چنان انتخاب شود که حداقل 

 مشارکت کند.

 توزیع نوع دوم:
 به عنوان توزیع نوع دوم باید بار جانبی به یکی از دو روش زیر محاسبه و بر مدل سازه اعمال گردد.

 شود.یع یکنواخت که در آن بار جانبی متناسب با وزن هر طبقه محاسبه میتوز -الف

توزیع متغیر که در آن توزیع بار جانبی برحسب وضعیت رفتار غیر خطی مدل سازه در هر گام  -ب

 شود.افزایش بار با استفاده از یک روش معتبر تغییر داده می

 م و جانبی با ضرائب مناسب. محاسبه نیروهای اعضاء با اعمال همزمان بارهای قائ -4
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 71تنظیم سطح بار جانبی به قسمی که بعضی از اعضاء )یاگروهی از اعضاء( در محدوده  -5

درصد از  11درصد از مقاومتشان قرار بگیرد )اعضا در حاشیه اطمینانی برابر با  111تا 

 مقاومتشان قرار بگیرد(. 

 . ثبت برش پایه و تغییر مکان بام -6
یروهای اعضا را بر حسب مقدار دوران در آنها ثبت کرد که برای کنترل عملکرد توان نهمچنین می

 باشد. قابل استفاده می

با به کار بردن مقدار سخخخختی برابر صخخخفر )یا خیلی کوچک( برای          ،تجدید نظر در مدل    -4

 اعضای خمیری شده. 

ا دیگری )یاعمال نمو مجدد به نیروهای جانبی در سازه تجدید نظر شده تا زمانی که عضو  -4

  .گروهی از اعضا( تسلیم شود

اضافه نمودن نمو نیروی جانبی و نمو متناظر با تغییر مکان بام به مقدار کل قبلی برای  -7

 محاسبه مقدار تجمعی برش پایه و تغییر مکان بام. 

  7و  4 ،4تکرار مراحل  -11

P- هایی در اعضا که به صورت قابل توجهی متجاوز از سطح عملکرد تغییر شکل ایجاد

به  سطح تغییر شکل جانبی که منجر  (رسیدن عضو )یا گروهی از اعضا ،مطلوب هستند

گردد و رسیدن عضو )یا گروهی از اعضاء( ظرفیت در سیستم  به افت مقاومت قابل ملاحظه

 .(4-2شکل ) باربر قائم گردد

 افت مقاومت کل مدل به صورت واضح  -11

به دلیل رسیدن به سطحی از تغییر شکل جانبی )که تحت آن  11اگر بارگذاری افزایشی در مرحله 

قف متو (ای از یک عضو)یا گروهی از اعضا( نتواند بیش از آن مقاومت کندکل یا بخش قابل ملاحظه

ای کاهش پیدا کرده است لذا سختی که مقاومت عضو به صورت قابل ملاحظه این حالتی است ،شد

( و 3گردد. بنابراین منحنی جدید ظرفیت با شروع از مرحله )عضو کاهش داده می شود یا حذف می

گردند دیگری نیز بدین ترتیب رسم می Pushoverهای قابل رسم است منحنی ،انجام سایر مراحل

 . (5-2شکل ) ی مقاومت حاصل گردده افت نهایتا زمانی ک
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 منحنی ظرفیت چند تایی برای مدل کردن افت مقاومت 5-2شکل 
 

قسمت اول منحنی منطبق بر منحنی  شود:رسم منحنی ظرفیت نهایی به صورت ذیل عمل میبرای 

سپس در تغییر مکانی متناظر با افت مقاومت اولیه به منحنی دوم انتقال داده می  اول می باشد و

ادامه می یابد. منحنی نهایی به  Pushoverشود و این مراحل به همین ترتیب تا آخرین منحنی 

 (.5-2شکل ای خواهد بود )شکل دندانه

 رسم طیف ظرفیت سازه
در  این طیف .باید تبدیل به طیف ظرفیت گردد ،به دست آمده در بند قبل منحنی ظرفیت سازه

باشد. هر نقطه می ADRSحقیقت نمایشی از منحنی ظرفیت در قالب 
roofiv ,  روی منحنی

گردد. این تبدیل با استفاده از روی طیف ظرفیت تبدیل می aiSو  diSظرفیت به نقطه متناظر خود 

 گیرد.صورت میروابط زیر 

(2-4) 
1

/



wv
S i

ai  

(2-4) 
1,1 roof

roof

di
PF

S
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مقادیر 
1  1وPF  گردند.از روابط ذیل حاصل می 

(2-7) 
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؛= ضریب مشارکت مدی مربوط به مد اول  1PF؛ جرم مدی مربوط به مد اول= ضریب 1α ،که در آن

1roof  ؛ مد اول در بام= مقدار دامنه/giw  جرم مربوطه به تراز =i ؛N، ؛ ترین تراز سازهلااب

V ؛ = برش پایهW؛ ده ساختمان + بارهای زنده محتمل= وزن مرroof
 ( تغییر مکان بام =v   متناظر

مکان طیفی = تغییر  dS؛ = شتاب طیفی aSکنند( ای از منحنی ظرفیت را مشخص میبا آن نقطه

(aS  ای روی طیف ظرفیت هستندنمایشگر نقطه ،متناظر با آن). 

آگاهی از تغییرات جرم مدی و ضرائب مشارکت درحالت تغییر شکلهای  ،مهمترین مسئله در تبدیل 

ب سب ،افزایش پریود ممکن است ،باشند. در پاسخ های غیرالاستیک سیستمغیرالاستیک می

و مسلماً این تغییرات بر روی جرم مدی و ضرائب مشارکت که جهت  تغییراتی در اشکال مدی گردد

سازه  رفتار واقعی ،تاثیر گذار خواهد بود. یک تبدیل مبهم مشخص کننده ،باشندتبدیل ضروری می

 باشد.نمی
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 ضرایب مشارکت مودی و جرم مودی نمونه 6-2شکل 
 

 قاضا:ن تیتعی 
م باید در یک دستگاه مختصات رس ،منحنی طیف ظرفیت و منحنی طیف تقاضا ،جهت تعیین تقاضا

غییر نشانگر حداکثر ت ،نقطه عملکرد شود.گردند. محل تلاقی این دو منحنی نقطه عملکرد نامیده می

در  ،باشد. اگر محل تلاقی طیف ظرفیت و طیف تقاضامکان محتمل ساختمان در زلزله تقاضا می

دهنده تغییر مکان واقعی سازه خواهد بود. گرچه این نشان ،ناحیه خطی طیف ظرفیت قرار گیرد

های غیر خطی و غیر ارتجاعی نیست. به منظور پیدا کردن یک حالت طبیعی در اکثر تحلیل ،مورد

ی را ایک مهندس به عنوان حدس اولیه نقطه ،ای که تقاضا و ظرفیت با هم برابر هستندمکان نقطه

مهندس  ،کند. با استفاده از شتاب و تغییر مکان متناظر با این نقطهروی منحنی ظرفیت انتخاب می

جهت لحاظ کردن اتلاف انرژی هیسترتیک را محاسبه کند. طیف تقاضا با  ،تواند ضرایب کاهشمی

زدیک ت نشود. اگر محل تلاقی طیف کاهش یافته و طیف ظرفیاستفاده از این ضرائب کاهش داده می

باشد. درغیر این صورت با فرض کردن نقطه جدیدی به نقطه فرض شده باشد، این نقطه مورد نظر می

یک روش  ،شود تا زمانی که جواب به دست آید. روش فوقمیان این دو نقطه حل مجدد انجام می

اخیر  باشد. مطالعاتتقریبی برای تعیین پاسخ غیر خطی یک ساختمان، تحت یک زلزله مشخص می

، تقریب خوبی از روش طیف ظرفیت ،باشدهایی که مد اول آنها غالب میدر سازه ،نشان می دهد

هایی که در آنها مدهای بالاتر در پاسخ سازه دهد ولیکن این روش برای سازهتغییر مکان به دست می

، جهت محاسبه نقطه عملکرد Cو  Bو  Aسه روش  ATC40در  باشد.مناسب نمی ،موثر هستند

 نقطه عملکرد ذکر شده است. در دستور العمل بهسازی نیز دو روش جهت محاسبه آورده شده است.

 ،در ادامه ابتدا به نحوه محاسبه ضرائب کاهش طیفی که جهت محاسبه نقطه عملکرد لازم است

 گردد. شود و پس از آن مراحل قدم به قدم این سه روش بحث میپرداخته می
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 فی محاسبه ضرائب کاهش طی 

 طیف ضرائب ظرفیت دو خطی  ایجاد
جهت تخمین میرایی موثر و کاهش طیف تقاضا لازم است که طیف ظرفیت به صورت دوخطی 

از منحنی طیف ظرفیت به عنوان حدس اولیه انتخاب  (pia،pid)تبدیل گردد. بدین منظور باید نقطه 

به عنوان  4-2شکل ن برابر مطابق شود. اغلب اوقات از نقطه به دست آمده از طریق قانون تغییر مکا

  .شودحدس اولیه استفاده می

 

 حدس نقطه عملکرد 7-2شکل 
 

 ای برابر با سختی اولیه سازهبرای رسم منحنی دو خطی، ابتدا خطی از مبدا مختصات با ضریب زاویه

مطابق    A 2و 1Aهای شود که مساحتبه صورتی رسم می (pia،pid)ردد. خط دوم از نقطه رسم می گ

این است که سطح زیر طیف  2A و 1A( با یکدیگر برابر باشند. هدف از مساوی قرار دادن 6-2شکل)

برابر باشد که این جهت یکسان بودن انرژی در هر دو  ،ظرفیت با سطح زیر نمایش دو خطی آن

 .است حالت لازم

Web: www.M-Alirezaei.com

Telegram Channel: @AlirezaeiChannel استفاده غیر تجاری از این اثر با ذکر منبع بلامانع است



 24                              فصل دوم / سطوح عملکرد سازه و تحلیل بار افزون                                               

 
 تقریب دو خطی منحنی ظرفیت 8-2شکل 

 

 تخمین میرایی

 به صورت ترکیبی از ،شودهنگامی که تحت اثر زلزله وارد محدوده غیر ارتجاعی می ،میرایی سازه

ه مساحت ک مربوط بباشد. میرایی هیسترتیمیرایی ویسکوزیته ذاتی سازه و میرایی هیسترتیک می

د به توانباشد. این میرایی میمکان سازه میتغییر -(های نمودار نیروی زلزله )برش پایهداخل حلقه

متناظر با تغییر مکان حداکثر  eqمیرایی ویسکوز معادل  ت میرایی ویسکوز معادل داده شود.صور

pid شود.رابطه زیر به دست آورده می 

(2-11) 05.00  eq 

 که در آن: 

0  میرایی ویسکوز ذاتی سازه که فرض  0.05و = میرایی ویسکوز معادل با میرایی هیسترتیک =

 (%5شود ثابت باشد )می

0، داده شده است به صورت رابطه زیر: 

(2-12) 
0

0
4

1

s

D

E

E


  

 که در آن: 

DE و  = انرژی تلف شده از طریق میراییs0E  .انرژی کرنشی حداکثر = 

ژی تلف شده توسط سازه در انر ،DE  .نشان داده شده است 7-2شکل در  s0Eو   DEمفهوم فیزیکی 

نیز حداکثر انرژی   s0E .یک چرخه حرکت است که برابر با سطح زیر حلقه هیسترزیس می باشد

 باشد. می 7-2شکل کرنشی مربوط به یک دور حرکت است که برابر با سطح هاشور خورده مثلث 

ya

pia

yd pid

1A

2A

12 AA 

iK

      Ki سختی اولیه 
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 محاسبه میرایی جهت کاهش طیف 9-2شکل 
 

 

 DEنحوه محاسبه  11-2شکل 
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 DEنحوه محاسبه  11-2شکل 
 

بر حسب مختصات نقطه تسلیم و نقطه عملکرد  DEمقدار  11-2شکل تا   7-2شکل با توجه به 

(pia،pidمطابق زیر محاسبه می ).شود 

 DE=  4( × 11-2شکل )مساحت هاشور خورده در  (2-13)

(2-14) )piayd -pid pi) = 4(a32A -22A -12A – pid pi= 4( a DE 

 داریم: 7-2شکل با توجه به 

(2-15) /2pid pi= a s0E  

 

 بنابراین:

(2-16) 
2/

)(4

4

1
0

pipi

piypiy

d

dda









 

(2-14) 
pipi

piypiy

d

dd

.

)(637.0
0







 

 ید:آرابطه زیر به دست می ،بر حسب درصد میرایی بحرانی 0 با نوشتن

(2-14) 
pipi

piypiy

da

dda

.

)(7.63
0





 

 به صورت زیر به دست می آید: eqبنابر این 
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(2-17) 5
)(7.63

50 



pipi

piypiy

eq
da

adda
 

ا ب ،یفیهش طجهت به دست آوردن ضرائب کا رابطه فوق،میرایی ویسکوز معادل به دست آمده از 

با اعمال  گیرد.مورد استفاده قرار می ،(1742استفاده از روابط ارائه شده توسط نیومارک و هال )

، طیف پاسخ کاهش یافته با میرایی (%5ضرائب کاهش طیفی به طیف پاسخ ارتجاعی )با میرایی 

به دست  ضرائب کاهش طیفی ،125/1شود. برای مقادیر میرایی کمتر از درصد حاصل می 5بیش از 

سازگار هستند.  ،هامهو روابط نیومارک و هال با مقادیر موجود در آیین نا اخیررابطه  eqآمده از 

ضرائب کاهش طیفی باید کاسته شوند که نتیجه طیفهایی با  %25لیکن در مقادیر میرایی بیش از 

تقریب قابل قبولی برای یک  ،7-2شکل حلقه هیسترزیس نشان داده شده در  باشد.کاهش کمتر می

 %31شکل پذیر تحت اثر زلزله با زمان تداوم نسبتاً کوتاه و میرایی ویسکوز معادل کمتر از سازه

تر نسبت به حالت واقعی بیش ،میرایی ویسکوز معادل به دست آمده ،باشد. برای حالتهایی غیر اینمی

ل اینکه چرخه های هیسترزیس واقعی ناقص هستند و دارای سطح کمتر و به دلی ،خواهد بود

های موجود است که عموماً سازی سازهدستورالعمل ایمن ATC40نامه آیین باشند.تری میفشرده

هایی میرایی ویسکوز معادل به دست آمده از باشد. برای چنین ساختمانپذیری نمیهای شکلسازه

 از ،از مقدار واقعی خواهد بود. جهت بر طرف شدن این عیب در این مدرک بیشتر اخیرطریق رابطه 

 ز موثر مطابق زیر تعریف شده است.استفاده شده است و میرایی ویسکو kضریب اصلاح میرایی 

(2-21) 5
)(7.63

5 



pipi

piypiy

eff
da

addak
ok 

زمان  ای وای نیز به کیفیت سیستم مقاوم لرزهدارد و رفتار سازهای بستگی به رفتارسازه kعامل 

 ،C،Bای به سه طبقه رفتارسازه ،دستورالعمل بهسازی و ATC40باشد. در تداوم زلزله وابسته می

Aایهقسیم شده است. رفتار سازت A ل شکهای هیسترزیس پایدار و قابل قبول مطابق نشانگر چرخه

کاهش زیاد  ای ضعیف بانشانگر رفتار سازه Cای  متوسط و شاخص رفتار سازه B ،باشدمی 2-7

دهد و همچنین در ای را نشان میطبقه بندی انواع رفتار سازه 2-2جدول  باشد.سطح زیرحلقه می

 سه حالت فوق ارائه شده است. ی هربرا ،kمقادیر  3-2جدول 
 تعیین نوع سازه 2-2جدول 

مدت زمان ارتعاش 

 زلزله

سازه با جزئیات نا معلوم یا 

 بد

سازه با جزئیات 

 متوسط

سازه با جزئیات 

 خوب

 C B A کوتاه

 C C B بلند
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 kتعیین مقدار  3-2جدول 

 نوع سازه
0 k 

A <16.25 1.0 
A >16.25 51.013.1  
B <25 0.67 
B >25 446.0845.0  

 0.33 هر مقدار
 

 

 محاسبه ضرایب کاهش طیفی

 باشد.مطابق ذیل می vSRو  ASRمعادلات ضرائب کاهش 

(2-21) 
12.2

)(68.021.3 eff

A

Ln
SR


 

(2-22) 
62.1

)(41.031.2 eff

v

Ln
SR


 

محاسبه شده با روابط فوق بزرگتر یا مساوی مقادیر   vSRو  ASRلازم به تذکر است که مقادیر  

 باشند. 4-2جدول 

 مقادیر حداقل برای ضرایب کاهش طیف 4-2جدول 

 ASR vSR نوع سازه
A 0.33 0.50 
B 0.44 0.56 
C 0.56 0.67 

 

 

 روش های بدست آوردن نقطه عملکرد  -2-6

 (ATC40آیین نامه ) Aتعیین نقطه عملکرد با استفاده از روش 
 :باشدیک روش تکراری شامل مراحل زیر می ،این روش

 .ADRS( متناسب با مکان و تبدیل طیف به شکل %5رسم طیف پاسخ ارتجاعی )با میرایی  -1

 (12-2شکل ) (.1در همان دستگاه مختصات مرحله ) ADRSرسم طیف ظرفیت سازه در قالب -2
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 12-2شکل 

 (.13-2شکل ( به عنوان حدس اولیه )pia،pidانتخاب نقطه عملکرد ) -3

 
 13-2شکل 

 (. تبدیل طیف ظرفیت به صورت دو خطی )مراحل کار در صفحات قبل آورده شده است -4

( و رسم 1و اعمال این ضرائب به طیف پاسخ مرحله ) vSRو  ASRمحاسبه ضرائب کاهش طیفی  -5

 (.14-2شکل طیفی تقاضای کاهش یافته در همان دستگاه )
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 5پس از مرحله  Aروش  14-2شکل 
 

 

 6پس از مرحله  Aروش  15-2شکل 

 . (15-2شکل ) تعیین محل تلاقی طیف ظرفیت و طیف تقاضای کاهش یافته-6

pi0.95d )  ( در محخدوده قخابخل قبخولidاگر مختخصات تغییر مکخان نقطخه به دسخت آمخده ) -4

pi<1.05di <dن ،( باشد( قطهpia،pid  نقطه عملکرد خواهد بود. در غیر این صورت با انتخاب )

عملیات باید تکرار گردد تا زمانی که نقطه عملکرد به  ،(4و بازگشت مرحله )(  pia،ipd)نقطه جدید 
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 6نقطه به دست آمده در بند  ،( جدید می تواند pia،pidدست آید. لازم به تذکر است که نقطه )

 باشد. 

 همان روش اشاره شده در تفسیر دستورالعمل بهسازی می باشد.این روش 

 (ATC40آیین نامه ) Bتعیین نقطه عملکرد با استفاده از روش 
شود که در دو روش دیگر این فرض به کار ای استفاده میدر این روش از یک فرض ساده کننده

که نقطه بل ،فیت ثابت استشود که نه تنها شیب اولیه نمایش دو خطی منحنی ظررود. فرض مینمی

(ya،ydو شیب منحنی پس از جاری شدن نیز ثابت است ). دباشمراحل این روش مطابق زیر می. 

 .ADRSمتناسب با مکان و تبدیل طیف به شکل  ،درصد 5تعیین طیف پاسخ ارتجاعی با میرایی  -1

درصد و مجموعه 5رسم طیف پاسخ با میرایی  -2

 

درصد تا  5با شروع از  ،(effمتناظر با مقادیر میرایی موثر ) ،های کاهش یافتهبهتر است که طیف

ای برای ساختمان با رفتار سازه ،effحداکثر مقدار .ای ساختمان باشندحداکثر مجاز برای رفتار سازه

 باشد.درصد می C، 21درصد و برای نوع  B ،27نوع  برای ،درصد A ،41نوع 

 
 2بعد از گام  Bروش  16-2شکل 

 

 (.14-2شکل ) 2در همان دستگاه مختصات مرحله  ADRSرسم طیف ظرفیت در قالب  -3
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 3بعد از گام  Bروش  17-2شکل 
 

بدین ترتیب که شیب اولیه منحنی با  ،14-2شکل رسم نمایش دو خطی طیف ظرفیت مطابق  -4

روی منحنی  (a،*d*)نقطه  ،سختی اولیه سازه برابر است. با استفاده از قانون تغییر مکان برابر

 و باید از این نقطه عبور کند ،خطیس از تسلیم منحنی دوشود. بخش پظرفیت مشخص می

 14-2شکل )نشان داده شده در    1Aو  2Aهای ای باشد که مساحتشیب این خط باید به گونه

 با هم برابر باشند. 

 

 4بعد از گام  Bروش  18-2شکل 
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شیب بخش پس از  ،شودای استفاده شده است که باعث میدر این مرحله از فرضیات ساده کننده

بستگی خواهد داشت. لازم   pidتنها به  ،effتسلیم منحنی دو خطی ثابت بماند. لذا در این حالت 

( a،*d*وی طیف ظرفیت )دانستن عبور منحنی دو خطی از نقطه متناظر با تغییر مکان الاستیک ر

 شده است.  تر به منحنی ظرفیت در این ناحیه استفادهجهت شبیه سازی نزدیک ،نیز

شیب بخش  (.a،*d*)محاسبه میرایی موثر به ازای تغییر مکان های مختلف نزدیک به نقطه  -5

 دو خطی طیف ظرفیت برابر است با: پس از تسلیم نمایش

(2-23) 
y

y

dd

aa




*

*

 = شیب پس از تسلیم 

 روی بخش پس از تسلیم نمایش دو خطی خواهیم داشت:  (pia،pid)به ازای هر نقطه 

(2-24) 
ypi

ypi

dd

aa




 = شیب پس از تسلیم 

 شود.رابطه ذیل حاصل می ،رابطه فوق با برابر قرار دادن دو

(2-25)  
y

y

dd

aa




*

*

=
ypi

ypi

dd

aa




 

 ،به دست آمده بدین ترتیببه صورت زیر به دست می آید.  pidبر حسب   pia ،با حل معادله فوق

piaشود.می نامیده 

(2-26) 
y

y

ypiy

pi a
dd

ddaa
a 






*

* ))((
 

 شود.قرار داده می (21-2) رابطه مقدار فوق در ،effبرای محاسبه 

(2-24) 5
)(7.63





pipi

piypiy

eff
da

addak
 

 شود. حاصل می pidمتناظر با هر  effهای مختلف در رابطه فوق مقدار   pidبا قرار دادن 

های تقاضا و طیف ظرفیت به ( در نمودار شامل مجموعه طیفeffو pidمشخص کردن نقاط ) -6

 (.17-2شکل ) pidازای مقادیر مختلف 
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 6بعد از گام  Bروش  19-2شکل 
 

 (.21-2شکل ( به یکدیگر )6وصل کردن نقاط به دست آمده در بند ) -4

طه ی که نقدر صورت .باشدمشخص کننده نقطه عملکرد می ،محل تلاقی این خط با طیف ظرفیت

(*a و*d) نتیجه به دست آمده از این روش با روشهای دیگر یکسان است. اگر  ،نقطه عملکرد باشد

کمی تفاوت خواهد ،هانتیجه حاصله از این روش با دیگر روش ،نباشد (d*و a*) نقطه ،نقطه عملکرد

بهتر  ،ور باشدد (d*و a*)داشت و در صورتی که نقطه عملکرد به دست آمده از این روش از نقطه 

 ست دو روش دیگر نیز بررسی گردند.ا

 

 7بعد از گام  Bروش  21-2شکل 
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 (ATC40آیین نامه ) Cتعیین نقطه عملکرد با استفاده از روش 
یه عی اولهای دستی ممکن است و نتیجه حاصله در سدر این روش حل گرافیکی با استفاده از روش

 .باشد. مراحل قدم به قدم این روش در ذیل آورده شده استنزدیک می ،به نقطه عملکرد

 .ADRSدرصد، متناسب با مکان و تبدیل طیف به شکل  5تعیین طیف پاسخ با میرایی  -1

ای از طیفهای کاهش یافته در یک دستگاه درصد و مجموعه 5رسم طیف پاسخ با میرایی  -2

 مختصات.

درصد تا  5با شروع از  ،effمتناظر با مقادیر میرایی موثر ،طیف های کاهش یافتهبهتر است که 

برای ساختمان با رفتار  ،effای ساختمان باشند. حداکثر مقدارحداکثر مقدار مجاز برای رفتارسازه

 .(21-2شکل ) درصد می باشد C،21 درصد و برای نوع B، 27برای نوع  ،درصد A ،41ای نوع سازه

 
 2بعد از گام 

 

 (.22-2شکل ) 2در همان دستگاه مختصات مرحله  ADRSرسم طیف ظرفیت در قالب  -3

 
 3بعد از گام  Cروش  22-2شکل 
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های قبل آورده شده است( تبدیل طیف ظرفیت به صورت دو خطی )نحوه تبدیل در بخش  -4

 ( روی طیف ظرفیت.  pia،pidو انتخاب نقطه اولیه )

ظر محل تلاقی به عنوان نقطه اولیه در ن ،درصد 5در صورت تلاقی طیف ظرفیت با طیف با میرایی 

شود. می نقطه انتهای طیف ظرفیت به عنوان نقطه اولیه انتخاب ،شود. در غیر این صورتگرفته می

 همچنین تغییر مکانی کمی بزرگتر از مقدار به دست آمده از طریق قانون تغییر مکان برابر

 (.23-2شکل باشد) pidتخمین مناسبی برای  تواندمی ،برابر بزرگتر(5/1)حدود

 
 4بعد از گام  Cروش  23-2شکل 

تعیین نسبت  -5   1)/(/1)/(  ypiypi ddaa. نسبت سختی  ،قابل ذکر است که کسر دوم

 .(24-2شکل ) باشداز تسلیم به سختی اولیه میپس 

(2-24) 
1

1










y

pi

y

pi

y

y

ypi

ypi

d

d

a

a

d

a

dd

aa

 نسبت سختی پس از تسلیم به سختی اولیه= 
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 شیب منحنی 24-2شکل 

 

اس براسای )های محاسبه شده در مرحله پنجم و با توجه به نوع رفتار سازهبر اساس نسبت -6

 آید.به دست می eff ،(4-2جدول تا  5-2جدول 

 Aای نوع بر حسب درصد برای رفتار سازه effمیرایی موثر  5-2جدول 

نسبت شیب برای    1)/(/1)/(  ypiypi ddaa  
0 0.05 0.1 0.2 0.3 0.4 0.5 y/dpd 

40 37 30 21 16 12 10 10 
40 37 31 23 18 14 11 8 
40 37 33 25 20 16 13 6 
40 37 34 28 23 19 16 4 
39 36 33 27 23 19 16 3 
33 31 29 25 22 19 16 2 
24 24 23 20 18 16 13 1.5 
18 17 16 15 13 12 11 1.25 

 Bای نوع بر حسب درصد برای رفتار سازه effمیرایی موثر  6-2جدول 

نسبت شیب برای    1)/(/1)/(  ypiypi ddaa  
0 0.05 0.1 0.2 0.3 0.4 0.5 y/dpd 

29 27 2312 10 9 10 
29 27 24 17 13 11 9 8 
29 27 25 19 15 12 10 6 
29 27 25 21 17 14 11 4 
29 27 25 21 17 14 12 3 
25 24 22 19 16 14 12 2 
18 18 17 15 14 12 11 1.5 
13 13 12 11 10 10 9 1.25 
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 Cای نوع بر حسب درصد برای رفتار سازه effمیرایی موثر  7-2جدول 

نسبت شیب برای    1)/(/1)/(  ypiypi ddaa  

0 0.05 0.1 0.2 0.3 0.4 0.5 y/dpd 

20 17 14 10 9 7 7 10 
20 18 15 11 9 8 7 8 
20 18 16 12 10 9 7 6 
20 18 16 13 11 9 8 4 
19 17 16 13 3 
16 15 14 12 11 10 9 2 
11 11 11 10 9 9 8 1.5 
9 9 9 8 8 7 7 1.25 

( و تعیین محل تلاقی این 25-2شکل ( در 1رسم خط با سختی اولیه سازه )خط شماره) -4

( از مبداء مختصات به نقطه 2درصد. همچنین رسم خط شماره ) 5خط با طیف میرایی 

(pia،pid.) 

 
 7بعد از گام  Cروش  25-2شکل 

 

به  ،درصد 5با میرایی ( و طیف پاسخ گویی 1از نقطه تلاقی خط ) ،(3رسم خط شماره ) -4

محاسبه شده در مرحله  eff( و طیف کاهش یافته متناظر با 2نقطه محل تلاقی خط )

 درصد می باشد.  24حدود  ،مورد استفاده eff(. در این شکل 26-2شکل ششم )
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 8بعد از گام  Cروش  26-2شکل 
 

به عنوان نقطه عملکرد تخمینی  ،( با طیف ظرفیت3نقطه محل برخورد خط شماره ) -7

(p2a،p2dنامیده می )(24-2شکل شود). 

 
 9بعد از گام  Cروش  27-2شکل 

 ،اختلاف داشته باشد 1pdدرصد با تغییر مکان  5کمتر از  2pdدر صورتی که تغییر مکان  -11

 ( باید انجام شود. 11باشد. در غیر این صورت مرحله )( نقطه عملکرد میp2a،p2d) نقطه

( از مبدا به نقطه 2خط ) ،دوم . بنابراین در تکرارiبه  1( با افزودن 4تکرار مراحل از بند ) -11

(p2a،p2d)  شود. رسم می 
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 روش ضرائب تغییر مکان  -2-7

ودستورالعمل بهسازی  FEMA 273 (1997)روش استفاده شده در  ،روش ضرائب تغییر مکان

زم شود. همچنین لا. در این روش تقاضای تغییر مکان به صورت مستقیم به دست آورده میباشدمی

تبدیل گردد. تغییر مکان هدف در این روش مشابه نقطه  ADRSبه شکل  نیست که منحنی ظرفیت

باشد. لازم به تذکر است که روش ذیل می ATC40عملکرد روش طیف ظرفیت استفاده شده در 

 های منظمی است که پیچش و اثرات مدهای بالاتر در آنها قابل اغماض است. مختص ساختمان

 رسم نمایش دو خطی منحنی ظرفیت 
 :شودرسم منحنی ظرفیت به شکل دو خطی به صورت ذیل عمل می برای

برای نشان دادن قسمتی پس از تسلیم. این خط باید نشانگر  ،eK=sKرسم خط با سختی  -1

 سختی متوسط در ناحیه افت مقاومت باشد. 

روی منحنی ظرفیت عبور  yV6/1این خط باید از نقطه متناظر با  ،ekرسم خط با سختی موثر  -2

باشد. می (eKو  sKبرش متناظر با نقطه محل تلاقی  دو خط )خطوط با سختی  yV مقدارکند. 

 .(24-2شکل )

 
 نمايش دوخطي منحني ظرفيت و محاسبه سختي مؤثر 28-2شکل 

 

طی مراحل فوق نیاز به سعی و خطا دارد. بدین ترتیب  ،ردر ابتدای کا yVبه دلیل مشخص نبودن 

شود و پس از آن نقطه محل تلاقی خط با سختی مشخص می eK ،yVکه پس از رسم خط با سختی 

eK  از جهت داشتن مشخصات  ،با منحنی ظرفیتyV 6/1 گردد.کنترل می 

 (eT) محاسبه پریود اصلی موثر
 د.شویود از فرمول زیر محاسبه میاین پر

(2-27) 
e

i
ie

K

K
TT  
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؛ یدآیکی ارتجاعی سازه به دست می= پریود اصلی ارتجاعی است که از تحلیل دینام iT: که در آن 

iK ؛ = سختی جانبی ارتجاعی سازهeK  درصد از  61= سختی جانبی موثر سازه )سختی سکانت در

 (24-2شکل بق مت تسلیم سازه مطامقاو

 (t)محاسبه تغییر مکان هدف 
 شود.هدف از رابطه زیر محاسبه میتغییر مکان 

(2-31) g
T

SCCCC e
at 2

2

3210
4

  

اشد. به بان طیفی با تغییر مکان بام می= ضریب اصلاح برای مرتبط کردن تغییر مک 0Cکه در آن: 

رود. عبارت دیگر برای تبدیل واکنش سیستم یک درجه آزاد به سیستم چند درجه آزاد به کار می

 های ذیل قابل تخمین است. این ضریب با استفاده از یکی از راه

 مقدار ضریب واکنش مد اول در تراز بام.  -الف

ز بام به دست آمده از بردار شکل متناظر با شکل تغییر یافته مقدار ضریب مشارکت مدی در ترا -ب

 سازه در تغییر مکان هدف. 

 بر حسب تعداد طبقات داده شده است.  0Cکه در آن مقادیر  ،4-2جدول مقادیر تقریبی  -ج

 0Cبی برای مقادیر تقری 8-2جدول 
سایر 

 هاساختمان
 های برشیساختمان

تعداد طبقات 

هر نوع توزیع  ساختمان

 بار

توزیع بار 

 یکنواخت

توزیع بار نوع اول)متناسب با بار 

 جانبی(

1/1 1/1 1/1 1 

2/1 15/1 2/1 2 

3/1 2/1 2/1 3 

4/1 2/1 3/1 5 

 بیشتر و 11 3/1 2/1 5/1

1C به  هایمکانتغییر مکان غیر ارتجاعی مورد نظر را با تغییر = ضریب اصلاحی است که حداکثر

ب از روابط ذیل قابل محاسبه کند. مقدار این ضریدست آمده از طیف ارتجاعی خطی مرتبط می

 است.

(2-31) 
0Te= 1                                            T1C 

0<Te] / R                  Te/T01)T-= [1+(R1C 
 

 در نظر گرفته شود.  2 می تواند  ،0.1eT>( Secبرای مقادیر ) 
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 در روابط فوق:

 0T پریود مشخصه طیف پاسخ است که پریود حد فاصل ناحیه شتاب ثابت و سرعت ثابت طیف =

 باشد. می

Rآید.که از رابطه زیر به دست می ی مقاومت غیر ارتجاعی به مقاومت تسلیم است= نسبت تقاضا 

(2-32) m

y

a C
wv

S
R .

/
 

yV شود. لازم به یادآوری = مقاومت تسلیم سازه است که با استفاده از منحنی ظرفیت محاسبه می

 باشد. مورد استفاده به صورت دو خطی می است که منحنی ظرفیت

W شامل بارهای مرده و قسمتی از بارهای زنده محتمل مطابق ذیل.  ،= وزن سازه 

aS شود. = شتاب طیفی که با توجه به پریود اصلی موثر  تعیین می 

2C  ضریب اصلاحی برای نشان دادن تاثیر رفتار هیسترزیس در تغییر مکان طیفی حداکثر سازه =

این ضریب اثرات کاهش سختی و زوال مقاومت را بر پاسخ تغییر مکان  ،باشد. به عبارت دیگرمی

 کند. حداکثر سازه منظور می

 باشد. می 2/1برابر ،TeT<0برای  ،2Cحداکثر مقدار 

 شده است.  ارائه 7-2جدول های قابی و سطوح عملکرد مختلف در به ازای سیستم 2Cمقدار 
 2Cمقادیر ضریب  9-2جدول 

 سطح عملکرد مورد نظر
1/1T 0TT  

 قاب نوع دو قاب نوع یک قاب نوع دو قاب نوع یک

 1/1 1/1 1/1 1/1 قابلیت استفاده بی وقفه

 1/1 1/1 1/1 3/1 ایمنی جانی

 1/1 2/1 1/1 5/1 آستانه فروریزش

در  31در این جدول قاب های نوع یک شامل سیستم های سازه ای هستند که در آن ها بیش از 

های خمشی قاب بینند.شود که هنگام زلزله صدمه میصد بار جانبی توسط اعضایی حمل می

های با قاب ی با اتصالات نیمه صلب،هاهای مهاربندی شده با محورهای متقارب، قابقاب معمولی،

دیوارهای بنایی غیر مسلح و دیوار های غیر  اند،های لاغر که فقط برای کشش طراحی شدهمهاربند

محسوب می شوند.  2باشند. سایر سیستم های سازه ای از نوع شکل پذیر در برش از این نوع می

 باشد.رون یابی خطی مینیاز به د  T>0(به ازای  2Cبرای محاسبه 

3 C  ضریب اصلاح برای منظور کردن افزایش تغییر مکان در نتیجه تاثیرات مرتبه دوم اثر =P 

در نظر گرفته  1/1برابر  ،های با سختی پس از تسلیم مثبتباشد. مقدار این ضریب برای ساختمانمی

 شود. می
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 شود.مول زیر محاسبه میاز فر 3Cمقدار  ،تسلیم منفی  های با سختی پس ازبرای ساختمان

(2-33) 
eT

Ra
C

2/3

3

)1(
1


 

 

 که در آن: 

 در قسمتهای قبل تعریف شده است.  eTو  Rمقادیر 

 تغییر مکان  –رو هنگامی که رابطه غیر خطی نی ،= نسبت سختی پس از تسلیم به سختی ارتجاعی

 باشد. توسط یک رابطه دو خطی نشان داده شده است، می

 مقايسه روش طیف ظرفیت و روش ضرائب تغییر مکان  -2-8

ظرفیت سازه و تقاضای زلزله با هم مقایسه  ،در روش طیف ظرفیت با استفاده از نقطه عملکرد

استفاده  Pushoverی شوند و برای به دست آوردن منحنی ظرفیت سازه از روش غیر ارتجاعمی

باشد. لازم به ذکر است طیف ارتجاعی زلزله می ،گردد. طیف تقاضای مورد استفاده در این روشمی

طیف تقاضای  ،effبا استفاده از مفهوم میرایی ویسکوز موثر  ،که جهت اعمال رفتار غیر ارتجاعی

قطه عملکرد لازم است که طیف ظرفیت سازه و شود. برای به دست آوردن نزلزله کاهش داده می

طیف  ،طیف تقاضای زلزله در یک دستگاه مختصات رسم گردند. لذا جهت مقایسه ظرفیت و تقاضا

تقاضای تغییر مکان  ،تبدیل گردد. در روش ضرائب تغییر مکان ADRSتقاضای زلزله باید به شکل 

ود. همچنین در این روش لازم نیست ش)تغییر مکان هدف( به صورت مستقیم به دست آورده می

تبدیل گردد. تغییر مکان هدف در این روش مشابه نقطه عملکرد  ADRSکه منحنی ظرفیت به شکل 

 باشد. روش طیف ظرفیت می

 اشکالات روش طیف ظرفیت  -2-9

عیین جهت ت ،استفاده از طیف های الاستیک با میرایی زیاد ،بخش قابل بحث در روش طیف ظرفیت

دو ایراد اساسی در روش طیف ظرفیت وجود دارد  Krawinklerباشد. به عقیده ای میهتقاضای لرز

 کند. این دو ایراد عبارتند از:که استفاده کمیّ از این روش را با اشکال مواجه می

هیچ اصل فیزیکی جهت توجیه وجود یک رابطه محکم بین اتلاف انرژی هیسترتیک و  -1

 مورد سیستم ها ی غیر ارتجاعی وجود ندارد. خصوصاً در  ،میرایی ویسکوز معادل

ات ارتباطی با مشخص -2

 دینامیکی سیستم غیر ارتجاعی ندارد. 

قابل  ،های تئوری روشهم بیان شده است که پایه vision 2000(SEAOC) در ،به دلیل این نواقص

یک قسمت قابل بحث در این روش  ،مولف روش طیف ظرفیت ، Freemanاد بحث است. به اعتق
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 های پاسخهای پاسخ غیر الاستیک و طیفرابطه میان طیف ،های غیر الاستیکمشابه سایر روش

 باشد.الاستیک خطی معادل می

ده های در دو روش استفاده شده در مدارک اخیر آمریکا مشانبود توافق نظر در تعریف تقاضای لرزه

روش ضرائب  ،باشدمی ATC40روش اصلی مورد استفاده در  ،شود. در حالیکه روش طیف ظرفیتمی

تقاضای تغییر مکان غیر الاستیک با  FEMA273در  استفاده شده است. FEMA273تغییر مکان در 

 آید. اعمال ضرائب تصحیح از روی تقاضای تغییر مکان الاستیک به دست می

 ه جهت رفع نواقص روش طیف ظرفیت پیشنهادهای ارائه شد -2-11

های با میرایی معادل خصوصاً در تر از طیفاستفاده از طیف های غیرالاستیک به مراتب صحیح

باشد. جهت برطرف کردن نواقص روش طیف می ،های زیادهای پریود کوتاه و شکل پذیریمحدوده

 Smoothed Inelastic)وار های پاسخ طراحی غیرالاستیک هماستفاده از طیف Bertero ،ظرفیت

Design Response Spectra) های تقاضا پیشنهاد داده است. گرچه جهت تحقق را به عنوان طیف

نشان داد که   Reinhornپریود استفاده شده است.  -شتاب  ،طیف به شکل کلاسیک ،این پیشنهاد

 ADRSستیک در قالب الاهای تقاضای غیراز طیف ،های الاستیک با میرایی معادلبه جای طیف

توان در روش طیف ظرفیت استفاده کرد. بنابراین فواید این دو رهیافت )نمایش عینی روش طیف می

 ،تواند ترکیب گردد. لذاالاستیک( میهای تقاضای غیرظرفیت و پایه های فیزیکی قوی طیف

 یی ویسکوز معادلاز میرا ،گردد. بدین ترتیب کهتردیدهای وارده به روش طیف ظرفیت برطرف می

شود و همین طور از پریود متناظر با نقطه محل تلاقی منحنی ظرفیت و طیف تقاضا با استفاده نمی

در مقالات جدیدی که توسط چوپرا و گول ارائه گردیده است  گردد.میرایی زیاد نیز استفاده نمی

ه برای تغییر های محافظه کارانتخمین ATC40نشان دادند که روش طیف ظرفیت مندرج در 

دهد. برای بهبودی روش طیف ظرفیت، روشی توسط چوپرا و گول های غیر ارتجاعی ارائه میمکان

TRY پیشنهاد شده است که از معادلات مربوط به  ,, نیومارک و هال( طیف غیر خطی به دست(

 .آیندپذیری به دست میهای مختلف شکلها بر اساس  نسبتآید. این طیفمی
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 مدلسازی و تحلیل بارافزون یک سازه دو طبقه بتنی -3 فصل

 مقدمه -3-1

ر دبرای انجام یک تحلیل سازه، نیاز به درک رفتار و معرفی رفتار غیرخطی مصالح به برنامه است. 

این فصل مدلسازی و تحلیل بار افزون برای یک سازه دو طبقه بتنی مورد بررسی قرار خواهد گرفت. 

 متر فرض شود. 3ارتفاع طبقه برابر  ل از تحلیل مورد بررسی قرار خواهد گرفت.در نهایت نتایج حاص

 صورت مسئله و تنظیم واحدها -3-2

یک سازه دو طبقه بتنی و بصورت سه بعدی را در نظر بگیرید که قصد تحلیل غیراتجاعی استاتیکی 

نشان  1-3شکل  پلان طبقات در را داریم. Xآن را داریم. در این مثال قصد تحلیل سازه در جهت 

فایل موجود  …File >Save Asرا باز نموده و از مسیر برای شروع به مدلسازی برنامه  داده شده است.

اقدام به  یا آیکون  tutorial N.1را به نام 

 واحدهای برنامه نشان داده شده است. 1-3جدول ظیم واحدهای برنامه نمایید. در نت
 واحدهای برنامه 1-3جدول 

 SIواحد 

وزن  شتاب تنش جرم نیرو طول
 مخصوص

millimetre 
(mm)  

Newton (N)  tonne (tonne)  
MegaPascal 

(MPa)  
(9807) 

mm/sec2  
N/mm3  

millimetre 
(mm)  

kiloNewton 
(kN)  

kilotonne 
(ktonne)  

GigaPascal 
(GPa)  

(9807) 
mm/sec2  

kN/mm3  

metre (m)  Newton (N)  kilogram (kg)  Pascal (Pa)  
(9.81) 

m/sec2  
N/m3  

metre (m)  
kiloNewton 

(kN)  
tonne (tonne)  kiloPascal (kPa)  

(9.81) 
m/sec2  

kN/m3  

 Emglishواحد 

inches (in)  pound (lb)  lb*sec2/in  
pound per 

square inch 
(psi)  

(386.1) 
in/sec2  

lb/in3  

inches (in)  
kilopound 

(kip)  
kip*sec2/in  

kip per square 
inch (ksi)  

(386.1) 
in/sec2  

kip/in3  

feet (ft)  pound (lb)  
lb*sec2/ft 

(slug)  

pound per 
square foot 

(psf)  

(32.17) 
ft/sec2  

lb/ft3  
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feet (ft)  
kilopound 

(kip)  
kip*sec2/ft 

(kslug)  
kip per square 

foot (ksf)  
(32.17) 
ft/sec2  

kip/ft3  

 
 پلان طبقات برای مثال حاضر 1-3شکل 

 

 

 حد دوران همیشه بر حسب رادیان است.وا SeismoStructدر برنامه 

 
 جدول تنظیم واحدهای برنامه 2-3شکل 

 

ای بالای برنامه نوع ، در پنجره کرکره3-3شکل مطابق در ابتدای کار نوع تحلیل را مشخص نمایید. 

 انتخاب نمایید. Static pushover analysisتحلیل را 

 
 انتخاب نوع تحلیل 3-3شکل 
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 تنظیم پارامترهای مدلسازی -3-3

 ( :پیش پردازش، انتخاب نوع مصالحPre-Processor–Materials) 

ش دو گزینه پیر اولین برگه موجود در قسمت پیش پردازش است. در این برگه کارب Materialsبرگه 

و انتخاب یکی از مصالح از پیش تعریف  Add Material Classکلیک بر روی گزینه  -1روی دارد. 

و تعریف یک مصالح جدید. در این آموزش  Add General Materialکلیک بر روی گزینه  -2شده، 

ظاهر  4-3شکل مطابق  New Materialرا انتخاب نمایید تا پنجره  Add General Materialگزینه 

  شود.

 
 معرفی مصالح بتن 4-3شکل 

 

  در برنامهSeismoStruct  0.3و برای فولاد همواره برابر  0.2مقدار نسبت پواسون برای بتن برابر 

 شود.فرض می

)مدل رفتاری مندل( قرار  con_ma، نوع آن را terial Typeنام مصالح را 

 OKمقادیر پیش فرض برنامه را قبول نمایید. با زدن دکمه  Material Propertiesدهید. در بخش 

و  Steelبار نام مصالح را خارج شوید. همین مراحل را برای معرفی مصالح فولاد نیز طی نمایید. این

بقیه مقادیر  پینتو( قرار دهید.-)مدل رفتاری منگوتو stl_mpآن را  ، نوعMaterial Typeدر بخش 

 خارج شوید. OKقبول نمایید و با زدن دکمه پیش فرض را 

  همیشه بهتر است برای مصالح بتنی، حداقل دو نوع مصالح را تعریف نمایید. مصالح نوع اول را

ب )بتن پوشش( استفاده نمایید. ضری برای بتن محصور شده و مصالح نوع دوم را برای بتن غیرمحصور

 محصور شدگی نیز بایستی متناسب با شرایط محصورشدگی بتن محاسبه و اعمال شود.

توانید در محیط برنامه برای ساختن مصالح سوم که در اینجا یک بتن غیر محصور است، براحتی می

SeismoStruct بر روی مصالح ،Concrete  کلیک نمایید و گزینه که قبلاً ساخته شده بود راست
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Copy Selection  را انتخاب نمایید. سپس با زدن دکمهCtrl+V  نسبت به چسباندن اطلاعات کپی

 شده و ایجاد یک مصالح جدید اقدام نمایید.

 
 کپی نمودن یک مصالح 5-3شکل 

 

دوبار پشت سر هم کلیک نمایید. در ساخته شده،  *Concreteپس از ایجاد مصالح جدید که به نام 

تغییر دهید.  1را به  Confinement Factorتغییر داده و ضریب  Coverکادر ظاهر شده نام آن را به 

 مشاهده خواهد شد. 6-3شکل مطابق  Materialsدر نهایت برگه 

 
 Materialsتکمیل برگه  6-3شکل 

 

  مقاطعپیش پردازش، انتخاب( :Pre-Processor–Sections) 
، با کلیک بر روی گزینه Sectionsبعد از انتخاب مصالح، حال نوبت به انتخاب مقاطع میرسد. در برگه 

Add  اطع اقدام نمایید.نسبت به اضافه نمودن مق 4-3شکل مطابق 

 
 اضافه نمودن مقاطع 7-3شکل 

 

. در جدول زیر ها و دیگری برای تیرهادر این مثال دو مقطع تعریف خواهند شد. یکی برای ستون

 هایی که قصد تولید آنها را داریم بطور خلاصه آورده شده است:مشخصات تیر و ستون
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 مشخصات مقطع هاستون یرهات
0.4 m 0.3 m ارتفاع 
0.3 m 0.3 m عرض 
816 416 ی طولیآرماتورها 
8@10 10@10 آرماتورهای عرضی 

 Sectionو در بخش  Columnنام مقطع، عبارت در بخش  ،4-3شکل مطابق  در پنجره ظاهر شده 

Type گزینه ،reinforced concrete rectangular section (rcrs)  برنامه  4را انتخاب نمایید. در نسخه

حال با کلیک بر روی برگه  ضریب محصور شدگی بصورت خودکار محاسبه خواهد شد.

Reinforcement  و  4آرماتورهای گوشه را ، 7-3شکل آماتورگذاری ستون را اصلاح نمایید. مطابق

و آرماتورهای بالا، پایین، چپ، راست را صفر قرار دهید. 16mmرماتورها را شماره آ

 
 

 
 تعریف آرماتورها 9-3شکل 

 

تعداد مقاطع خاموت در  No. of stirrup legsیه و در ناح Transverse Reinforcementدر بخش 

را انتخاب و در  10mm#، آرماتور Hoopsوارد نمایید. در بخش  2جهت عرض و ارتفاع مقطع را 

Web: www.M-Alirezaei.com

Telegram Channel: @AlirezaeiChannel استفاده غیر تجاری از این اثر با ذکر منبع بلامانع است



 53                                                                                    یسازه دو طبقه بتن کیبارافزون  لیو تحل یمدلسازفصل سوم / 

خودکار انتخاب نمایید. در این حالت برنامه بطور  m 0.1ها را فاصله خاموت Spacing (m)ناحیه 

 کند.ضریب محصورشدگی بتن را تعیین می

  برنامه درSeismoStruct  2.5مقدار کاور بتن بصورت پیش فرض برابر cm .در نظر گرفته میشود 

اقدام به ایجاد مقطع تیر نمایید. در پنجره ظاهر شده، ابعاد  Addحال دوباره با کلیک بر روی گزینه 

 تکمیل نمایید. 11-3شکل را مطابق 

 
 ساختن مقطع تیر 11-3شکل 

 

آماتورگذاری تیر را اصلاح  Reinforcementبرای چیدمان آرماتورهای داخلی مقطع تیر، بر روی برگه 

، و آرماتورهای بالا 16mmو شماره آرماتورها را  4آرماتورهای گوشه را ، 11-3شکل نمایید. مطابق 

 قرار دهید. 2پایین، چپ، راست را برابر 

 
 ساختن و اصلاح آرماتورهای طولی و عرضی تیر 11-3شکل 
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تعداد مقاطع خاموت در  No. of stirrup legsو در ناحیه  Transverse Reinforcementدر بخش 

را انتخاب و در ناحیه  8mm#، آرماتور Hoopsمایید. در بخش وارد ن 2جهت عرض و ارتفاع مقطع را 

Spacing (m) 0.1ها را فاصله خاموت m  انتخاب نمایید. در این حالت برنامه بطور خودکار ضریب

توانید می Section Characteristicsحال با کلیک بر روی برگه  کند.محصورشدگی بتن را تعیین می

 ملاحظه نمایید.مشخصات مقطع ساخته شده را 

 
 دیدن مشخصات مقطع 12-3شکل 

 

مشخصات هندسی ارتجاعی مقطع محاسبه و نشان داده  Elastic Section Propertiesدر بخش 

و در در صورتی که تیک  Confinement Factorsشود. در بخش می

Automatic Calculation of Confinement Factors  خورده باشد، ضریب محصورشدگی بطور

 Section Mass and Weightشود. در بخش نمایش داده می Confinedخودکار محاسبه و  در بخش 

های گسترده طولی اضافی تیر قابل تعیین است. در میزان جرم و وزن واحد طول تیر به همراه جرم

رم واحد طول تیر با توجه به ابعاد هندسی تیر، میزان ج Section Self Mass (tonne/m)قسمت 

توان جرم می ( Section Additionalشود. در بطور خودکار محاسبه و گزارش می

تواند واحد طول تیر که بصورت اضافی )مضاف بر وزن خود تیر( را به برنامه معرفی نمود. این جرم می

در نظر گرفته tone/m 0.6که در این مثال این مقدار را برابر  ناشی از بارهای دیوار روی تیرها باشد

وزن واحد طول تیر بطور خودکار محاسبه شده و نشان  Section Self Weight (kN/m)در بخش  .ایم
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بارهای اضافی )و نه جرم(  Section Additional Weight (kN/m)شود. همچنین در بخش داده می

 شود.بطور خودکار محاسبه و نشان داده میکه به برنامه معرفی شده است، 

  ،دسته المانپیش پردازش( :Pre-Processor–Element Classes) 
اقدام شود. بدین منظور در  Element Classesهای تیر و ستون بایستی در برگه برای معرفی المان

ید. در پنجره ظاهر را کلیک نمایید تا یک المان را تعریف نمای Addگزینه  Element Classesبرگه 

گزینه  Element Type و در بخش Columnشده، در بخش نام مقطع عبارت 

infrmFB: Inelastic forcebased frame element  را انتخاب نمایید. در قسمتSection Name 

نشان داده  14-3شکل که قبلاً ساخته شده بود را انتخاب نمایید. مراحل کار در  Columnمقطع 

 شده است.

 
 Element Classesبرگه  13-3شکل 

 

 
 معرفی المان ستون 14-3شکل 

 

د نمایید. عبارت را وار 211عدد   Section Fibresو در بخش  5عدد  Integration Sectionsدر بخش 

Section Fibres شود. در صورت تعداد این هایی است که مقطع به آنها تقسیم میبیانگر تعداد رشته

یابد. همین مراحل را برای معرفی المان فایبرها زیاد انتخاب شود، زمان و دقت تحلیل افزایش می

 انجام دهید. 15-3کل شتیر مطابق 
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 معرفی المان تیر 15-3کل ش

 

 شود.نمایان می 16-3شکل بصورت نشان داده شده در  Element Classesدر انتها برگه 

 
 انتهای معرفیدر  Element Classesبرگه  16-3شکل 

 

  ،هاگرهپیش پردازش( :Pre-Processor–Nodes) 

ها دارید. برای این منظور بایستی از برگه برای مدلسازی نیاز به تعریف گره SeismoStructدر برنامه 

Nodes  استفاده نمایید. مطابق  بر روی گزینهAdd  کلیک نمایید تا پنجرهNew Node  .ظاهر شود

گزینه  Node Typeرا به عنوان نام گره اول وارد نمایید. در بخش  Node N1در قسمت 

Structural node های را انتخاب نمایید. گزینهX coordinate(m) ،Y coordinate(m)  و

Z coordinate(m) ها را برابر صفر نمایند. این گزینهبه ترتیب مختصات گره مورد نظر را سوال می

های دیگر و دادن معرفی گره -1های دیگر دو راه در پیش روی هست: ی معرفی گرهوارد نمایید. برا

کپی گره تولید شده قبلی و افزایش گره، از روی  -2مختصات نقاط به مانند گره تعریف شده قبلی، 

نماییم. برای این گره انتخاب شده. در اینجا ما از روش دوم که روش سریعتری هست، استفاده می

ای که قبلا ایجاد شده بود را انتخاب نمایید. ، گرهNode Name، در بخش 14-3شکل ابق مط منظور

نمایید تا پنجره  کلیک Incrementationحال در قسمت سمت چپ صفحه نمایش بر روی گزینه 

Automatic Incrementation  ظاهر شود. در این پنجره و در بخشNode Name Increment  عدد

های جدید تولید شده دارای یک بدین معنی است که نام گره 1را وارد نمایید. وارد نمودن عدد  1

های جدید با فواصل متر را وارد نمایید تا گره 4عدد  Xincrement(m)واحد جهش است. در بخش 
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فر را وارد عدد ص Zincrement(m)و  Yincrement(m)ایجاد شوند. در بخش  Xمتری در جهت  4

 3را وارد نمایید تا  3عدد  Repetitionsباشند. در بخش  Xهای تولیدی فقط در جهت نمایید تا گره

کلیک نمایید. روند این کار در  OKایجاد شود. بر روی گزینه  Xمتری در جهت  4تا گره با فواصل 

 ، نشان داده شده است.14-3شکل 

 
 معرفی گره 17-3شکل 

 

 
 هاافزایش تعدادگره 18-3شکل 
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های تولیدی در مرحله قبل را انتخاب ، ابتدا تمام گرهZهای ایجاد شده، در جهت برای افزایش گره

 Automaticکلیک نمایید تا پنجره  Incrementationی گزینه حال بر رو(. N4تا  N1نمایید )گره 

Incrementation  ظاهر شود. در این پنجره و در بخشNode Name Increment  را وارد  11عدد

های جدید تولید شده دارای ده واحد جهش بدین معنی است که نام گره 11نمایید. وارد نمودن عدد 

های جدید در عدد صفر را وارد نمایید تا گره Yincrement(m)و  Xincrement(m)است. در بخش 

های تولیدی در متر را وارد نمایید تا گره 3عدد  Zincrement(m)ایجاد نشوند.در بخش   Yجهت 

تا گره با  2را وارد نمایید تا  2عدد  Repetitionsمتری ایجاد شوند. در بخش  3با فواصل  Zجهت 

شکل کلیک نمایید. روند این کار در  OKد شود. بر روی گزینه ایجا Zمتری در جهت  3فواصل 

 های طولی مدل شد.های روی یکی از قابتا این قسمت گره نشان داده شده است. 3-17

 
 Zهای تولیدی در جهت افزایش گره 19-3شکل 

 

ها را دوباره انتخاب نمایید. حال بر روی گزینه های روی قاب طولی بعدی تمام گرهید گرهبرای تول

Incrementation  کلیک نمایید تا پنجرهAutomatic Incrementation  ظاهر شود. در این پنجره و

بدین معنی است که  4را وارد نمایید. وارد نمودن عدد  4عدد  Node Name Incrementدر بخش 

و  Xincrement(m)های جدید تولید شده دارای چهار واحد جهش است. در بخش گرهنام 

Zincrement(m) های جدید در جهت عدد صفر را وارد نمایید تا گرهX  وZ .در بخش   ایجاد نشوند

Yincrement(m)  های تولیدی در جهت متر را وارد نمایید تا گره 4عددY  متری ایجاد  4با فواصل

ایجاد  Yمتری در جهت  4گره با فواصل  1را وارد نمایید تا  1عدد  Repetitionsر بخش شوند. د

ای مورد نیاز و ایجاد در جدول زیر مختصات تمام نقاط گرهکلیک نمایید. OKشود. بر روی گزینه 

 شده در این پروژه نشان داده شده است:

 نام گره Z Y X نوع

N1 0 0 0 structural 
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N2 4 0 0 structural 

N3 8 0 0 structural 

N4 12 0 0 structural 

N11 0 0 3 structural 

N12 4 0 3 structural 

N13 8 0 3 structural 

N14 12 0 3 structural 

N21 0 0 6 structural 

N22 4 0 6 structural 

N23 8 0 6 structural 

N24 12 0 6 structural 

N5 0 4 0 structural 

N6 4 4 0 structural 

N7 8 4 0 structural 

N8 12 4 0 structural 

N15 0 4 3 structural 

N16 4 4 3 structural 

N17 8 

N18 12 4 3 structural 

N25 0 4 6 structural 

N26 4 4 6 structural 

N27 8 4 6 structural 

N28 12 4 6 structural 

  ،هااتصال المانپیش پردازش( :Pre-Processor–Element Connectivity) 

از این بخش های ایجاد شد در گام قبل ای و ایجاد یک المان بین گرههای سازهبرای ایجاد المان

 Newکلیک نمایید تا پنجره  Addبر روی گزینه  Element Connectivityشود. در برگه استفاده می

Element د. در بخش ظاهر شوElement Name  نامC1  را به عنوان نام ستونی که قصد ایجاد آن را

که قبلاً به عنوان مقطع ستون تعریف  Columnگزینه  Element Classداریم را وارد نمایید. در بخش 

های دو سر المان مورد نظر بایستی گره Element End Nodesشده بود را انتخاب نمایید. در بخش 

 Element Orientationواقع شود. در بخش  یبایست N11و  N1بین گره  C1نمایید. ستون  را تعیین

را بزنید تا زاویه دوران مقطع از مقدار پیش فرض پیروی  Define by Rotation Angleتیک گزینه 

. حال برای ایجاد الماننشان داده شده است 21-3شکل نماید. جزئیات انجام شده در این گام در 

 -2ایجاد ستون و تیرهای دیگر با روش شرح داده شده در قبل،  -1های جدید دو راه وجود دارد: 
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افزایش تعداد ستون و تیرها بوسیله کپی ستون ایجاد شده در گام قبل. در اینجا ما از روش دوم که 

بر روی  Element Connectivityنماییم. بدین منظور، در برگه تری است، استفاده میروش ساده

که در گام قبل ایجاد شده بود کلیک نموده و آن را انتخاب نمایید، حال بر روی گزینه  C1ستون 

Incrementation  کلیک نمایید تا پنجرهAutomatic Incrementation  ظاهر شود. در این پنجره و

های جدید ایجاد شده دارای لمانعدد یک را وارد نمایید تا نام ا Element Incrementدر بخش 

و در قسمت  Structural Nodesجهشی به میزان یک واحد باشند. در بخش 

Increment of Structural Node 1  وIncrement of Structural Node 2  را وارد نمایید. در  1عدد

داده و عدد  این حالت، برنامه شماره گره دو سر عضو انتخاب شده را به میزان یک واحد افزایش

متصل بود بعد از  N11و  N1که به گره  C1حاصل، برابر گره اتصال جدید خواهد شد. مثلاً ستون 

 C1های دو سر تولید شده و شماره گره C2این کار کپی شده و در کپی اول یک ستون جدید به نام 

را وارد  3دد ع Repetitionsشوند. در بخش تبدیل می N12و  N2نیز یک شماره زیاد شده و به 

های طولی ایجاد های طبقه اول برای یکی از قابکپی تولید شود بدین ترتیب ستون 3نمایید تا 

 را ببینید(. 21-3شکل شود )می

 
 هااتصال المان 21-3شکل 
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 هاافزایش تعداد المان 21-3شکل 

 

های ایجاد شده در طبقات بالا نیز همین کار را تکرار نمایید. بدین منظور چهار برای کپی ستون

کلیک نمایید تا پنجره  Incrementationبر روی گزینه ستون ایجاد شده را انتخاب نموده و 

Automatic Incrementation .در این پنجره و در بخش  ظاهر شودElement Increment  11عدد 

واحد باشند. در بخش  11های جدید ایجاد شده دارای جهشی به میزان را وارد نمایید تا نام المان

Structural Nodes  و در قسمتIncrement of Structural Node 1  و

Increment of Structural Node 2  ن حالت، برنامه شماره گره دو سر را وارد نمایید. در ای 11عدد

واحد افزایش داده و عدد حاصل، برابر گره اتصال جدید خواهد  11عضو انتخاب شده را به میزان 

های طبقه کپی تولید شود بدین ترتیب ستون 1را وارد نمایید تا  1عدد  Repetitionsشد. در بخش 

های قاب دوم طول تمام ستونایجاد ستون برای شود.های طولی ایجاد میدوم نیز برای یکی از قاب

 Automaticکلیک نمایید تا پنجره  Incrementationهای تولیدی را انتخاب نمایید. و بر روی گزینه 

Incrementation  ظاهر شود. در این پنجره و در بخشElement Increment  را وارد نمایید  4عدد

به  C1واحد باشند )یعنی مثلاً ستون  4به میزان  های جدید ایجاد شده دارای جهشیتا نام المان

C5 شود(. در بخش تبدیل میStructural Nodes  و در قسمتIncrement of Structural Node 1 

را وارد نمایید. در این حالت، برنامه شماره گره دو سر  4عدد  Increment of Structural Node 2و 
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زایش داده و عدد حاصل، برابر گره اتصال جدید خواهد شد. واحد اف 4عضو انتخاب شده را به میزان 

های طبقه اول کپی تولید شود بدین ترتیب ستون 1را وارد نمایید تا  1عدد  Repetitionsدر بخش 

های ایجاد در جدول زیر شماره و مشخصات ستون شود.و دوم نیز برای قاب دیگری سازه ایجاد می

های ایجاد شده بین گرههمین مراحل را نیز برای ایجاد تیرهای  شده بطور خلاصه آورده شده است.

ظاهر شود. در بخش  New Elementاقدام نمایید تا پنجره  Addطی نمایید. از گزینه 

Element Name  نامB1  را به عنوان نام تیری که قصد ایجاد آن را داریم را وارد نمایید. در بخش

Element Class  گزینهBeam ًبه عنوان مقطع تیر تعریف شده بود را انتخاب نمایید. در  که قبلا

بین  B1های دو سر المان مورد نظر را تعیین نمایید. تیر بایستی گره Element End Nodesبخش 

تیک گزینه  Element Orientationبایستی واقع شود. در بخش  N11و  N12گره 

Define by Rotation Angle مقطع از مقدار پیش فرض پیروی نماید. بقیه  را بزنید تا زاویه دوران

مختصات و شماره ای از تیرها را با روش افزایشی که در قبل تشریح شد ایجاد نمایید. در ادامه خلاصه

 Element Connectivityگره

شود، نمای ها نشان داده شده است. همانطور که در سمت راست پنجره دیده میالمانبعد از تعریف 

در اینجا سازه مدلسازی شد. نمای سه بعدی سازه به همراه  سه بعدی سازه نشان داده شده است.

 نشان داده شده است. 23-3شکل ها در شماره گره

 هاگره المان نام المان

C1 Column N1   N11   deg=0.00 

C2 Column N2   N12   deg=0.00 

C3 Column N3   N13   deg=0.00 

C4 Column N4   N14   deg=0.00 

C11 Column N11   N21   deg=0.00 

C12 Column N12   N22   deg=0.00 

C13 Column N13   N23   deg=0.00 

C14 Column N14   N24   deg=0.00 

C5 Column N5   N15   deg=0.00 

C6 Column N6   N16   deg=0.00 

C7 Column N7   N17   deg=0.00 

C8 Column N8   N18   deg=0.00 

C15 Column N15   N25   deg=0.00 

C16 Column N16   N26   deg=0.00 

C17 Column N17   N27   deg=0.00 

C18 Column N18   N28   deg=0.00 
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B1 Beam N11   N12   deg=0.00 

B2 Beam N12   N13   deg=0.00 

B3 Beam N13   N14   deg=0.00 

B4 Beam N15   N16   deg=0.00 

B5 Beam N16   N17   deg=0.00 

B6 Beam N17   N18   deg=0.00 

B11 Beam N21   N22   deg=0.00 

B12 Beam N22   N23   deg=0.00 

B13 Beam N23   N24   deg=0.00 

B14 Beam N25   N26   deg=0.00 

B15 Beam N26   N27   deg=0.00 

B16 Beam N27   N28   deg=0.00 

B7 Beam N11   N15   deg=0.00 

B8 Beam N12   N16   deg=0.00 

B9 Beam N13   N17   deg=0.00 

B10 Beam N14   N18   deg=0.00 

B17 Beam N21   N25   deg=0.00 

B18 Beam N22   N26   deg=0.00 

B19 Beam N23   N27   deg=0.00 

B20 Beam N24   N28   deg=0.00 

 
 هادر انتهای تعریف المان مدل ایجاد شده 22-3شکل 
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 سه بعدی سازه نمای 23-3شکل 

 

  ،قیدهاپیش پردازش( :Pre-Processor–Constraints) 
توان برای ها را به یک گره مقید نمود. از این قابلیت میتوان برخی از گرهمی Constraintsدر برگه 

کلیک نمایید تا  Addتعریف دیافراگم صلب استفاده نمود. بدین منظور در این برگه بر روی گزینه 

گزینه  Constraint Typeظاهر شود. در این پنجره و در بخش  New Nodal Constraintپنجره 

Rigid Diaphragm  و در بخشRestraint Type  گزینهXY plane  را انتخاب نمایید. حال در بخش

Master Node  گرهN13 های را به عنوان گره مرجع انتخاب و گرهN11  تاN18  را بجزN13 در ،

را  24-3شکل ) انتخاب نمایید  Slave Nodesبخش 

 .ببینید(
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 هامقید نمودن گره 24-3شکل 

 

ا به عنوان ر N23برای ساختن دیافراگم طبقه دوم نیز به همین روش اقدام نمایید. در این حالت گره 

در بخش  N23های مقید شده به گره را به عنوان گره N23را بجز  N28تا  N21های گره مرجع و گره

Slave Nodes .برگه  انتخاب نماییدConstraints نشان داده  25-3شکل ها در بعد از تعریف دیافراگم

 شده است.

 
 های تعریف شدهدیافراگم 25-3شکل 

 

  ،هاگاهتکیهپیش پردازش( :Pre-Processor–Restraints) 
 N1های های سازه است. برای این منظور گرهگاهآخرین گام در مدلسازی هندسی سازه، تعریف تکیه

 نشان داده شده است. 26-3شکل را انتخاب نمایید. روند کار در  Editرا انتخاب و گزینه  N8تا 
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 هاگاهمقید نمودن تکیه 26-3شکل 

 

  ،اعمال بارهاپیش پردازش( :Pre-Processor–Applied Loads) 

ابجایی جفی میزان در یک تحلیل استاتیکی غیرخطی نیاز به تعریف یک رژیم بارگذاری برای معر

را انتخاب  Addگزینه  Nodal Loadو در بخش  Applied Loadsطبقات است. بدین منظور در برگه 

در  24-3شکل را انتخاب نمایید. مطابق  Incremental Loadدر پنجره ظاهر شده گزینه  نمایید.

 مایید.را انتخاب ن N15و  N11گره  List of Nodesبخش 

 
 اعمال بارگذاری برای بیان رژیم بارگذاری استاتیکی غیرخطی 27-3شکل 

 ج

را وارد نمایید.  11عدد  Valueو در بخش  forceگزینه  Type، در بخش xجهت  Directionدر بخش 

ورت گفته شده در فوق وارد نمایید. در جدول بص 21نیز بارهایی به میزان  N25و  N21های برای گره

 زیر خلاصه بارگذاری جانبی بر روی سازه آورده شده است.
 مقدار نوع بار جهت شماره گره طبقه بندی بار

Incremental Load N11 x force 10 
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Incremental Load N15 x force 10 

Incremental Load N21 x force 20 

Incremental Load N25 x force 20 

  ،فاز بارگذاریپیش پردازش( :Pre-Processor–Loading Phases) 
 Loading Phasesکنترل بارگذاری قابل تعریف است. بدین منظور در برگه  Loading Phasesدر برگه 

 Phase Type در پنجره ظاهر شده، در بخش 24-3شکل کلیک نمایید. مطابق  Addبر روی گزینه 

متر را به عنوان جابجایی  0.14عدد  Target Displacementو در بخش  Response Controlگزینه 

های برنامه برای رسیدن به این جابجایی هدف تعداد گام Stepsهدف سازه تعیین نمایید. در بخش 

 شود.تعیین می

 
 حوه کنترل بارگذارین 28-3شکل 

 Name  ،بایستی مشخص شود که منظور از جابجایی هدف

 Directionرا انتخاب نمودیم. همچنین در بخش  N23جابجایی کدام گره است که در اینجا ما گره 

 را برای پوش سازه انتخاب نمایید. xجهت 

  ،معیار عملکردپیش پردازش( :Pre-Processor–Performance Criteria) 

کاربرا قادر به تعریف معیار عملکردی برای اعضای سازه مدل شده  Performance Criteriaدر برگه 

 Performanceنماییم. در برگه می ها معیار عملکردی تعریفاست. در این مثال ما برای برش ستون

Criteria بر روی گزینه ،Add  کلیک نمایید تا پنجرهNew Performance Criterion  ظاهر شود. در

 Criterion Typeوارد نمایید. در بخش  Shearنام معیار را  Criterion Nameاین پنجره در بخش 
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و در بخش  111عدد  Valueدر بخش د. انتخاب نمایی Frame Element Shear forceنوع معیار را 

Type of Notification  عبارتNotify های را انتخاب نمایید. حال در بخش پایین پنجره ستون

تنظیمات  27-3شکل در  میباشند را انتخاب نمایید. C18تا  C1های تعریف شده در مدل را که نام

 .این بخش نشان داده شده است

 
 تعریف معیار عملکردی 29-3شکل 

 

  ،خروجی تحلیلپیش پردازش( :Pre-Processor–Analysis Output) 
های مورد نیاز خود را تعیین نماید. بدین منظور در برگه تواند خروجیقبل از تحلیل سازه، کاربر می

Analysis Output توان بعد از انجام مراحل مدلسازی، حال می کامل نمایید. 31-3شکل ، مطابق

اقدام نمایید یا بر روی آیکون  Run>Processorسازه را تحلیل نمود. بدین منظور از مسیر 
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 تحلیل تنظیمات خروجی 31-3شکل 

 

 ( :پردازشProcessor) 

 Runبر روی دکمه  Running Analysisدر این مرحله، کاربر قادر به تحلیل سازه است. در بخش 

کلیک نمایید تا عملیات تحلیل انجام شود. در صورت انتخاب گزینه 

See only essential information [fastest]  فقط اطلاعات اصلی تحلیل در بخشAnalysis Log 

در صورت انتخاب گزینه  شود.شود با در این گام روند تحلیل سریعتر انجام مینشان داده می

Realtime plottingشود. ، منحنی ظرفیتی سازه در حال تحلیل به صورت به هنگام نشان داده می

، تغییرشکل سازه Realtime drawing of the deformed shapeهمچنین در صورتی انتخاب گزینه 

 (.31-3شکل شود )در حین تحلیل بصورت بهنگام نشان داده می

 
 بعد از تحلیل سازه 31-3شکل 
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های مورد نیاز را استخراج توان به بخش پس پردازش رفته و خرجیبعد از انجام تحلیل سازه، می

 نمایید.

 دیدن تغییرشکل سازهپردازش،  سپ( :Post-Processor–Deformed Shape Viewer) 

های تحلیل کار توان بر روی خروجیمی Run>Post-Processorیا  با استفاده از دکمه 

توان تغییرشکل سازه را می Deformed Shape Viewerو در برگه  Post-Processorنمود. در محیط 

مشاهده نمود. برای این منظور بر روی هر گام افزایشی که با عبارت در هر گام افزایشی سازه 

Output No  مشخص شده است دوبار پشت سر هم کلیک نمایید تا تغییرشکل سازه در آن گام در

نشان داده  32-3شکل در  44به عنوان مثال تغییرشکل سازه در گام  شکل سمت راست دیده شود.

 است. شده

 
 44تغییرشکل سازه در گام  32-3شکل 

 

 پارامترهای پاسخ کلیپردازش،  پس( :Post-Processor–Global Response 

Parameters) 
توان منحنی تغییرشکل می Global Response Parametersو در برگه  Post-Processorدر محیط 

ای سازه را مشاهده نمود. برای دیدن ها و همچنین منحنی چرخهگاهیروها و لنگرها در تکیهسازه، ن

 Structural Displacementsو زیربرگه  Global Response Parametersتغییرشکل سازه در برگه 

باکس زیر را انتخاب نمایید. حال در چک xرا انتخاب و در مقابل آن جهت  displacementحالت 

 Refreshرا انتخاب و سپس گزینه  N23 گره

انتخاب شده باشد، نمایشی از تغییرشکل گره در  graphگزینه  

گزینه  Viewبخش  . همچنین در صورتی که در(33-3شکل ) نمای سمت راست دیده خواهد شد
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values  انتخاب شده باشد، بجای نمایش گراف تغییرشکل، مقادیر عددی تغییرشکل نمایان خواهد

روند کپی  کپی نمود. Excelتوان این مقادیر را به یک برنامه صفحه گسترده به مانند شد و می

 نشان داده شده است.  34-3شکل نمودن مقادیر عددی گراف تغییرشکل، در 

 
 N23تغییرشکل گره  33-3شکل 

 

 
 های صفحه گستردهروند کپی نمودن مقادیر عددی گراف برای استفاده از برنامه 34-3شکل 

 

 Forces and Moments at Supportsان در همین برگه و از زیربرگه تو، میبرای تعیین برش پایه کلی

را  Total support forces/momentsدر این برگه گزینه  نسبت به گرفتن این خروجی اقدام نمایید.

را انتخاب نمایید. در این حالت برش  Xaxisو  forceهای . از قسمت بالای آن گزینهانتخاب نمایید

برای نمایش منحنی ظرفیت سازه )برش پایه در پایه در برابر ضرا

 displacementاقدام نمایید. گزینه  Hysteretic Curvesبرابر جابجایی بام( از همین برگه و زیربرگه 

 Total Base Shear/Momentگزینه  Leftaxis (load level)را انتخاب نمایید. در بخش  Xaxisو 

را انتخاب نمایید،  Refreshسپس گزینه  را انتخاب نمایید. N23گره  Node 1انتخاب و در بخش را 

 graphگزینه  Viewدر صورتی که در بخش  تا برش پایه در برابر جابجایی بام نمایش داده شود.

(. 36-3شکل انتخاب شده باشد، نمایشی از تغییرشکل گره در نمای سمت راست دیده خواهد شد )

Web: www.M-Alirezaei.com

Telegram Channel: @AlirezaeiChannel استفاده غیر تجاری از این اثر با ذکر منبع بلامانع است



 هاتحلیل غیرارتجاعی سازه     42

انتخاب شده باشد، بجای نمایش گراف  valuesگزینه  Viewهمچنین در صورتی که در بخش 

توان این مقادیر را به یک برنامه صفحه تغییرشکل، مقادیر عددی تغییرشکل نمایان خواهد شد و می

 کپی نمود. Excelگسترده به مانند 

 
 برش پایه 35-3شکل 

 

 
 نمایش ظرفیت سازه )برش پایه در برابر جابجایی( 36-3شکل 

 

شود، محور قائم منفی است. برای دیدن مقادیر برش پایه بصورت اعداد مثبت، همانطور که دیده می

ابتدا بر روی یک ناحیه از گراف نشان داده  34-3شکل ، مطابق برای تغییر علامت اعداد محور قائم

را انتخاب نمایید. در پنجره ظاهر شده و  Post-Prossor Settingشده راست کلیک نمایید و گزینه 

ار قر 1-را برابر  Yaxis Multiplierعدد نوشته شده در روبروی عبارت  Output Displayدر بخش 

 ضرب شوند.  1-داده تا تمام مقادیر مربوط به این محور در عدد 
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 تغییر علامت منفی محور قائم 37-3شکل 

 

 العملی الماناثرات عکسپردازش،  پس( :Post-Processor–Element Action Effects) 
های برش، لنگر و نیروی محوری برای هر یک توانید دیاگرامیم Element Action Effectsدر برگه 

، مقدار دیاگرام لنگر 34-3شکل به عنوان مثال در  های مدلسازی شده را مشاهده نمایید.از المان

تحلیل، نشان داده شده است. برای این منظور، در  بخش  31برای اعضای سازه در گام 

Frame Forces Viewer  گزینه در صورتی کهHorizontal Elements Only   فعال باشد، فقط پاسخ

فعال باشد، پاسخ انتخابی برای اعضای  Vertical Elements Onlyاعضای افقی و در صورتی که گزینه 

 شود.نشان داده میقائم 

 
 ر برای اعضادیاگرام لنگ 38-3شکل 

 

بایستی دوران المان و برش المان نیز کنترل شود. برای کنترل این  ATC40و  FEMA356طبق 

 استفاده نمایید.  Frame Forcesو  Frame Deformationsموارد از زیربرگه 
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 مدلسازی و تحلیل مقادیر ویژه یک سازه دو طبقه بتنی -4 فصل

 مقدمه -4-1

های ارتعاش مودی یک سازه دو طبقه یین و ترسیم شکلدر این پروژه تحلیل مقادیر ویژه برای تع

بتنی مورد بحث قرار خواهد گرفت. بدین منظور جهت کاهش زمان مدلسازی از مدل ساخته شده 

 در فصل قبل استفاده خواهد شد.

 و انتخاب نوع تحلیل باز نمودن پروژه قبل -4-2

قدام به باز نمودن پروژه قبلی که ا …File>Open، از مسیر Seismostruct بعد از باز نمودن برنامه 

در نوار  به جای این کار میتوانید از آیکون  ذخیره شده است، بنمایید. tutorial N.1.spfبا نام 

اقدام به ذخیره فایل موجود به  File>Save asابزار اصلی استفاده نمایید. حال با با استفاده از مسیر 

گزینه  Pre-Processorدر قسمت  1-4شکل مطابق  یید.( نماtutorial N.2.spfنام دیگری )مثلاً 

Eigenvalue analysis .را انتخاب نمایید 

 
 انتخاب تحلیل مقادیر ویژه 1-4شکل 

 

  در تحلیلEigenvalue analysis  و شکل ارتعاشی مودهای نیازی به تعریف بار خارجی نبوده

برای تعریف جرم  شود.سازه توسط مشخصات طبیعی سازه به مانند جرم و سختی آن تعیین می

 اقدام شود. Element Classesبایستی در برگه 

 تعريف پارامترهای تحلیل مقادير ويژه -4-3

 تعریف المان( :Pre-Processor–Element Classes) 
کلیک نمایید.  Addبر روی گزینه  Mass Element Type، و در بخش Element Classesدر برگه 

را وارد نمایید. در بخش  LMassعبارت  Element Classحال در پنجره ظاهر شده، در بخش 

Element Type  گزینهlmass:Lumped(concentrated) mass element .در بخش  را انتخاب نمایید
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Mx [tonne] ،My [tonne]  وMz [tonne]  مقدار جرم مورد نظر را وارد نمایید. در این پروژه ما مقدار

 .(2-4شکل ) توان جرم دورانی نیز تعریف نمودگیریم. در صورت نیاز میتن در نظر می 1جرم را 

 
 معرفی جرم 2-4شکل 

 

 هااتصال المان، پیش پردازش( :Pre-Processor–Element Connectivity) 
شود. برای این منظور در این برگه بر روی ها دردر این برگه انجام میهای متمرکز به گرهمعرفی جرم

وارد  Element Nameرا در قسمت  Mass1کلیک نمایید و در پنجره ظاهر شده عبارت  Addدکمه 

را که قبلاً تعریف شده بود را انتخاب نمایید و در  LMassگزینه  Element Classنمایید. در بخش 

ای را قصد الحاق جرم به آن را دارید را انتخاب نمایید. برای نام گره Element End Nodesبخش 

 های جرمی تعریف نمایید.های واقع در طبقه اول و دوم المانهکل گر

 
 اختصاص جرم به یک گره 3-4شکل 

 

 های جرمی و شماره گره متناظر با آنها نشان داده شده است:در جدول زیر شماره المان
 شماره گره نوع المان جرمی نام المان

Mass1 LMass N11 
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Mass2 LMass N12 

Mass3 LMass N13 

Mass4 LMass N14 

Mass5 LMass N15 

Mass6 LMass N16 

Mass7 LMass N17 

Mass8 LMass N18 

Mass11 LMass N21 

Mass12 LMass N22 

Mass13 LMass N23 

Mass14 LMass N24 

Mass15 LMass N25 

Mass16 LMass N26 

Mass17 LMass N27 

Mass18 LMass N28 

 ر پنجرهد تنظیمات تحلیل مقادیر ویژه را تعیین نمایید. …Tools>Project Settingsحال از مسیر 

Project Settings  و در برگهEigenvalue  و در بخشEigenSolver  گزینهLanczos  را انتخاب

شکل وارد نمایید ) 11برابر  Number of Eigenvaluesنمایید. تعداد مدهای نوسانی سازه را در بخش 

4-4.) 

 
 تنظیمان تحلیل 4-4شکل 
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 Runبر روی دکمه  Running Analysisدر این مرحله، کاربر قادر به تحلیل سازه است. در بخش 

 کلیک نمایید تا عملیات تحلیل انجام شود. 

 ،های تحلیل مودالکمیتپردازش( :Post-Processor–Modal/Mass Quantities) 

های تحلیل کار توان بر روی خروجیمی Run>Post-Processorیا  فاده از دکمه با است

های مربوط کمیتتوان می Modal/Mass Quantitiesو در برگه  Post-Processorنمود. در محیط 

 .(5-4شکل ) به تحلیل مودال را مشاهده نمود

 خروجی هر گام تحلیلپردازش،  پس: (Post-Processor– Step Output) 
 (.6-4شکل توان میزان جابجایی مدی در هر مود را مشاهده نمود )می Step Outputدر برگه  

 دیدن تغییرشکل سازهپردازش،  پس( :Post-Processor– Deformed Shape Viewer) 
ز این برگه استفاده نمایید. با دوبار کلیک بر روی مد برای دیدن تغییرشکل سازه در هر مد نوسانی، ا

 شود.انیمیشن حرکت سازه در هر مد نشان داده می Animate 3D modelدلخواه و زدن تیک 

 
 های تحلیل مودالکمیت 5-4شکل 
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 میزان جابجایی مدی برای هر گره 6-4شکل 
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 یک سازه دو طبقه بتنیتاریخچه زمانی مدلسازی و تحلیل  -5 فصل

 مقدمه -5-1

قبل مورد بررسی  هایغیرارتجاعی برای یک سازه دو طبقه بتنی که در مثالدر این پروژه تحلیل 

گاشت جهت نصب در های شتابندستگاه. قرار گرفته بود، را مبنای تحلیل جدید قرار خواهیم داد

اند و اطلاعات های مهم بسیار مناسبهای فعال و همچنین در سازهها و گسلنزدیکی مراکز زمین لرزه

ها همچنین برای تحلیل آنها در مهندسی زلزله از اهمیت زیادی برخوردار هستند. از شتابنگاشت

شود. و بزرگی(استفاده میطبیعت جنبش قوی زمین )فاصله، عمق، شتاب، جابجایی، ساز و کار گسل 

مطالعه بر روی جنبش زمین شروع  هایی برای( برنامه1725بعد از زلزله سانتاباربارا در کالیفرنیا )

نگار مورد استفاده قرار گرفت و اولین رکورد ثبت شده های شتابهاولین دستگا 1732شد. در سال 

زلزله  1741باشد. در سال ( می6.4wM=بیچ )مربوط به زلزله لانگ 1733مارس  11در سال 

رخ داد که این رویداد توسط یک شتابنگار که در زیرزمین یک  6.9wM=ولی با بزرگی امپریال

کیلومتر بود به  6ساختمان بتنی در السنترو قرار داشت و فاصله آن تا محل گسیختگی در حدود 

ای زههای لرر جهان برای تحلیلثبت رسید. رکورد ثبت شده در السنترو برای سالیان دراز در سراس

های اینترنتی که بر روی آنها لیستی از پایگاه 1-5جدول  و طراحی مورد استفاده قرار گرفت.

 دهد.های موجود، قرار داده شده است را نشان مینگاشترکوردهای مختلفی از شتاب
 های اینترنتی موجود در ارتباط با رکوردهای زلزلهپایگاه 1-5جدول 

 منبع پایگاه اینترنتی

http://www.consrv.ca.gov/cgs/smip/ California Strong Motion Instrumentation Program 

(CSMIP) 

http://docinet3.consrv.ca.gov/csmip/cisn-

edc/default.htm 
California Integrated Seismic Network (CISN) 

http://nsmp.wr.usgs.gov/ U.S. Geological Survey (USGS) 

http://www.trinet.org/ ‘TriNet’، and ‘ShakeMap’ 

http://www.usc.edu/dept/civil_eng/Earthquake_eng/ University of Southern California (USC) 

http://www.ngdc.noaa.gov/seg/hazard/strong.html 
US National Geophysical Data Center 

(NGDC/NOAA) 

http://peer.berkeley.edu/smcat/search.html 
Pacific Earthquake Engineering Research (PEER) 

Center 

http://nisee.berkeley.edu/data/strong_motion/sacsteel/ SAC steel project، strong-motion database 
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 باز نمودن پروژه قبل و انتخاب نوع تحلیل -5-2

اقدام به باز نمودن پروژه قبلی که  …File>Open، از مسیر Seismostruct بعد از باز نمودن برنامه 

در نوار  ذخیره شده است، بنمایید. به جای این کار میتوانید از آیکون  tutorial N.2.spfبا نام 

اقدام به ذخیره فایل موجود به  File>Save as. حال با با استفاده از مسیر ابزار اصلی استفاده نمایید

گزینه  Pre-Processorدر قسمت  1-4شکل مطابق  ( نمایید.tutorial N.3.spfنام دیگری )مثلاً 

Dynamic time-history analysis  را انتخاب نمایید. در این حالت برگهTime-history Curves  به

 شود.اضافه می Pre-Processorهای قسمت لیست برگه

 
 انتخاب تحلیل تاریخچه زمانی 1-5شکل 

 

  در تحلیلEigenvalue analysis  نیازی به تعریف بار خارجی نبوده و شکل ارتعاشی مودهای

برای تعریف جرم  شود.به مانند جرم و سختی آن تعیین میسازه توسط مشخصات طبیعی سازه 

 اقدام شود. Element Classesبایستی در برگه 

 تعريف پارامترهای تحلیل مقادير ويژه -5-3

 های تاریخچه زمانیمنحنیپردازش،  پیش( :Pre-Processor– Time-history Curves) 

کلیک نمایید. حال  Loadر روی گزینه ب Load Curvesو در بخش  ،Time-history Curvesدر برگه 

نصب برنامه موجود  که در پوشه Friulliاقدام به وارد نمودن شتابنگاشت زلزله در پنجره ظاهر شده، 

 C:\Programمیباشد، نمایید )این فایل به طور پیش فرض در مسیر 

Files SeismoStruct\Accelerograms .)قرار دارد 
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 وارد نمودن شتابنگاشت به برنامه 2-5شکل 

 

را  Friulliعبارت  Descriptionو در  TH1نام دلخواه  Curve Name، در بخش 2-5شکل مطابق 

رنامه معرفی نموده مسیر فایل شتابنگاشت فوق را به ب Select Fileدرج نمایید. با استفاده از دکمه 

شود. برای تثبت و آن را باز نمایید. در شکل پایین پنجره، شکل نگاشت این زلزله نشان داده می

بر  Timehistory Stagesکلیک نمایید. حال در همین برگه و در بخش  OKاطلاعات بر روی دکمه 

که معرف مدت زلزله  21عدد  End of Stageدر برابر عبارت  ،کلیک نمایید. مطابق Addروی دکمه 

که برابر تعداد نقاط آن شتابنگاشت است، را وارد نمایید. در این  2111عدد  Stepsو در برابر عبارت 

ثانیه خواهد بود. برای تثبت اطلاعات بر روی دکمه  0.01حالت بازه زمانی بین نقاط شتابنگاشت برابر 

OK  .کیلک نمایید 

  برنامهSeismoStruct ر بازه زمانی بین نقاط یک شتابنگاشت را از تقسیم زمان کل بطور خودکا

 کند.شتابنگاشت بر تعداد نقاط آن شتابنگاشت تعیین می
 

  ،اعمال بارهاپیش پردازش( :Pre-Processor–Applied Loads) 
 Addبر روی گزینه  Applied Loadsبرای اعمال شتابنگاشت مورد نظر به سازه مدل شده، در برگه 

را  Dynamic Timehistory Load، در پنجره ظاهر شده گزینه 3-5شکل مطابق  مایید.کلیک ن

را انتخاب نمایید.  N8تا  N1های گره List of Nodesها در بخش انتخاب نمایید. حال از لیست گره

 آنها کلیک نمایید. را پایین نگه دارید و بر رویبرای انتخاب آنها می
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 های برنامهگاهاعمال شتابنگاشت به تکیه 3-5شکل 

 

را انتخاب نمایید. در  accelerationگزینه  Typeرا انتخاب و در برابر  xجهت  Directionدر بخش 

است را وارد نمایید. توجه نمایید در  s9.81 m/2شتاب ثقل زمین که برابر  Multiplier Curveبرابر 

انتخاب شود.  1.0صورتی که شتابنگاشت شما دارای واحد شتاب بود، این ضریب بایستی برابر 

بوده و در اینجا نیاز بود که با ضرب کل آن در  gشتابنگاشت انتخابی که وارد برنامه شد، بر حسب 

g .هایی که این شتابنگاشت در آن در نظر گرفته هدر جدول زیر، هر یک از گر واحد آن اصلاح شود

که در قبل تعریف شد را  TH1منحنی  Curve Nameدر بخش  شده است، نشان داده شده است.

های در گره 4-5شکل هایی مطابق بعد از اعمال این بارهای شتابی به برنامه، پیکان انتخاب نمایید.

 شود.میاعمای نشان داده 

 تابع شتابنگاشت ضریب نوع بار جهت اعمال بار نام گره نوع تحلیل

Dynamic Time-history Load N1 TH1 

Dynamic Time-history Load N2 x acceleration 9.81 TH1 

Dynamic Time-history Load N3 x acceleration 9.81 TH1 

Dynamic Time-history Load N4 x acceleration 9.81 TH1 

Dynamic Time-history Load N5 x acceleration 9.81 TH1 

Dynamic Time-history Load N6 x acceleration 9.81 TH1 

Dynamic Time-history Load N7 x acceleration 9.81 TH1 

Dynamic Time-history Load N8 x acceleration 9.81 TH1 
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 اعمال بار شتابی به برنامه 4-5شکل 

 

( :Pre-Processor–Analysis Output) 
تعیین نمایید. مطابق  Analysis Outputقبل انجام تحلیل سازه، بایستی خروجی مورد نظر در برگه 

 N1و  N25گره   Nodesو در بخش  Realtime Plotting During Analysisر بخش ، د5-5شکل 

 را انتخاب نمایید تا در حین تحلیل، تغییرشکل نسبی بین این دو گره نمایش داده شود.

 
 تعریف خروجی تحلیل 5-5شکل 

 

 ( :پردازشProcessor) 
 Runبر روی دکمه  Running Analysisله، کاربر قادر به تحلیل سازه است. در بخش در این مرح

(. بعد از انجام تحلیل، در قسمت پس پردازش، 6-5شکل ایید تا عملیات تحلیل انجام شود )کلیک نم

تحلیل به  هایتوان بر روی خروجیمی Run>Post-Processorیا  با استفاده از دکمه 

 مانند تغییرشکل سازه را مشاهده نمود.
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 تحلیل سازه 6-5شکل 
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 SeismoStructافزار مدلسازی سریع در نرم -6 فصل

 مقدمه -6-1

شود که در آن به پرداخته می SeismoStructهای برنامه در این قسمت، به بررسی یکی از قابلیت

 WIZARDدهد. این قابلیت در برنامه تحت عنوان زه مدلسازی سریع یک سازه را میکاربر اجا

اقدام  یا آیکون  File > Wizardنامگذاری شده است. برای دسترسی به این قابلیت از مسیر 

 محیط این قسمت نشان داده شده است. 1-6شکل در  نمایید.

 
 در برنامه Wizardمحیط قسمت  1-6شکل 

 

، کاربر بایستی Structural Model، و در بخش SeismoStruct Wizardدر پنجره  1-6شکل مطابق 

ی موجود هانوع سازه را از نظر دو یا سه بعدی بودن مشخص نماید. با کلیک بر روی هر یک از آیکون

باشد که دو بعدی، حالتی از وضعیت سه بعدی سازه می وضعیتنوع تحلیل مشخص خواهد شد. 

پیکربندی سازه به لحاظ تعداد  Structural Configurationتنظیمات را ندارد. در بخش برخی از 

، و در قسمت، Structural Configurationشود. در بخش .. تعیین می.دهانهف تعداد طبقات و

Number of Bays  ،تعداد دهانهNumber of Storeys  تعداد طبقات، و در قسمت

Number of Frames شوند. در بخش تعیین میها تعداد قابReference Dimensions  فواصل

 Bay Length (m)و در قسمت  Reference Dimensions.. قابل تعیین است. در بخش .ها ودهانه

 Frame Spacing (m)ارتفاع طبقات و در قسمت  Storey Height (m)ها، در قسمت طول دهانه

تنظیمات مربوط به نوع مصالح و منظمی  Settingsها قابل تعیین است. در بخش فواصل بین قاب
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، در صورتی که سازه به لحاظ Regular Structureسازه قابل اعمال است. در این بخش و در قسمت 

فاع باشد، تیک زده شود. در صورتی که سازه نامنظم باشد، هندسی دارای منظمی در پلان و ارت

فعال شده و کاربر قادر به اعمال نامنظمی سازه است. در بخش  Structural Dimensionsدکمه 

Structural Material  نوع مصالح سازه تعیین شود. در این حالت دو مصالح بتنی

(Reinforced Concrete Structure( و فولادی )Steel) .در بخش  در دسترس استLoading  نوع

 Loading Typeتوان از قسمت و نوع بارگذاری را می Analysis Typeتوان از قسمت تحلیل را می

( به نوع تحلیل بستگی دارد. به عنوان مثال در Loading Typeتعیین نمود. وجود قسمت اخیر )

دو نوع توزیع بارگذاری جانبی یکنواخت انتخاب شود،  Static pushover analysisصورتی که تحلیل 

(Uniform distribution( و مثلثی )Triangular distribution.در اختیار کاربر قرار دارد ) 

 تنظیمات( :Settings) 
، را تعیین نماید. در حالتی از 1در این برگه، کاربر بایستی نوع مصالح، شامل مصالح فولادی یا بتنی

Wizard ساخته می 2نمایید، المانهای ایجاد شده بصورت غیرارتجاعی براساس نیرو برنامه استفاده

شوند. در صورتی که کاربر نیاز به تعریف المان از نوع دیگری داشته باشد، بعد از ساخت مدل اولیه 

هایی ، توسط گرهWizardهای ایجاد شده در قادر به تغییر نوع المان بصورت دستی است. تمام المان

ها بصورت خودکار با یک حرف و سه رقم شوند. نام هر یک از گرهای به هم متصل میازهاز نوع س

های ایجاد شده دارای فرمتی تمام گره شروع میشود. n111ها با نام شود. نام گرهعدد ایجاد می

شماره طبقه )شروع از پایین  jشماره ستون )شروع از چپ(،  iباشند که در آن می

مربوط به ستون  n132شماره قاب )شروع از قاب جلویی( است. به عنوان مثال گره شماره  kبالا( و  به

میزان دوران المان در حین ساختن مدل  چپ، طبقه دوم )سطح سوم( و مربوط به قاب دوم است.

 ، بصورت پیش فرض برابر صفر است.Wizardدر محیط 

 بارگذاری( :Loading) 
 ز هشت نوع تحلیل موجود در برنامه را انتخاب نماید:کاربر بایستی یکی ا

 ( تحلیل مقادیر ویژهEigenvalue analysisدر این تحلیل وزن سازه و جرم :) های اختصاص

 داده شده با سازه در روند تحلیل مورد استفاده قرار گرفته و نیاز به تعریف بارگذاری نیست.

 استاتیکی غیرخطی با بار غیرمتغی تحلیل( رStatic analysis with non-variable loads :)

 در این تحلیل بایستی بارهای ماندگار ثقلی تعریف شوند.

                                                        
1 Reinforced concrete or steel structure 
2 Inelastic force-based plastic-hinge (infrmFBPH) elements type 
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 ( تحلیل استاتیکی غیرارتجاعیStatic pushover analysis در این تحلیل بارهای افزایشی :)

شوند. دو نوع توزیع مثلثی و مستطیلی برای بصورت افقی در هر یک از طبقات ایجاد می

 خواهد بود. xاعمال این بارهای افزایشی در جهت  بارها قابل تعریف است.این 

 ( تحلیل استاتیکی غیرارتجاعی بهنگام شوندهAdaptive static pushover analysis :) در

 شوند.این تحلیل بارهای افزایشی بصورت افقی در هر یک از طبقات ایجاد می

 ( تحلیل استاتیکی تاریخچه زمانیStatic time-history analysis در این تحلیل تاریخچه :)

 شود.اعمال می xبارگذاری تعریف شده در بالا و سمت چپ سازه و در جهت 

 ( تحلیل دینامیکی تاریخچه زمانیDynamic time-history analysis در این تحلیل علاوه :)

وند و معمولاً شهای تراز فونداسیون اعمال میبر بارهای ثقلی، بارهای جانبی در که گره

بارها  اعمال این گیرد.شتابنگاشت تعریف شده توسط کاربر هستند مورد استفاده قرار می

 خواهد بود. xجهت در 

 ( تحلیل دینامیکی فزایندهIncremental dynamic analysis :) در این تحلیل علاوه بر

وند و معمولاً شهای تراز فونداسیون اعمال میبارهای ثقلی، بارهای جانبی در که گره

ارها گیرد. اعمال این بشتابنگاشت تعریف شده توسط کاربر هستند مورد استفاده قرار می

خواهد بود. در این حالت شتابنگاشت معرفی شده با ضرائب مقیاس تعریف  xجهت در 

شده توسط کاربر در هر تحلیل تغییر یافته و هر بار یک تحلیل جداگانه برای سازه صورت 

 ت.خواهد گرف

 ( تحلیل طیف پاسخResponse spectrum analysis ،در این تحلیل علاوه بر بارهای ثقلی :)

 بارهای استاتیکی متناسب با شکل ارتعاش مودی به سازه اعمال میشود.

  حداکثر ابعاد یک سازه که میتوان آن را در برنامهSeismoStruct  توسطWizard  ،مدلسازی نمود

 ه با طبق 4دهانه،  4یک سازه 
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 SeismoStructافزار پیش پردازش در نرم -7 فصل

 مقدمه -7-1

سازه خواهیم پرداخت. از در مدلسازی  SeismoStructهای برنامه در این قسمت، به بررسی قابلیت

جمله موارد مهم، محیط پیش پردازش بوده که در این بخش معرفی اجمالی از این محیط و 

 های آن خواهیم داشت.قابلیت

  قبل از شروع مدلسازی در برنامهSeismoStruct .بهتر است نوع تحلیل را تعیین نمایید 

 انواع تحلیل -7-2

 در حال حاضر برنامه قادر به انجام هشت تحلیل زیر است:

 ( تحلیل مقادیر ویژهEigenvalue analysis) 

 ( تحلیل استاتیکی غیرخطی با بار غیرمتغیرStatic analysis with non-variable loads) 

 ( تحلیل استاتیکی غیرارتجاعیStatic pushover analysis) 

 ( تحلیل استاتیکی غیرارتجاعی بهنگام شوندهAdaptive static pushover analysis) 

 ( تحلیل استاتیکی تاریخچه زمانیStatic time-history analysis) 

 ( تحلیل دینامیکی تاریخچه زمانیDynamic time-history analysis) 

 ( تحلیل دینامیکی فزایندهIncremental dynamic analysis) 

 ( تحلیل طیف پاسخResponse spectrum analysis) 

، در حالتی 1-4شکل ای بالای برنامه مطابق توان براحتی از منوی کرکرههای فوق را میتمام تحلیل

 ( قرار دارد، انتخاب نمود.Pre-Processorکه برنامه در وضعیت پیش پردازش )

 
 انتخاب نوع تحلیل سازه 1-7شکل 
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بسته به اینکه کاربر چه تحلیلی را انتخاب نموده باشد، بایستی اقدام به مدلسازی، متناسب با نوع 

های ارتجاعی و یا غیرارتجاعی ن از المانتواتحلیل خود بنماید. به عنوان مثال، در هر نوع تحلیلی می

های ارتجاعی کاربردی ندارند و تعریف آنها در این نوع در تحلیل 1ها جرمیاستفاده نمود. المان

و  های دینامیکیهای مقادیر ویژه، تحلیلها تنها در تحلیلتحلیل، بی اثر خواهد بود. این نوع المان

های ، تنها در تحلیل3های میراگربرد دارند. همچنین المانکار 2استاتیکی غیرخطی بهنگام شونده

هشداری به  2-4شکل وقتی نوع تحلیل تغییر یابد، مطابق  گیرند.دینامیکی مورد استفاده قرار می

ه کشود. به عنوان مثال در صورتی کاربر داده شده و الزامات آن تحلیل، جایگزین تحلیل قدیمی می

یک تحلیل دینامیکی را بخواهیم به یک تحلیل استاتیکی غیرخطی تبدیل نماییم، برنامه میراگرها 

 نماید.ها را بصورت خودکار حذف میو جرم

 
 هشدار تغییر در نوع تحلیل 2-7شکل 

 

 ناحیه پیش پردازش برنامه -7-3

 هایمدولهای متنوعی جعت مدلسازی سازه است. ازش دارای قسمتبرنامه در بخش پیش پرد

 ،Materials، Sections، Element Classes، Nodes، Element Connectivityشامل، برنامه 

Constraints، Restraints، Performance Criteria، Analysis Output ها در در تمام انواع تحلیل

تنها در حالتی که نوع  Adaptive Parametersها مانند مدول دسترس هستند. لیکن برخی از بخش

تحلیل استاتیمی بهنگام شونده انتخاب شده باشد، در دسترس است. در هر مدول، تعاریف انتخاب 

های مختلف مدول 3-4شکل در  شده توسط کاربر عموماً بصورت جدولی قابل دسترسی هستند.

ن داده شده است. در اینکه از مدل یک دید بزرگتری داشته باشید، بر روی دکمه مشخص برنامه نشا

کلیک نمایید تا نمای سه بعدی سازه را در پنجره بصورت تمام صفحه مشاهده  3-4شکل شده در 

 نمایید.

                                                        
1 Mass elements (lmass and dmass) 
2 Dynamic، eigenvalue and adaptive pushover analysis 
3 Damping elements (dashpt) 

Web: www.M-Alirezaei.com

Telegram Channel: @AlirezaeiChannel استفاده غیر تجاری از این اثر با ذکر منبع بلامانع است



 هاتحلیل غیرارتجاعی سازه     71

 
 های مختلف برنامهربوط به مدولبخش م 3-7شکل 

 

 ها در برنامهانتخاب واحد -7-4

قادر خواهید بود، در هر بخش از مدلسازی، نوع واحدهای جاری برنامه را  SeismoStructدر برنامه 

به محض تغییر  و انگلیسی وجود دارد. SIانتخاب و تغییر دهید. در برنامه امکان استفاده از واحدهای 

ابند. یبطور اتوماتیک تمام پارامترهای وارد شده در برنامه، به واحد جاری تغییر میواحد جاری برنامه، 

اقدام نمایید. در  و یا آیکون  Tools > Units Selectorبرای تغییر در واحد جاری برنامه از مسیر 

مختلف برنامه به همراه مقادیر متناظر برای تنش و وزن  واحدهای 2-4جدول و 1-4جدول  جدول

 مخصوص مصالح نشان داده شده است.
 SIواحدهای   1-7جدول 

طول نیرو جرم تنش شتاب وزن مخصوص
(9807) mm/sec2 MPa ton N mm 

kN/mm3 (9807) mm/sec2 GPa kton kN mm 

N/m3 (9.81) m/s2 Pa kg N m 

kN/m3 (9.81) m/s2 kPa ton kN m 

 انگلیسی واحدهای  2-7جدول 

 طول نیرو جرم تنش شتاب وزن مخصوص
lb/in3 (386.1) in/sec2 psi lb*sec2/in lb in 

kip/in3 (386.1) in/sec2 ksi kip*sec2/in kip in 

lb/ft3 (32.17) ft/s2 psf lb*sec2/ft lb ft 

kip/ft3 (32.17) ft/s2 ksf kip*sec2/ft kip ft 
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کاربر قادر به تعیین واحدهای جاری برنامه است. مطابق این شکل، در برنامه دو  4-4شکل  مطابق

نوع اول میلگردهای موجود براساس نوع اروپایی باشد. نوع میلگرد برای استفاده در برنامه موجود می

 باشند.ونوع دوم بر اساس میلگردهای آمریکایی در دسترس می

 
 پنجره مربوط به تعیین واحدهای جاری برنامه 4-7شکل 

 

 ويرايش اطلاعات ورودی -7-5

قادر خواهید بود، متناسب  Addکلیک بر روی دکمه های بخش پیش پردازش با در هر یک از مدول

با آن مدول اطلاعاتی را وارد محیط برنامه نمایید. برای وارد نمودن هر اطلاعاتی )مثلاً وارد نمودن 

یک مصالح جدید( بایستی برای آن یک اسمی مشخص و یکتا در نظر گرفته شود. برای ویرایش 

شکل عات ورودی )مثلاً یک مصالح ایجاد شده( مطابق اطلاعات مربوط به هر یک از مشخصات اطلا

 کلیک نمایید. Editاطلاعات ورودی مورد نظر را انتخاب و سپس بر روی گزینه ابتدا  4-5

  کاراکتر بوده و  32اسامی اطلاعاتی ورودی )مثلاً نام یک مصالح جدید( بایستی حداکثر دارای

و  ”،“، &و  #ام آن از بکاربردن فاصله بین حروف و همچنین استفاده از کاراکترهای در استفاده از ن

 نقطه خودداری نمود.
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 ویرایش اطلاعات ورودی 5-7شکل 

 

یرایش برای تغییر و و Applied Loadsو  Nodes ،Element Connectivity ،Restraintsهای در مدول

ای که نیاز هست برای اطلاعات ورودی بصورت یکجا، بایستی تمام آنها را انتخاب نموده و مشخصه

 Nodesهای انتخاب شده، یکسان داده شود را ویرایش نمایید. مثلاً فرض نمایید در برگه تمام آیتم

ها را انتخاب و شود. برای این منظور ابتدا آن گره 5چند گره برابر  xخواهید مقدار مختصات می

ها را برابر با مقدار مورد نظر وارد نمایید. برای انتخاب متوالی از کلید آن گره xسپس مقدار مختصات 

Shift  و برای انتخاب غیرمتوالی از کلیدCtrl  استفاده نمایید. برای حذف برخی از آیتم ورودی، ابتدا

های ورودی، شوند. برای چینش منظم آیتم Deleteها بایستی آن آیتم انتخاب شده و سپس آن آیتم

های موجود در بالای صفحه کلیک نمایید. به عنوان مثال مطابق مطابق با نوع چیدمان، بر روی گزینه

ها بر حسب نام آنها را دارید، بایستی بر روی گزینه در صورتی که قصد مرتب سازی گره 6-4شکل 

Node Name ها بر حسب مختصات نمایید و یا در صورتی که قصد مرتب سازی گره کلیکx  یاy 

 در بالای بخش ورودی اطلاعات کلیک نمایید. Xهای آنها را دارید بایستی بر روی گزینه

 
 های ورودیچینش مرتب آیتم 6-7شکل 

 

هایی مانند ورودی در بخش پیش پردازش هر مدول را کپی و در برنامهتوان اطلاعات براحتی می

Microsoft Excel  و یاMicrosoft Word های مورد نظربچسبانید. بدین منظور ابتدا بایستی آیتم 

ها اقدام به کپی و انتقال آیتم Ctrl+Cو یا  Edit > Copy Selection and Editرا انتخاب و از مسیر 

یا از مسیر  Ctrl+Vسیستم نمایید. برای چسباندن این اطلاعات از کلیدهای میانبر  به حافظه موقت

Edit > Paste Selection  اقدام نمایید. بعد از چسباندن آیتم، برای اینکه نام آن تکراری نباشد، برنامه
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ی همچنین برای کپ اضافه خواهد نمود. *به صورت پیش فرض به آنها نام چسبانده شده یک علامت 

و یا کلیدهای  Edit > Copy 3D Plotنمودن شکل گرافیکی سازه که در قسمت سمت راست از مسیر 

هایی مانند توان شکل گرافیکی را در برنامهاستفاده نمایید. بعد از کار می Ctrl+Alt+Cمیانبر 

Microsoft Excel  و یاMicrosoft Word .با راست  4-4شکل توان مطابق همچنین می بچسبانید

 را انتخاب نمایید. Copy 3D Plotکلیک بر روی شکل گرافیکی مدل، گزینه 

 
 راست کلیک بر روی شکل گرافیکی مدل و کپی نمودن آن 7-7شکل 

و  

Edit > Redo و  های توان به جای این مسیرها از آیکوناستفاده نمایید. همچنین می 

 استفاده نمایید.

وارد محیط  4-4شکل برنامه قادر به مدلسازی بصورت گرافیکی نیز هست. برای این منظور مطابق 

با کلیک دوبل بر روی هر قسمت دلخواه در پنجره گرافیکی، اقدام به  گرافیکی مدلسازی شده و

، Nodes ،Element Connectivityهای مدلسازی گره مورد نظر نمایید. این روش مدلسازی در مدول

Constraints  وLoads .موجود است 
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 محیط گرافیکی مدلسازی 8-7شکل 

 

 Tools > Organiseیا از مسیر  های مدلسازی شده از گزینه برای قرار دادن برخی المان

Groups…  های ها و الماندو حالت وجود دارد و کاربر قادر است گرهاستفاده نمایید. در این حالت

جهت  های موجود استفاده نمود.ای را در یک گره قرار داده در هنگام خروجی گرفتن از گروهسازه

 7-4شکل استفاده نمایید. در این حالت بخش از مدل مطابق  دیدن بخشی از مدل از آیکون 

کاربر براحتی قادر به چرخاندن و حرکت مدل در حالت دو و سه بعدی است. برای  استفاده نمود.

ز پنجره شناور نمایان شده، گزینه مشاهده جزئیات هر المان بر روی آن المان راست کلیک نموده و ا

Element Properties  ای خلاصهنشان داده شده است.  11-4شکل  را انتخاب نمایید. روند این کار در

 3-4جدول از دستورات مهم جهت استفاده بهینه از صفحه کلید و موس، جهت دیدن بهتر مدل در 

 آمده است.
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 دیدن بخشی از مدل 9-7شکل 

 

 
 دیدن مشخصات مربوط به یک المان دلخواه 11-7شکل 

 

 دیدن مدلراهنمای تغییر در  3-7جدول 

با استفاده از  با استفاده از موس

 صفحه کلید

 دستور

 (Zoom Inبزرگنمایی ) Arrow-up غلتک موس را به بالا بچرخانید

 Zoomکوچک نمایی ) Arrow-down غلتک موس را به پایین بچرخانید

Out) 

با کلیک و نگه داشتن کلید موس، به سمت 

 چپ بکشید

Arrow-left ( گردش به چپRotate 

Left) 

با کلیک و نگه داشتن کلید موس، به سمت 

 راست بکشید

Arrow-right  گردش به راست

(Rotate Right) 
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با کلیک و نگه داشتن کلید موس، به سمت بالا 

 بکشید

Ctrl + Arrow-up ( گردش به بالاRotate 

Up) 

با کلیک و نگه داشتن کلید موس، به سمت 

 پایین بکشید

Ctrl + Arrow-

down 
 Rotateدش به پایین )گر

Down) 

با کلیک و نگه داشتن کلید راست موس، به 

 سمت چپ بکشید

Ctrl + Arrow-
right 

 Moveحرکت به چپ )

Left) 

با کلیک و نگه داشتن کلید راست موس، به 

 سمت راست بکشید

Ctrl + Arrow-

left 
 Moveحرکت به راست )

Right) 

 با کلیک و نگه داشتن کلید راست موس، به

 سمت بالا بکشید

Shift + Arrow-

down 
 Moveحرکت به بالا )

Up) 

با کلیک و نگه داشتن کلید راست موس، به 

 سمت پایین بکشید

Shift + Arrow-

up 
حرکت به پایین 

(mouse-button) 

 تنظیمات پروژه -7-6

به توان تنظیمات مربوط می SeismoStructبرای هر یک از پروژهای ساخته شده در محیط برنامه 

و  …Tools > Project Settingsآن مدل را اعمال نمود. برای دسترسی به تنظیمات مدل از مسیر 

 بخش تنظیمات مربوط به برنامه شامل موارد زیر استدر نوار ابزار استفاده نمایید.  یا آیکون 

 :(11-4شکل )
 General 
 Analysis 

 Elements 

 Constraints 

 daptive Pushover 

 Eigenvalue 

 Constitutive Models 

 Element Subdivision 

 Response Spectrum Analysis 

 Capacity Checks 

 Convergence Criteria 
 Iterative Strategy 

 Gravity & Mass 

 Integration Scheme 

 Damping 
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 ربوط به پروژهتنظمیات م 11-7شکل 

 

 
 اعمال مقادیر پیش فرض برنامه و یا پیش فرض قرار دادن مقادیر دلخواه ورودی 12-7شکل 

 

ای ه، چند دکمه وجود دارد که در تمام برگهProject Settings، در پایین پنجره 12-4شکل مطابق 

زده شود، تمام مقادیر پیش  Program Defaultsدر صورتی که گزینه این پنجره قابل استفاده است. 

فرض برنامه جایگزین مقادیر وارد شده توسط کاربر خواهند شد. همچنین در صورت انتخاب گزینه 

Set as Defaultده گرفته شهای برنامه در نظر ، تمام مقادیر ورودی توسط کاربر به عنوان پیش فرض

 های بعدی نیز از آن مقادیر به صورت پیش فرض استفاده خواهد شد.و در پروژه

 های برنامه نیست.های معمولف نیازی به تغییر در پیش فرضبرای اکثر پروژه 

 Generalبرگه 
انتخاب شده باشد، نتایج تحلیل  Text Output: در حالتی که گزینه Text Outputگزینه  -

 (13-4شکل ) شود.ذخیره می out.*داگانه با پسوند در یک فایل ج

انتخاب شده  Multiple Text Outputدر حالتی که گزینه   -

شود. این گزینه در ذخیره می out.*نتایج تحلیل در چند فایل جداگانه با پسوند باشد، 

 (13-4شکل ) شود، مناسب است.ده میحالتی که مدل بزرگی استفا

: در این حالت تنظیمات برنامه برای استفاده در پروژه بعدی ذخیره Save Settingsگزینه  -

 شود.می

توان به جای درصورت انتخاب این گزینه، در محیط برنامه می: Allow single clickگزینه  -

تک کلیک استفاده نمود. به عنوان مثال برای تغییر در  دوبار کلیک پشت سر هم از یک

 مشخصات یک آیتم ورودی کافی است یک بار بر روی آن کلیک نمایید.

های مشخص شده : در این حالت برنامه مدل جاری را در زمان…Autosave everyگزینه  -

نماید. به صورت خودکار ذخیره نموده و تغییرات اعمال شده را بر روی مدل اعمال می

توان زمان آن را برابر صفر قرار داد. مقدار پیش برای جلوگیری از ذخیره خودکار برنامه، می

 (13-4شکل  دقیقه است.) 21فرض برنماه 
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 تنظیمات برنامه 13-7شکل 

 

 Analysisبرگه 

 بوط به تحلیل سازه در این برگه گنجانده شده است.پارامترهای مر

 : در این بخش کاربر قادر به انتخاب دو نوع روش تحلیل است:Solverبخش  -

o  روشSkyline Method 

o  روشFrontal Method 

: در این بخش در صورتی که تیک گزینه غیرخطی Geometric Nonlinearitiesبخش  -

( در تحلیل در نظر P-خطی هندسی )اثرات هندسی زده شده باشد، اثرات ثانیه غیر

 Run with Linear Elastic Propertiesشوند. همچنین در صورتی که گزینه گرفته می

غیرخطی مصالح و  تانتخاب شده باشد، نوع تحلیل به صورت ارتجاعی انجام شده و اثرا

به ست )فرض فعال نینخواهند شد. این گزینه بصورت پیشهندسه سازه در نظر گرفته 

 استثنای تحلیل طیف پاسخ(.

 
 برگه تحلیل سازه 14-7شکل 

 

 Elementsبرگه 
ای قرار دارند و کاربر قادر به تغییر هر یک از آنها های سازهدر این برگه پارامترهای مربوط به المان

 است.
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اور بتن در مقاطع بتنی در این قسمت تعیین مقدار ک: R/C Cover Thicknessگزینه  -

شود. مقدار گیری میها اندازهشود. این کاور از سطح خارجی مقطع تا مرکز خاموتمی

 سانتیمتر است. 5/2فرض برنامه پیش

های قاب که بصورت ارتجاعی و یا : در برخی از المانCarry out Stress Recoveryگزینه  -

گیرند، در صورتی که جابجایی گره در آنها صفر باشد، رار میغیرارتجاعی مورد استفاده ق

های المان، مقدار تنش و کرنش در آن نقطه در خلال پروسه تحلیل به سبب محدودیت

برابر صفر محاسبه خواهد شد که البته اشتباه است. برای جلوگیری از این مورد از این 

دقیق نیروهای داخلی برای کابر  شود. لیکن در حالتی که مقدارالگوریتم استفاده می

توان این گزینه را غیرفعال نمود. این گزینه در حالتی که بار گسترده اهمیتی ندارد، می

 ها تعریف شده است، اثر گذار خواهد بود.خطی برای المان

: Force-based Element Type / Force-based Plastic-Hinge Elements Typeگزینه  -

باشد، برای رسیدن به همگرایی مورد نیاز، آنها براساس نیرو می الگوریتمهایی که در المان

 به تعدادی تکرار نیاز است.

o  گزینهElement Loop Convergence Tolerance در این حالت تلرانس :

 فرضشود که مقدار پیشهمگرایی برای رسیدن به پاسخ مورد نظر تعیین می

 است. 1e-5برنامه 

o  گزینهElement Loop Maximum Iterationsهای : در این حالت حداکثر حلقه

فرض برنامه در این شود. مقدار پیشتکرار برای رسیدن به همگرایی تعیین می

بار تکرار  30باشد. در اغلب موارد با بار بوده که مقدار زیادی می 300حالت برابر 

 fbd_iteی توان به همگرایی مطلوب رسید. به هرحال در صورتی که با خطامی

 بار نیز افزایش دهید. 1000توانید این تعداد را تا در حین تحلیل روبرو شدید می

برخورد نمودید،  fbd_iteو یا  fbd_invدر صورتی که در حین تحلیل با خطای 

بدین معنی است که معکوس نمودن ماتریس سختی المان انجام نشده و یا تعداد 

 ی نبوده است.سعی و خطای لازم برای همگرایی کاف

 شود. در هایی که براساس نیرو هستند، همگرایی بسختی انجام میدر برخی موارد، برای المان

 در نظر گرفت 3تا  2های روی مقطع را به میزان این حالت بهتر است که تعداد انتگرال

در  وع قیود سازه وجود دارد.دو گزینه برای انتخاب ن Constraints Typeدر این برگه و در قسمت 

انتخاب شده باشد، روند تحلیل سریعتر بوده ولی این روش  Penalty Functionsصورتی که گزینه 
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انتخاب شده  Lagrange Multipliers[. در حالتی که گزینه Cook et al.، 1989معایبی نیز دارد ]

 باشد، ممکن از زمان تحلیل اندکی افزایش یابد.

 Adaptive Pushoverبرگه 
شود. نوع بروز شدن توزیع بارگذاری مشخص می ،: در این بخشType of Updatingبخش  -

 چهار حالت برای این گزینه وجود دارد:

o  گزینهTotal Updating در این حالت توزیع الگوی جابجایی برای سازه در کل :

ود. شیابد و توسط یک الگوی جدید جایگزین میارتفاع، بطور کامل تغییر می

 شود.استفاده از این روش توصیه نمی

o  گزینهIncremental Updating در این روش بردار جابجایی برای گام جاری با :

شود. این روش به صورت پیش فرض در ترکیب توزیع بار گام قبل درست می

 گیرد.برنامه مورد استفاده قرار می

: در این گزینه، مقدار Update Frequencyگزینه  -

 فرض برنامه عدد یک است.پیش

های مختلف برای ترکیب : در این بخش گزینهModal Combination methodگزینه  -

، روش Square Root of the Sum of Squares (SRSS)مودهای سازه شامل روش 

Complete Quadratic Combination (CQC) روش ،Complete Quadratic 

Combination with three components (CQC3) تواند وجود دارد. همچنین کاربر می

 ( را نیز انتخاب نماید.Single-Modeحالت تک مود )

 Eigenvalueبرگه 
شونده و یا انجام تحلیل مودال را دارید، بایستی در حالتی که قصد انجام تحلیل پوش آور بهنگام 

 Jacobi algorithm withو یا  Lanczos algorithmهای روش تعیین مودهای سازه را به یک از روش

Ritz transformation .را انتخاب نمایید 

 : در این حالت بایستی پارامترهای زیر را وارد نمایید.Lanczos algorithmگزینه  -

o  گزینهNumber of eigenvalues بایستی تعداد مودهای نوسانی سازه را وارد :

مود نوسانی در حین تحلیل محاسبه  11فرض تعداد نمایی. بصورت پیش

شوند لیکن در حالتی سازه دارای نامنظمی بوده و بصورت سه بعدی مدل می

 شود، تعداد مودهای آن بیشتر خواهد بود.

o  گزینهMaximum number of steps :های مورد نیاز برای رسیدن به عداد گامت

 است. 51فرض این مقدار برابر نماید. بصورت پیشهمگرایی را مشخص می
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: در این حالت کاربر بایستی Jacobi algorithm with Ritz transformationگزینه  -

 :(15-4شکل ) های زیر را مشخص نمایدگزینه

o  گزینهNumber of Ritz vectors در این بخش تعداد مودهای نوسانی سازه در :

 های مختلف بایستی به برنامه معرفی شود.جهات

o  گزینهMaximum number of stepsهای مورد نیاز برای رسیدن به : تعداد گام

 است. 51فرض این مقدار برابر نماید. بصورت پیشهمگرایی را مشخص می

 
 15-7شکل 

 

 Constitutive Modelsبرگه 
های رفتاری برای آنها که دربرنامه وجود دارد نشان داده شده و کاربر در این برگه مصالح و منحنی

فرض قادر خواهد بود هر یک از آنها را از لیست نمایش در محیط برنامه حذف نماید. بصورت پیش

 (.16-4شکل ی رفتاری در برنامه قابل رویت است )هاتمام مصالح و منحنی

 
 16-7شکل 

 

 Element Subdivisionبرگه 
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و یا کوچکتر تقسیم  6، 4، 2های مدل را به قطعات کوچکتر مثلاً به کاربر قادر خواهد بود المان

های مربوط به تقسیم المان کاربر قادر خواهد بود، گزینه element subdivision -4ش نماید. در بخ

در این بخش بایستی درصدی از طول قطعه اول و آخر را برای تبدیل به چهار قطعه را وارد نماید. 

است. در این حالت قطعه تقسیم  %15فرض برنامه عدد المان به چهار قطعه وارد نمود که مقدار پیش

 5تقسیم خواهد شد. در بخش  %15-%35-%35-%15های ده به ترتیب به طولش

and 6element subdivision  بایستی درصدی از طول قطعه اول و آخر و همچنین درصدی از طول

و  %11فرض بترتیب ها بصورت پیشقطعات دوم و یکی به آخر توسط کاربر تعیین شود. این درصد

 است. 21%

 
 تقسیم یک المان به قطعات کوچکتر 17-7شکل 

 

 Response Spectrum Analysisبرگه 
برنامه اضافه شده است. در این حالت امکان اعمال طیف مورد نظر  4تحلیل طیف پاسخ در نسخه 

 وجود دارد.EX، ±EY، ±EZ± در جهات 

 Capacity Checksبرگه 
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ست. ای اهای مختلف سازهکاربر قادر به تعیین معیارهای پذیرش ظرفیتی برای الماندر این برگه، 

ها و همچنین دوران وتری آنها در برنامه قابل کنترل در حال حاضر تنها کنترل ظرفیت برشی المان

 استفاده شده است. Eurocode 8نامه ها از معیارهای پذیرش آییناست. این کنترل

 Convergence Criteriaبرگه 
در حالتی که نوع کنترل بصورت  در این برگه ضوابط همگرایی برای برنامه مشخص خواهد شد.

 mm 0.1فرض مقدار تلرانس همگرایی بصورت پیش فرش برابر جابجایی و دوران باشد، بصورت پیش

وابط توان نوع ضبرای دوران درجات آزادی تعیین شده است. همچنین می 1e-4 radبرای جابجایی و 

 کنترلی را بصورت نیروی و یا تلفیقی از هر دو حالت در نظر گرفت.

 Iterative Strategyبرگه 
است. این گزینه  41: پیش فرض این مقدار عدد Maximum number of iterationsگزینه  -

 د.پرستعداد حداکثر سعی و خطا برای افزایش بار فزاینده در حین تحلیل را از کاربر می

: در حین تحلیل، ماتریس سختی سازه نیاز به اصلاح Number of stiffness updatesگزینه  -

و بروزرسانی دارد. با استفاده از این گزینه تعداد دفعات بروز رسانی ماتریس سختی پرسیده 

تعداد سعی و  %45تا  %51شود. معمولاً تعداد دفعات بروز رسانی ماتریس سختی برابر می

 است. 35فرض برابر شود. مقدار این گزینه بصورت پیشرفته میخطاهای تحلیل در نظر گ

: این قسمت، تعداد سعی و خطاهای برنامه بعد از عدم Divergence iterationگزینه  -

تعداد حداکثر سعی و خطا،  %45پرسد. عددی در حدود همگرایی برنامه را سوال می

 32دار آن در برنامه برابر فرض مقتواند برای این قسمت مناسب باشد. بصورت پیشمی

 است.

حداکثر تلرانس همگرایی در حین تحلیل که بطور : Maximum Toleranceگزینه  -

 است. 1e20فرض دارای مقدار پیش

: در حین تحلیل، در صورتی که یک گام تحلیل، برنامه Maximum Step Reductionگزینه  -

رار را تر تکعقب ست تا برنامه از گامیهمگرا نشود و تحلیل با ناپایداری همراه باشد، نیاز ا

برای رسیدن به همگرایی انجام دهد. این گزینه، مقدار کاهش گام زمانی را از کاربر 

 پرسد.می

: این گزینه حداقل سعی و خطا برای رسیدن به Minimum number of iterationsگزینه  -

 ر یک است.فرض مقدار آن برابپرسد که بطور پیشهمرایی را از کاربر می

های این قسمت مربوط به کاهش : گزینهStep Increase/Decrease Multipliersگزینه  -

 Large stepهای زمانی تحلیل هستند. وقتی همگرایی بسختی انجام شود، گزینه گام

decrease multiplier  مورد استفاده قرار گرفته و گام افزایشی به میزان زیادی کاهش
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است. بدین معنی که هر گام افزایشی  0.125فرض برابر گزینه بطور پیشیابد. مقدار این می

نماید. در حالتی که عدم همگرایی چندان مهم نباشد، را به هشت قسمت برابر تقسیم می

گیرد که دارای مقدار مورد استفاده قرار می Small step decrease multiplierگزینه 

زایشی برنامه برای انجام تحلیل نصف بوده و است، بدین معنی که گام اف 0.5فرض پیش

 Average stepهای میانه گزینه همچنین برای حالت شود.هر گام به دو قسمت تقسیم می

decrease multiplier  0.25مورد استفاده قرار گرفته که دارای مقدار پیش فرض برابر 

 است.

 Gravity & Massبرگه 
ی تعیین و جرم و وزن سازه ناشی از جرم مقاطع مدل شده هاهای این قسمت مربوط به روشگزینه

 است.

: در این قسمت، تنظمیات مربوط به جهت جرم و نحوه تنظیمات Mass Settingsگزینه  -

جهت موثر  Global Mass Directionsشود. در بخش مربوط به منبع جرم مشخص می

تمام جهات فعال فرض شود که بصورت پیشهای تعریف شده مشخص میبرای اثر جرم

شود. در صورتی که گزینه منبع جرم مشخص می :Define Mass fromهستند. در بهش 

فرض برنامه(، جرم سازه از روی جرم و وزن اختصاص داده شده به اول انتخاب شده )پیش

شوند. در صورت انتخاب گزینه ( تعیین میlmass and dmassهای جرمی )ها، و المانالمان

ها، بارهای اختصاص 

شود. در واقع گزینه سوم، هر دو گزینه های جرمی تعیین میداده شده و همچنین المان

 گیرد.اول و دوم را در بر می

در  .شودمقدار شتاب ثقل زمین مشخص می g value: در بخش Gravity Settingsگزینه  -

شود که بطور جهت بارهای ثقلی پرسیده می Direction of Gravity Forcesبخش 

 باشد.می z–فرض پیش

 Integration Schemeبرگه 

یم. در بع اعمال دارگیری بر روی تادر برنامه برای انجام تحلیل دینامیکی غیرخطی، نیاز به انتگرال

  Newmark integration scheme [Newmark، 1959]گیری ، دو روش انتگرالSeismoStructبرنامه 

بطور وجود دارد.  Hilber-Hughes-Taylor integration algorithm [Hilber et al.، 1977]و 

 انتخاب شده است. Hilber-Hughes-Taylorفرض روش پیش

گیری مورد : در حالتی که این روش انتگرالNewmark integration schemeگزینه  -

بصورت  betaباشد. مقدار مورد نیاز می gammaو  betaاستفاده قرار گیرد، دو پارامتر 
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2+0.5)=0.25( 0.25=فرض شود. بطور پیشدر نظر گرفته می  0.5=و  در نظر گرفته

 (.14-4شکل ) شودمی

 
 18-7شکل 

 

: در این روش یک پارامتر اضافی Hilber-Hughes-Taylor integration schemeگزینه  -

 باشد.می =-1وجود دارد. مقدار پیش فرض آن برابر  Alphaتحت عنوان 

 
 19-7شکل 

 

 Dampingه برگ
 باشد.مقدار میرایی سازه یکی از پارامترهای اساسی در حین انجام تحلیل دینامیکی می

شود. در صورتی که گزینه : در این حالتف نوع میرایی مشخص میDamping Typeگزینه  -

nonestiffness-

proportional damping شود. در صورت مقدار میرایی متناسب با سختی تعیین می

،میرایی متناسب با جرم در نظر گرفته Mass-proportional dampingانتخاب گزینه 
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میرایی رایلی ملاک قرار خواهد  Rayleigh dampingشود و در صورت انتخاب گزینه می

 گرفت.

 MATERIALSمدول  -7-7

کاربر قادر به معرفی مصالح مورد نیاز جهت مدلسازی سازه، ، MATERIALSبا استفاده از مدول 

توان مشخصات مکانیکی مصالح مانند منحنی تنش و کرنش را به برنامه است. در این بخش می

 (.21-4شکل معرفی نمود )

  تنها مصالحی که در بخش تنظیمات و در بخشTools > Project Settings > Constitutive 

Model شوند.انتخاب شده باشند، در این بخش نشان داده می 

 
 مدول مصالح در برنامه 21-7شکل 

 

 دو گزینه جهت معرفی مصالح جدید وجود دارد: 21-4شکل در مدول مصالح مطابق با 

 Add Material Classتوان از مصالح پیش فرض برنامه استفاده نمود: در این حالت می 

 . (21-4شکل )

 Add General Material در این حالت بایستی مشخصات کامل مصالح به برنامه معرفی :

 .(22-4شکل ) شود
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 اضافه نمودن مصالح جدید 21-7شکل 

 
 اضافه نمودن مصالح جدید 22-7شکل 

 

 باشد:لیست مصالح موجود در برنامه بصورت زیر می
  Bilinear steel model - stl_bl 

 Menegotto-Pinto steel model - stl_mp 

  Dodd-Restrepo steel model – stl_dr 

  Monti-Nuti steel model - stl_mn 

  Mander et al. nonlinear concrete model - con_ma 

- con_tl 

  Chang-Mander nonlinear concrete model – con_cm 

  Kappos and Konstantinidis nonlinear concrete model - con_hs 

  Superelastic shape-memory alloys model - se_sma 
  Trilinear FRP model - frp_tl 

  Elastic material model - el_mat 

 SECTIONSمدول  -7-8

توانید در این مدول، نسبت به تعریف مقاطع اقدام نمایید. در این بخش بعد از تعریف مصالح، می

استفاده  Addبرای تعریف مقاطع وجود دارد. در صورتی که از گزینه  ، دو گزینه23-4شکل مطابق 

شود، کاربر بایستی برای مقطع یک نام یکتا انتخاب نمایید. همچنین در محیط برنامه بیست و سه 

مقطع یکی از انتخاب و ابعاد  23نوع مقطع متفاوت وجود دارد که کاربر قادر خواهد بود از بین این 

 وان ابعاد مقطع انتخابی وارد نماید.آن مقطع را به عن
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 اضافه نمودن مقاطع 23-7شکل 

 

 باشند:مقاطع موجود در برنامه برای تولید بصورت زیر می
 Rectangular solid section - rss 
 Rectangular hollow section - rhs 

 Circular solid section - css 

 Circular hollow section - chs 

 Symmetric I/T section - sits 

 Asymmetric general shape - agss 

 Double angle or channel shaped section - dacss 

 Composite I-section - cpis 

 Partially encased composite I section - pecs 

 Fully encased composite I section - fecs 

 Composite rectangular section - crs 

 Composite circular section - ccs 
 Reinforced concrete rectangular section - rcrs 

 Reinforced concrete circular section - rccs 

 Reinforced concrete T-section - rcts 

 Reinforced concrete asymmetric rectangular section -rcars 

 Reinforced concrete rectangular wall section - rcrws 

 Reinforced concrete U-shaped wall section - rcuws 

 Reinforced concrete L-shaped wall section - rclws 

 Reinforced concrete rectangular hollow section - rcrhs 

 Reinforced concrete circular hollow section - rcchs 

 Reinforced concrete jacketed rectangular section - rcjrs 

 Reinforced concrete box-girder section - rcbgs 
انتخاب شود، مطابق  Add Steel Profileدر صورتی که گزینه 

که در ایران  

 شوند نیز در این کتابخانه وجود دارند. تولید می
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 فولادی موجود در برنامههای مقاطع پروفیل 24-7شکل 

 

 ELEMENT CLASSESمدول  -7-9

های رابط در های جرمی و المان.. و همچنین المان.های تیر و ستون وای شامل المانهای سازهالمان

ای تعرف شده و سپس در های سازهاند. ابتدا بایستی در این مدول، الماناین مدول گنجانده شده

 کدیگر متصل شوند.به ی Element Connectivityمدول 

 
 ایهای سازهتعریف المان 25-7شکل 

 

 های زیر در برنامه قابل تعریف هستند:، المان25-4شکل مطابق 

 Inelastic frame elements - infrmDB، infrmFB 
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 Inelastic plastic-hinge frame element – infrmFBPH، infrmDBPH 

 Elastic frame element - elfrm 

 Inelastic infill panel element - infill 

 Inelastic truss element - truss 

 Link element - link 

 Mass elements - lmass & dmass 

 Damping element - dashpt 
 ه مانند های برنامه بتوجه داشته باشید، برخی از المانmass  وdamping elements  در برخی از

 ها مانند تحلیل استاتیکی قابل استفاده نیستند.تحلیل

 Nodesمدول  -7-11

هایی داریم. تعریف این ها نیاز به تعریف گرهبرای به هم وصل نمودن المان SeismoStructدر برنامه 

گره تعریف نمود.  51111ا حداکثر توان تقابل انجام است. برای هز مدل می Nodesها در مدول گره

ای های سازهشوند. از گرهای تقسیم میای و ناسازهبه دو دسته سازه SeismoStructهای برنامه گره

ن ها ممکشود و اجرای برنامه بدون تولید این گرههای تیر و ستون استفاده میبرای مدلسازی المان

ار ها بکمحورهای محلی المانبرای مدلسازی و تعریف ای بیشتر های ناسازهنیست. در حالی که گره

شوند و تاثیری در روند تحلیل ندارند. هر گره بایستی دارای یکی نام یکتا باشد. برای ایجاد برده می

شکل مختص به خود است. مطابق  zو  x ،yشود. هر گره دارای یک استفاده می Addگره از گزینه 

دوبار سریع کلیک نمایید تا پنجره  Nodeبرای ویرایش مختصات یک گره بر روی آن در مدول  4-26

 ویرایش آن باز شود.

 
 ویرایش اطلاعات یک گره 26-7شکل 

 

ن مختصات آن را ای و همچنیای و ناسازهتوانید نوع آن را از نظر سازهدر پنجره ویرایش آن می

های مختلف قرار دارند، های مشابه که در مختصاتتعیین نمایید. یک راه سریع برای ایجاد گره
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خواهید کپی شوند را هایی که میاست. بدین ترتیب ابتدا گره Incrementationاستفاده از گزینه 

توان افزایش شماره ه میدر این پنجرکلیک نمایید.  Incrementationانتخاب نموده و بر روی گزینه 

 نام گره و همچنین افزایش آن در جهات مختلف را تعیین نمود.

 Element Connectivityمدول  -7-11

برای  های تولید شده در گام قبل وجود دارد.ای بین گرههای سازهدر این مدول امکان ایجاد المان

ظاهر  24-4شکل ای به مانند هویرایش یک المان کافی است بر روی آن دوبار کلیک نمایید تا پنجر

( که شبیه به پنجره تعریف المان است، Edit Element Propertiesشود. در این پنجره )پنجره 

 توانید خصوصیات مختلف المان را تغییر دهید.می

 
 ویرایش یک المان 27-7شکل 

 

نام المان را وارد نمایید. بهتر است نام المان از یک یا چند حرف و یک  Element Nameدر بخش 

نوع المان تعیین شود. در بخش Elementعدد بعد از آن تشکیل شود. در بخش 

Element End Nodes ای موجود انتخاب شود. بصورت های ابتدا و انتهای المان از نوار کرکرهگره

توان گره ابتدا و انتهای عضو را نیز مشخص نمود. برای این منظور به جاری تعیین کی نیز میگرافی

کلیک نمایید و در پنجره گرافیکی سمت راستف  شماره گره ابتدا و یا انتهای عضو، بر روی کلید 

جهت دوران المان مشخص  Element Orientationبر روی گره مورد نظر کلیک نمایید. در بخش 

المان براساس انتخاب شده باشد، دوران  Define by Rotation Angleشود. در صورتی که گزینه می

شود. لیکن در حالتی که گزینه تعیین می Rotation Angleزاویه انتخاب شده در بخش 

Define by Additional Nodes توان دوران المان را براساس یک گره دیگر انتخاب شده باشد، می

گیرد. به عضو در امتداد آن گره انتخاب شده قرار می 3فت. بدین معنی که محور محلی در نظر گر
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دوران داده  6ستون مشخص شده در شکل، با استفاده از گره شماره  24-4شکل عنوان مثال مطابق 

 است.قرار گرفته  6شده است. مطابق شکل، محور محلی آن المان در امتداد گره 

آن المان را  27-4شکل مطابق  های ریزتر، ابتدا بایستیهمچنین برای تقسیم یک المان به المان

سپس از پنجره ظاهر شده، تعداد کلیک نمایید.  Subdivisionانتخاب و سپس بر روی گزینه 

 Project Settingsبایستی از مسیر تقسیمات مورد نظر را تعیین نمایید. برای تعیین طول تقسیمات 

> Element Subdivision .نسبت به تعیین طول تقسیمات مورد نظر اقدام نمایید  

 
 دروان یک المان با استفاده از یک گره اضافی 28-7شکل 

 

 
 های ریزترتقسیم یک المان به المان 29-7شکل 

 

 ،Elastic and Inelastic frame elements - infrmFB، infrmDBهای تعریف المان

infrmFBPH، infrmDBPH & elfrm
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یف تعربرای  2و  1های شماره گره 31-4شکل ها نیاز به سه گره است. مطابق برای تعریف این المان

عضو مورد نیاز  3یا  2برای تعریف امتداد محور محلی  3عضو و گره شماره  1امتداد محور محلی 

 است.

 
 تعریف یک المان 31-7شکل 

 

 Infill panel element - infillهای تعریف المان
برای ایجاد یک المان  31-4شکل نقطه هست. مطابق ها نیاز به تعریف چهار برای تعریف این المان

 های دیوار است.ز به معرفی چهار گره به عنوان گوشهمیانقابی نیا

  
 قابیهای مورد نیاز برای ایجاد المان میانگره 31-7شکل 

 

 Inelastic truss element - trussهای تعریف المان
 ها نیاز به معرفی دو گره است.برای تعریف این المان

- Link elementهای تعریف المان

ها نیاز به معرفی چهار گره است. دو گره اولی برای تعریف ابتدا و انتهای المان برای تعریف این المان

های رابط در برنامه صات باشند زیرا طول المانمورد نیاز است. این دو گره بایستی دارای یک مخت
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المان و گره چهارم برای تعیین زاویه  1برای تعریف جهت محور محلی  3برابر صفر است. گره شماره 

 (.32-4شکل شود )استفاده می 3یا  2دوران بین محور محلی 

 Lumped mass elements - lmassهای تعریف المان
باشد تا المان جرمی تعریف های جرمی متمرکز، تنها نیاز به معرفی یک گره مینبرای تعریف الما

 .(33-4شکل ) شده در آن گره متمرکز گردد

 
 تعریف المان رابط 32-7شکل 

 

 
 تعریف المان جرمی متمرکز 33-7شکل 

 

 Distributed mass elements - dmassهای تعریف المان
 (.34-4شکل معرفی دو گره ابتدایی و انتهایی است )برای تعریف این المان جرمی گسترده نیاز به 
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 تعریف المان جرمی گسترده 34-7شکل 

 

 Dashpot damping elements - dashptهای تعریف المان

شود به زمین متصل شده باشد. برای گره دوم فرض میبرای تعریف این المان نیاز به یک گره می

 است.

 Constraintsمدول  -7-12

قیود زیر توسط برنامه و در  شود.تفاده میجهت مقیدسازی برخی درجات آزاد سازه، از این مدول اس

 مدول فوق قابل انجام است:
 Rigid Link 

 Rigid Diaphragm 
 Equal DOF 

 
 مقید سازی درجات آزادی 35-7شکل 

 

کلیک  Addبر روی گزینه  constraintدول ، برای مقید سازی درجات آزادی در م35-4شکل مطابق 

نوع مقید سازی که در بالا به آن اشاره شد  constraint typeظاهر شده و در بخش نمایید. در پنجره 
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های انتخاب شده باشد، بین گره مرجع و گره Rigid Linkرا انتخاب نمایید. در صورتی که گزینه 

ها را در جهت مختلف تعیین نمود. در ید بودن گرهتوان مقوابسته، یک لینک صلب برقرار شده می

 Rigidها در یک صفحه وجود ندارد. در صورتی که گزینه اینحالت محدودیتی برای قرار داشتن گره

Diaphragm  انتخاب شده باشد، یک دیافراگم صلب هر هر تراز دلخواهZ توان ایجاد نمود، از سازه می

قرار داشته باشد. برای این منظور نیاز به یک گره مرجع  X-Yبطوری که دیافراگم صلب در صفحه 

های انتخاب شده باشد، تمام درجات آزادی گره مرجع و گره Equal DOFدر حالتی که گزینه  است.

 شود.ها تولید نمیشوند ولی در اینجا قیدی بین گرهوابسته یکی می

Restraintsمدول  -7-13

-z ات آزادی مدل میشود( درجy+rx+ry ها بست تا در خارج صفحه، را برای تمام گره

 مدل جابجایی نداشته باشد.

 Applied Loadsمدول  -7-14

( انتخاب شده باشد، ظاهر Eigenvalue analysisاین مدل در حالتی که نوع تحلیل، مقادیر ویژه )

 شود.نمی

 :(Nodal Loads) ایبارهای گره

نوع حالت برای بارهای پایدار و همیشگی به مانند  : اینPermanent loadsحالت بار 

 گیرد.گاهی مورد استفاده قرار میبارهای مرده و نشست تکیه

: این نوع حالت بار برای مدلسازی بارهای افزایش، به مانند Incremental loadsحالت بار 

 بارهای استاتیکی فزاینده )بار یا جابجایی(.

: این نوع بارگذاری عموماً برای مدلسازی Static time-history loadsحالت بار 

ای از جابجایی به سازه اعمال تاریخچههای استاتیکی رفت و برگشت که بصورت یک بارگذاری

 شوند، کاربرد دارد.می

: برای اعمال بارهای دینامیکی )بار یا شتاب( به Dynamic time-history loadsحالت 

شود. از این حالت بارگذاری عموماً برای اعمال بارهای دینامیکی سازه از این حالت بار استفاده می

 شود.تاریخچه زمانی استفاده می

 :(Element (Distributed) Loads) بارهای گسترده المانی
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ای خواهد بود. های سازهماندگار به الماندر این حالت کاربر تنها قادر به اعمال بارهای گسترده به 

کلیک نمایید و  Addبر روی گزینه  Element Loadsدر بخش  36-4شکل در این حالت مطابق 

تیرهایی که قصد اعمال بارهای ماندگار بر روی آنها را دارید را انتخاب و مقدار بار را وارد نمایید. در 

گرفته  منفی در نظر صورتی که قصد اعمال بارها به صورت ثقلی را دارید بایستی علامت بارها بصورت

 شود.

 
 36-7شکل 

 

توان برای کپی کردن فزایشی بار اعمال شده در این بخش، می incrementationهمچنین از گزینه 

 های دیگر نیز استفاده نمود.بر روی المان

 Loading Phasesمدول  -7-15

غیرخطی، بارگذاری بصورت ثقلی شامل بارهای ماندگار و بصورت در حین انجام تحلیل استاتیکی 

همزمان با بارهای ماندگار، بارهای جانبی )عموماً جابجایی جانبی( بر سازه )در یک یا دو جهت( 

شود. بدین معنی که چون در تحلیل غیرخطی استاتیکی، اصل جمع آثار قوا برقرار نیست، اعمال می

بر سازه اعمال شده و سپس بارهای جانبی بر سازه وارد شوند. بارهای  بایستی ابتدا، بارهای ثقلی

در  شود.جانبی با ضریبی بصورت فزاینده افزایش یافته و در هر گام، میزان سختی سازه تعیین می

شود. توجه داشته باشید، در این حالت، منظور این حالت، استراتژی بارگذاری در این مدول انجام می

 تواند بار و یا جابجایی نیز باشد. سه گزینه زیر وجود دارد:ه میاز بار فزایند
 Load control phase 

 Response control phase 

 Automatic response control phase 
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، کاربر ضریب فزاینده بار )یا 34-4شکل : در این حالت، مطابق Load control phaseگزینه 

 نماید.های مورد نیاز برای رسیدن به میزان مورد نظر را وارد میهمچنین تعداد گام جابجایی( و

 
 کنترل بارگذاری 37-7شکل 

 

: در این حالت، پاسخ در یک نقطه کنترل شده و کنترلی بر روی Response control phaseگزینه 

 بردار بار نیست.

 
 کنترل جابجایی 38-7کل ش

 

 Response: در این حالت، که بسیار شبیه به حالت Automatic response control phaseگزینه 

control phase های لازم برای رسیدن به جابجایی هدف بطور خودکار تعیین است، تعداد گام

 شود.می

 Time-history curvesمدول  -7-16

در این مدول امکان تعریف تاریخچه بارگذاری بصورت استاتیکی و دینامیکی وجود دارد. این مدول 

 static time-historyو یا  dynamic time-history analysesدر حالتی که نوع بارگذاری بصورت 

analyses این مدول دارای دو قسمت اصلی  شود.انتخاب شده باشد، نمایان می

 زیر است:
 Load curves 
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 Time-history stages 

 
 های مختلف مدول بارگذاری تاریخچه زمانیقسمت 39-7شکل 

 

 در صورتی شود.منحنی تاریخچه زمانی )شتابنگاشت( به برنامه معرفی می Load curvesدر بخش 

ضرب شود. برای  gهمپایه شده باشد، باستی کل منحنی بارگذاری در  gکه شتابنگاشت بر حسب 

خواندن شتابنگاشت، بایستی فایل شتابنگاشت بصورت دو ستونی و در یک فایل متنی ذخیره شده 

 41-4شکل در  نقطه داشته باشد. 261111تواند تا باشد. در این حالت منحنی بارگذاری می

های مختلف این پنجره نشان داده شده است. در بخش نام منحنی بایستی یک نام دلخواه قسمت

 انتخاب شود.

های زمانی را برای انجام تحلیل مشخص نمود. مطابق توان گام-Timeدر بخش 

زمان انتهایی شود. همچنین تعداد نقاط موجود در شتابنگاشت وارد می Stepsدر بخش  41-4شکل 

ی های زمانی، فاصله زمانشود. برنامه از تقسیم زمان انتهایی بر تعداد گامشتاب نگاشت نیز وارد می

 نماید.بین هر گام را تعیین می
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 زمانی شتابنگاشت منحنی تاریخچه 41-7شکل 

 

 
 های زمانی برای تحلیلتعریف گام 41-7شکل 

 

 IDA parametersمدول  -7-17

 Incremental Dynamicدر این مدول امکان تعریف پارامترهای تحلیل دینامیکی فزاینده )

Analysis وجود دارد. در بخش )Scaling factors قیاس برای اعمال بر روی شتابنگاشت ضریب م

، ضریب مقیاس ابتدا، انتها و گام پرشیب برای هر ضریب Start-End-Stepوجود دارد. در بخش 

مقیاس قابل اعمال است. در صورتی که قصد اعمال ضرایب مقیاس خاصی را به شتابنگاشت دارید 
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 Distinctی غیر همگن را در بخش هاتوانید این گامهای یکسانی نیستند، میکه با فواصل و گام

Scaling Factors  اعمال نمایید. خروجی یک تحلیل دینامیکی فزاینده، برش پایه سازه در برابر

 جابجایی بام سازه است.

 RSA parametersمدول  -7-18

( وجود Response-spectrum analysisدر این مدول امکان معرفی پارامترهای تحلیل طیف پاسخ )

دول امکان اعمال طیف دلخواه به صورت افقی و عمودی به سازه وجود دارد. در بخش دارد. در این م

Loading combinations  امکان ترکیب بارهای طیفی در جهات مختلف و با ضرایب دلخواه وجود

 Givenدو حالت برای تعریف طیف وجود دارد. در صورتی که گزینه  Spectral Dataدر بخش  دارد.

Accelerogram شود. در حالتیتخاب شود، ورودی یک شتابنگاشت بوده که به طیف تبدیل میان 

توان در آن نامه را میانتخاب شده باشد، طیف مورد نظر آیین User Defined Spectrumکه گزینه 

های مربوطه وارد میوارد نمود بدین صورت که اعداد طیف را یکی یکی در ستون

 توان برای تولید طیف استاندارد نیز استفاده نمود.چسباندن نیز می
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 SeismoStructافزار پردازش در نرم -8 فصل

 مقدمه -8-1

در تحلیل سازه خواهیم پرداخت. در  SeismoStructهای برنامه در این قسمت، به بررسی قابلیت

 Run > Processorز مسیر برنامه، تحلیل سازه انجام خواهد شد. برای این منظور ا Processorبخش 

روند  2-4شکل در صورت انجام تحلیل، مطابق  .(1-4شکل ) استفاده نمایید یا دکمه 

شود و همچنین در نوار وضعیت بالای پنجره، نشان داده می Analysis Logانجام تحلیل در بخش 

 شود.اده میوضعیت تحلیل نشان د

 
 محیط پردازش برنامه 1-8شکل 
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 در حین تحلیل 2-8شکل 

 

را انتخاب نموده باشد، به صورت بهنگام،  Rهمچنین کاربر در صورتی که گزینه 

های استاتیکی و یا نمودار جابجایی گره انتخاب شده در برش پایه در تحلیلجایی در برابر نمودار جاب

 (.3-4شکل شود )های دینامیکی، نمایش داده میبرابر زمان در تحلیل

 
 3-8شکل 

 

تغییرشکل سازه تحت  Real-time drawing plotting deformed shapeدر صورت انتخاب گزینه 

(. توجه داشته باشید، هر دو 4-4شکل شود )بارهای اعمال شده، به صورت بهنگام نمایش داده می

باعث تاخیر در روند  Real-time drawing plotting deformed shapeو  Real-time plottingگزینه 

شوند. و استفاده از گزینه اول نسبت به دو گزینه دیگر باعث تسریع در روند تحلیل خواهد تحلیل می

 شد.
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 تغییرشکل سازه در حین تحلیل 4-8شکل 
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 SeismoStructافزار پس پردازش در نرم -9 فصل

 مقدمه -9-1

 خروجی گرفتن از نتایج تحلیلدر  SeismoStructبرنامه های در این قسمت، به بررسی قابلیت

استفاده  و یا دکمه  Run > Post-Processorبرای این منظور از مسیر خواهیم پرداخت. 

 های تحلیلعموماً خروجیباشد. در محیط پس نمایید. پیش پردازش، نقطه مقابل پس پردازش می

گیرد. تمام نتایج خروجی از این محیط قابل کپی بدست آمده و تفسیرهایی در این ارتباط صورت می

 Microsoft Excelهای صفحه گسترده مانند ها را در محیط برنامهتوان این خروجینمودن بوده و می

 (:1-7شکل باشند )های زیر در در محیط موجود میبررسی نمود. مدول
 Analysis Logs 
 Modal/Mass Quantities 

 Step Output 

 Deformed Shape Viewer 

 Global Response Parameters 

 Element Action Effects 

 Stress and Strain Output 

 IDA Envelope Curve  
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 تنظمیات پس پردازش -9-2

امکان تنظیمات مربوط به پس پردازش  Tools > Post-Processor Settingsبا استفاده از مسیر 

توان مقادیر عددی در روی محوری افقی و قائم را در در پنجره ظاهر شده می باشد.موجود می

 ضرایبی ضرب کرد.

 
 2-9شکل 

 

 Tools > Plot Optionsتوان تغییر داد. از مسیر های خروجی برنامه را میهمچنین هر یک از پنجره

را انتخاب  برای این منظور استفاده نمایید و یا با راست کلیک بر روی پنجره مورد نظر آیکون 

 .. برای پنجره مورد نظر خواهد بود..نمایید. کاربر قادر به تغییر رنگ، ضخامت و

 
 پنجره تغییر در خروجی 3-9شکل 

 

توانید سایه پس زمینه اشکال را از بین برای گرفتن خروجی و کپی نمودن شکل خروجی برنامه می

را انتخاب نموده و گزینه  Gradientگزینه  Panelو در تب  Plot Optionsببرید. برای این منظور در 

Visible ه شکل خروجی سفید شود. بعد از انجام تحلیل را از حالت انتخاب خارج نمایید تا پس زمین
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 Toolsتوانید از شکل، ارتعاش سازه یک فیلم تهیه نمایید. برای این منظور از مسیر مقادیر ویژه می

> Create AVI file .اقدام نمایید 

 Modal/Mass Quantitiesمدول  -9-3

ستاتیکی بهنگام شونده این مدول در تنها در حالتی که تحلیل از نوع مقادیر ویژه یا تحلیل ا

(Eigenvalue or Adaptive Pushover analysesباشد، نمایان می ).شکل در این مدول مطابق  شود

ای هر مود دوره تناوب، فرکانس و فرکانس زاویه Modal Periods and Frequenciesو در تب  7-4

میزان جرم هر  Nodal Massesدر تب  5-7شکل مطابق  شود. همچنیننوسانی سازه نشان داده می

 شود.گره در جهات انتقالی مختلف و دورانی نشان داده می

 
 4-9شکل 

 

 
 5-9شکل 

 

برای سازه را  nMو جرم مودی  nLنسبت بین ضریب تحریک  cipation factorsmodal partiبخش 

 دهد.در هر مود نشان می

  در برنامهSeismoStruct شود.شکل ارتعاش مودها نسبت به جرم همپایه می 
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 Step Outputمدول  -9-4

 کاربر باشد و در آن خروجی تحلیل بصورت متنی در اختیارها موجود میاین مدول در تمام تحلیل

.. از جمله .ها وگاهی، نیروی المانهای تکیهالعملها، عکسها، دوران گرهگیرد. جابجایی گرهقرار می

توان بر روی پنجره نمایش داده شده راست کلیک باشند. براحتی میهای این مدول میخروجی

 ه با استفاده از آیکون برنام Export to Text Fileنموده و گزینه کپی را انتخاب نمود و یا قابلیت 

 استفاده نمود.

 Deformed Shape Viewerمدول  -9-5

در این  6-7شکل شود. مطابق برای دیدن تغییرشکل سازه بعد از بارگذاری از این مدول استفاده می

ینه توان تغییرشکل سازه را در هر گام بارگذاری دید. همچنین در صورتی که گزمدول می

Displacement values display توان مقادیر جابجایی هر گره را هم علاوه بر انتخاب شده باشد، می

 تغییرشکل سازه در کنار آن گره مشاهده نمود.

 
 دیدن تغییرشکل سازه 6-9شکل 

 Global Response Parametersمدول  -9-6

انتخاب شده باشد، کاربر قادر به  Structural displacementsدر صورتی که برگه  در این مدول و

مشاهده تغییرشکل هر گره از سازه خواهد بود. برای دیدن جابجایی انتقالی بایستی گزینه 

displacement  و برای دیدن دوران گره گزینهrotation  کناری نیز جهت انتخاب شود. در بخش

شود. در صورتی که گزینه مشخص می Zaxisو  Xaxis ،Yaxisهای ر بخشجابجایی یا دوران د

Relative Displacement توان جابجایی یک گره را نسبت به گره دیگری انتخاب شده باشد، می

ای که تمایل دارید جابجایی براساس آن مشخص شود را در بخش تعیین نمود. برای این منظور گره

Base Node د. در بخش انتخاب نماییView  اگر گزینهgraph  انتخاب شده باشد، شکل گرافیکی و
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شود. برای مشاهده انتخاب شده باشد، مقادیر عددی جابجایی نشان داده می valuesدر صورتی گزینه 

 (.4-7شکل کلیک نمایید ) Refreshتغییرات و نمودار جابجایی بر روی گزینه 

 
 دیدن جابجایی گره 7-9شکل 

 

نیروها و لنگرها و همچنین  Forces and Moments at Supportsتب در صورت انتخاب 

انتخاب  forceدر صورتی که در این برگه گزینه  شوند.گاهی نمایش داده میهای تکیهالعملعکس

انتخاب شده باشد، لنگر واژگونی کلی  momentدر حالتی که گزینه شده باشد، مقدار نیروی نهایی و 

توان جهت این بارها را تعیین می Zaxisو  Xaxis ،Yaxisهای شود. در بخشنمایش داده می

انتخاب شده باشد، مقدار کل  Total support forces/momentsنمود. همچنین در حالتی گزینه 

 هایگاهنیروهای مربوط به تکیه

 support forces/moments توان بصورت انفرادی برای هر یک از انتخاب شده باشد، می

 ها مقدار پاسخ را تعیین نمود.گاهتکیه

کاربرد در تحلیل تاریخچه زمانی  Nodal Accelerations and Velocitiesدر صورت انتخاب تب 

های سازه در هر لحظه از تاریخچه بارگذاری و مقدار سرعت و یا جابجایی هر یک از گرهداشته 

، مقدار شتاب هر گره در هر لحظه از زمان نمایش Accelerationدهد. در صورت انتخاب گزارش می

 rotationalانتخاب شده باشد، شتاب انتقالی و در حالتی که  translationalشود. در حالتی که داده می

 Zaxisو  Xaxis ،Yaxisهای در بخش شود.انتخاب شده باشد، شتاب دورانی گره نمایش داده می

 ها را تعیین نمود.توان جهت این شتابمی

شود. منحنی نیرو در برابر جابجایی سازه نمایش داده می Hysteretic Curvesدر صورت انتخاب تب 

اشد، این خروجی منجر به تهیه منحنی ظرفیت سازه در حالتی تحلیل از نوع استاتیکی غیرخطی ب

 .(4-7شکل ) کلیک نمایید Refreshخواهد شد. برای نمایش منحنی بر روی دکمه 
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 8-9شکل 

 

 Element Action Effectsمدول  -9-7

وان تنمودارهای پاسخ هر المان را مشاهده نمایید. به عنوان مثال میتوانید بسادگی در این مدول می

از  Frame Forces Viewerبرگه  7-7شکل  ها را در هر گام زمانی مشاهده نمود.نمودار لنگر المان

 دهد.این مدول را نشان می

 
 9-9شکل 

 

های سازه های داخلی المانتوانید دیاگرام هر یک از تلاششود، در این تب میهمانطور که دیده می

انتخاب شده باشد، تنها  Horizontal Elements Onlyرا مشاهده نمایید. در صورتی که در گزینه 

 Vertical Elementsشود و در حالتی که گزینه های تیر نمایش داده میتلاش مورد نظر برای المان

Only شود. در حالتی که های قائم نمایش داده میانتخاب شده باشد، تلاش مورد نظر برای المان

شود. انتخاب شده باشد، مقادیر تلاش آن المان بر روی المان نوشته می Display Valuesگزینه 
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ها ه بر روی المانباعث تغییر در ضخامت دیاگرام ترسیم شد Diagrams Thicknessگزینه نواری 

 خواهد شد.

 Element Action Effectsمدول  -9-8

( انتخاب شده باشد، Incremental Dynamic Analysisدر حالتی که نوع تحلیل دینامیکی فزاینده )

شود. در برگه این مدول نمایش داده شده و خروجی تحلیل دینامیکی فزاینده نمایش داده می

IDA Envelope اگر حالت ،Corresponding Drift vs. Maximum B.Shear  ،انتخاب شده باشد

جابجایی متناظر نسبی در هر تحلیل در برابر حداکثر برش پایه حاصل در آن تحلیل دینامیکی 

انتخاب شد باشد،  Maximum Drift vs. Corresponding B.Shearشود. اگر گزینه نمایش داده می

ر حداکثر برش پایه متناظر با آن جابجایی در آن تحلیل حداکثر جابجایی نسبی در هر تحلیل در براب

 Maximum Drift vs. Maximum B.Shearشود. همچنین در حالت دینامیکی نمایش داده می

، شود. توجه نماییدحداکثر جابجایی نسبی در برابر حداکثر برش پایه ان تحلیل نمایش داده می

 شکل گرافدر یک لحظه رخ ندهد. برای دیدن  حداکثر برش پایه ممکن است با حداکثر جابجایی

را انتخاب نمایید و همچنین برای گرفتن مقادیر عددی در همین بخش  graphگزینه  Viewاز بخش 

 کلیک نمایید. Refreshرا انتخاب نمایید و بر روی دکمه  valuesگزینه 
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